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Merlin Project-Handbuch

Download, Test & Abonnieren

Herzlich Willkommen!

Danke, dass Sie sich für Merlin Project, die neueste Version der führenden
Projektmanagement-Software, entschieden haben!

Hilfe und Unterstützung

Verwenden Sie die eingebaute Hilfe im Menü Hilfe.


Weitere Hilfe und Unterstützung erhalten Sie auf unserer Webseite im
Bereich Support: www.projectwizards.net oder beim Support per E-Mail
support@projectwizards.net
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Systemvoraussetzungen

Merlin Project benötigt einen Apple Mac mit Intel-Prozessor und macOS 10.13 als
Mindestvoraussetzung.

Installation und Testphase

Mit diesem Link gelangen Sie schnell und einfach zu unserer Webseite. Hier stehen Ihnen
alle unsere Produkte und weiterführende Informationen zur Verfügung.

Klicken Sie auf Merlin Project und anschließend auf „Download“.

30-Tage-Test

Testen Sie Merlin Project kostenlos und uneingeschränkt. Beim ersten Start des
Programms erscheint der abgebildete Hinweis.

Klicken Sie auf 30-Tage-Test starten, für die kostenlose 30-Tage-Testphase.

Die Testphase erlaubt es Ihnen, Merlin Project in einem Zeitraum von 30 Tagen, ab dem
ersten Programmstart, im vollen Umfang auszuprobieren.

Im oberen rechten Eck des Programmfensters erscheint bei der 30-Tage-Testphase ein
Hinweis. Diesem Hinweis entnehmen Sie die noch vorhandene Anzahl der fortlaufenden
Tage für die Testphase.
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Nach Ablauf der Testphase lassen sich Projektdateien öffnen und betrachten aber nicht
mehr bearbeiten. Zum erneuten Bearbeiten der Projekte wird ein Abo benötigt.

Abonnement

Öffnen Sie Merlin Project nach Ablauf der Testphase, erscheint ein Hinweisdialog.

Klicken Sie auf Nicht lizenziert, erscheint das abgebildete Hinweisfenster.

Klicken Sie auf Jetzt abonnieren gelangen Sie automatisch zum Dialog Abonnement.

Klicken Sie auf Nur zum Lesen verwenden , um die Anwendung zum Öffnen und Lesen
vorhandener Merlin Project-Dokumente zu verwenden.


Die Option Nur zum Lesen verwenden erlaubt nicht das Öffnen von
Dateien in Fremdformaten oder die Verwendung von Vorlagen.
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Jetzt abonnieren …

Während Ihr Merlin Project von unserer Website sich in der Testphase befindet, bietet es
folgende Optionen:


Mengenrabatte und zentrale Lizenzverwaltung sind nur verfügbar, wenn
die Software von unserer Website und nicht aus dem Mac App Store
heruntergeladen wurde.



Sollten Sie ein bestehendes Abonnement haben, klicken Sie auf

Bestehendes Abo verwalten… und geben Sie Ihre E-Mail- und
Passwort-Zugangsdaten ein. Wenn Sie Ihre Lizenznummer kennen,

klicken Sie auf Activate This Device…

Um ein neues Abonnement zu starten, klicken Sie auf Abonnement für … .
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1. wählen Sie Ihr Land aus dem Klappmenü aus.

2. geben Sie Ihre Postleitzahl ein.

3. tragen Sie die Anzahl der gleichzeitigen Benutzer* ein.

4. einen optionalen Couponcode können Sie bei Bedarf in das gleichnamige Feld
eintragen.

5. klicken Sie auf Abonnieren.

Anschließend tragen Sie eine gültige E-Mail-Adresse und ein selbstdefiniertes Kennwort
ein.



Sie benötigen Ihre Anmeldedaten (E-Mail-Adresse und Passwort), wenn
Sie Ihr Merlin Project-Abonnement auf einem anderen Mac aktivieren
möchten. Bitte bewahren Sie diese Daten sicher auf. Und stellen Sie
sicher, dass Sie eine E-Mail-Adresse verwenden, auf die Sie Zugriff
haben.
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Haben Sie das Programm aus dem App Store heruntergeladen?

Während Ihr Merlin Project aus dem App Store sich in der Testphase befindet, bietet es
folgende Optionen:


Mengenrabatte und zentrale Lizenzverwaltung sind nur verfügbar, wenn
die Software von unserer Website und nicht aus dem Mac App Store
heruntergeladen wurde.

Klicken Sie auf die Schaltfläche Abonnement für… für das gewünschte Zahlungsintervall.
Ihr Abonnement wird als In-App-Kauf über den App Store abgerechnet und folgt den
Standardverfahren von Apple.


Sollten Sie Ihren In-App-Kauf wiederherstellen wollen, klicken Sie auf die
Schaltfläche Einkäufe wiederherstellen.

10 Abonnement

https://www.apple.com/app-store/


Bestehendes Abo verwalten

Sie können Ihr bestehendes Abonnement über das Menü verwalten: Merlin Project →
Abonnement verwalten.

Bei einem Abonnement, das auf dem aktuellen macOS-Gerät aktiviert ist …

… klicken Sie auf Abo verwalten, um dessen Einstellungen einzusehen.

Bei einem Abonnement, das auf diesem macOS-Gerät nicht aktiviert is …

… klicken Sie auf Bestehendes Abo verwalten, um dessen Einstellungen einzusehen.
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Tragen Sie die E-Mail und das Kennwort für Ihr Abonnement ein und klicken auf
Weiter…

Nachfolgend stehen Ihnen die Optionen für die Verwaltung Ihres Abos zur Verfügung:

• Dieses Gerät freischalten

• Abonnement erweitern … (und erwerben Sie Lizenzen für zusätzliche Benutzer
innerhalb des aktiven Abonnements)

• Abonnement kündigen …

• Zahlungsdaten …

• Letzte Rechnung

Mit einem Mausklick auf Schließen beenden Sie den Dialog ohne eine Auswahl getroffen
zu haben.

Haben Sie das Programm aus dem App Store heruntergeladen?

Sobald Sie ein aktives Abonnement, ändert sich der Dialog wie folgt:
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Klicken Sie auf Abonnement verwalten, Sie werden zum App Store weitergeleitet, wo Sie
die Einstellungen für Ihr Abonnement im App Store einsehen können.

Abonnement kündigen

Zum Kündigen eines bestehenden Abos öffnen Sie den Dialog über das Menü Merlin
Project > Abonnement.

Klicken auf Bestehendes Abo verwalten. Tragen Sie die E-Mail und das Kennwort Ihres
Abonnements ein und klicken auf Weiter …. Anschliessend klicken Sie auf Abonnement
kündigen ….


Für Abonnements mit Lizenzen für mehrere Benutzer im Abo, verwenden
Sie bitte die Erweiterte Optionen der zentralen Lizenzverwaltung…

Haben Sie das Programm aus dem App Store heruntergeladen?

Klicken Sie auf Abonnement verwalten. Sie werden zum App Store weitergeleitet, wo Sie
Ihr laufendes Abonnement kündigen können.
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Erste Schritte im Projekt

Die nachfolgende Anleitung hilft Ihnen die ersten Schritte im Projekt zu erlenen.

Neues Projekt öffnen

Wenn Merlin Project startet, ohne dass ein Projekt geöffnet ist, oder wenn Sie Ablage >
Neu … aufrufen, wird folgendes Fenster angezeigt:

Um mit einem neuen Projekt zu starten, klicken Sie auf die Schaltfläche Leeres
Dokument.

Um Ihr neues Projekt aus einer Vorlage zu starten, wählen Sie eine geeignete Vorlage aus
und klicken auf Erstellen.

Um ein bereits vorhandenes Projekt zu öffnen, klicken Sie auf die Schaltfläche
Vorhandenes Dokument öffnen…

Bereits geöffnete Projekte werden in dem Bereich Benutzte Dokumente aufgelistet.
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Projekt benennen

Benennen Sie Ihr Projekt. Klicken Sie hierzu doppelt auf Neues Projekt in der Zeile #0 der
Gliederung und vergeben Sie einen neuen Titel für Ihr Projekt.

Projekt-Inspektor

Mit einem Mausklick auf die Zeile #0 (Das Projekt) erscheint der Inspektor, in dem sich
eine Reihe von Optionen für das markierte Projekt befinden. Hier lassen sich auch der Titel
und das Startdatum des Projekts ändern.


Jeder Inspektor besitzt mehrere Register mit weiteren Optionen.
Selektiert man Bestandteile, wie in diesem Fall die Zeile #0, erscheint
immer der passende Inspektor.
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Startdatum

Klicken Sie im Inspektor auf das Kalendersymbol im Feld Start >Frühestens. Bestimmen
Sie mit dem Kalender den frühesten geplante Start für das Projekt.
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Reguläre Arbeitszeiten

Die Arbeitszeiten werden in den Einstellungen für das jeweilige Projekt festgelegt. Klicken

Sie auf das Symbol Einstellungen (1) und dann auf das Register Kalender (2).

Im abgebildeten Inspektor befinden sich Kalender für die Reguläre Woche sowie
Ausnahmen, wie zum Beispiel Urlaubs- und Extra-Arbeitszeiten.

Klicken Sie auf das Register Reguläre Woche:

Der Standard-Kalender ist aktiv (gesetztes Häkchen). Weitere Kalender stehen in der
Liste zur Auswahl und lassen sich als Kalender fürs Projekt bestimmen.


Mit einem Mausklick auf Plus und Minus lassen sich neue Kalender
erstellen oder vorhandene Kalender löschen.

Klicken Sie auf einen oder mehrere (mit gleichzeitig gedrückter cmd-Taste) Wochentage
und anschließend auf die Arbeitsintervalle zum Ändern der Kalendereinstellungen.


Die Kalender-Einstellungen haben einen direkten Einfluss auf die
Projektplanung und die Arbeitszeit in dem aktiven Projekt.

Nach dem gleichen Prinzip funktionieren die Ausnahmen. Lesen Sie hierzu mehr in der
Anleitung Arbeitsfreie Zeit.
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Ansichten

In Merlin Project existieren diverse Ansichten zum Betrachten des Projekts.

Merlin Project enthält Ansichten für den klassische Strukturplan mit Gantt-Grafik,
Netzplan und Kanban-Board, aber auch für Ressourcen, Zuweisungen, Berichte und
Anhänge.

Die Ansichten unterstützen den in macOS Mojave oder neuer umfassten Dunkelmodus und
ermöglichen Ihnen Ihre Inhalte in unterschiedlichen grafischen Darstellungen zu
bearbeiten und betrachten.



Möchten Sie das Programm im hellen Erscheinungsbild unabhängig
davon wie Ihre Systemeinstellung ist? So aktivieren Sie die Option

Immer hell für das Ansichten-Erscheinungsbild der Einstellungen >
Allgemein.


Auch wenn im Dunkelmodus erfolgt Drucken stets im hellen
Erscheinungsbild, Bildexporte hingegen im aktuell ausgewählten
Erscheinungsbild.

Merlin Project zeigt oben links den Namen der aktuellen Ansicht.

Klicken Sie auf Strukturplan für die Auswahlliste aller Ansichten.
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Klicken Sie auf Eingabe um alle eingebauten Struktuplan-Ansichten zu sehen.

Zusätzliche Option für die Ansichten:

Option Bearbeiten ermöglicht das Modifizieren von vorhandenen Ansichten und sichert
die Änderungen als neue, eigene Ansichten.

Ansicht wechseln

Verwenden Sie das Ansichtenmenü, um zu einer anderen Ansicht Ihres Projektes zu
wechseln.
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Strukturplan

Typischerweise wird im Projektmanagement eine Strukturplan-Darstellung mit einer
Gliederung und einem Balkendiagramm verwendet.

Hierzu finden Sie in Merlin Project folgende Strukturplan-Ansichten:

• Eingabe

• Ablauf

• Fortschritt

• Meilensteine

• Notizen

• Ressourcenabgleich

• Soll/Ist-Vergleich (Zeit)

• Status Kompakt

Benötigen Sie eine Auswertung Ihres Strukturplans nach Zeitphasen, so können Sie eine
der folgenden Strukturplan-Ansichten verwenden:

• Arbeitsverteilung

• Kostenerwartung

• Kostenplanung

• Budgetierung

• Soll/Ist-Vergleich (Kosten)

• Leistungswert

Weitere Ansichten erstellen Sie mit der Option Bearbeiten. Im Fenster Bearbeiten stehen
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Ihnen die eingebauten Ansichten, mit einem Mausklick auf das Plus legen Sie neue
Ansichten an.
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Netzplan

Die Ansicht Netzplan bietet zur Auswahl diverse grafische Planansichten:

• Ablauf

• Kanban

• Kanban Kompakt

• Mind-Map

• Organigramm

• Organigramm mit Status

• PERT

• Phasen

• Status Kompakt


Weitere Ansichten erstellen Sie über die Option Bearbeiten. Im Fenster
stehen Ihnen die bereits vorhandenen Ansichten, mit einem Mausklick
auf das Plus-Symbol legen Sie neue Ansichten an.
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Ablauf

Die Ansicht Ablauf beinhaltert die logischen Zusammenhänge und die Struktur des
Projekts in Form eines Netzplans.

Die Darstellung des Netzplans passen Sie grafisch in den Darstellungsoptionen (1) mit
dem Klappmenü Layout (2) an. Im Inspektor befinden sich weitere Optionen für die
Darstellung des Netzplans.
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Kanban / Kanban Kompakt

Die Ansicht Kanban ist für das agile Projektmanagement gedacht und bietet eine Vielzahl
von Einsatzmöglichkeiten.

Die Ansicht Kanban Kompakt ist eine schlanke Variante der Ansicht Kanban.

Mind-Map

Die Ansicht Mindmap eignet sich für die grafische Darstellung von Projekten. Das Layout
der Mindmap kann in den »Darstellungsoptionen« verändert und grafisch angepasst
werden. Klicken Sie auf das abgebildete Symbol.


Weitere Optionen für die Darstellung der Mindmap lassen sich mit dem
Inspektor Darstellungsoptionen bearbeiten. Klicken Sie hierzu auf das
Schraubenschlüssel-Symbol.

Organigramm

Die Ansicht Organigramm im Netzplan eignet sich für die hierarchische Darstellung
unterschiedlicher Projekte.
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Das Layout des Organigramms kann in den Darstellungsoptionen verändert und grafisch
angepasst werden. Klicken Sie auf den Schraubenschlüssel.
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Ressourcen

Die Ansicht Ressourcen enthält alle im Projekt beteiligten und zugewiesenen Ressourcen.
Damit hat man den Überblick über die im Projekt existierenden Ressourcen.

Ressourcen stehen in den vier folgenden Darstellungen zur Ansicht:

• Arbeit

• Eingabe

• Kosten

• Leistungswert
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Zuweisungen

Die Ansicht Zuweisungen enthält alle im Projekt zugewiesenen Ressourcen. Im Diagramm
stehen für jeden Tag Auslastungswerte der jeweiligen Ressource.

Damit überblicken Sie schnell Auslastungen (rot dargestellt) einzelner Zuweisungen und
machen eventuelle Überlastungen ausfindig und korrigieren diese gegebenfalls.

Die vorhandenen Ansichten für die Zuweisungen sind:

• Ablauf

• Arbeitsverteilung

• Kostenerwartung

• Kostenplanung

• Ressourcenabgleich

• Soll/Ist-Vergleich (Kosten)

• Soll/Ist-Vergleich (Zeit)
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Mit den Ansichten kontrollieren Sie die zugewiesenen Ressourcen im Projekt anhand von
verschiedenen Aspekten, beispielsweise anhand der Kostenerwartungen.
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Bericht

Die Ansicht Bericht ermöglicht das Erstellen von Berichten aus unterschiedlichen
Ansichtsmodulen. Hier lassen sich alle Ansichten miteinander kombinieren um die
benötigten Informationen aus dem Projekt zu berichten.
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Anhänge

Die Ansicht Anhänge ermöglicht einen Überblick über alle Anhänge im Projekt.

Mithilfe des Klappmenüs, lassen sich die Anhänge nach Typ in der Ansicht auflisten:

• Checklisten

• Dateien

• Ereignisse

• Informationen

• Probleme

• Risiken

Darstellungsoptionen

Das Layout der jeweiligen Ansicht kann über den Darstellungsoptionen verändert und
grafisch angepasst werden. Klicken Sie hierzu auf den Schraubenschlüssel.

Dieser Inspektor ist kontextsensitiv und enthält je nach gewählter Ansicht unterschiedliche
Optionen.
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Inspektor »Darstellungsoptionen: Strukturplan«

Dieser Inspektor erscheint, wenn die Ansicht Strukturplan aktiviert ist.

Er enthält folgenden Optionen:

• Kritischer Pfad

• Abhängigkeiten

• Balken

◦ Etiketten

◦ Zweitrangig

◦ Gruppenbegrenzungen

• Zeitphase

◦ Etiketten

◦ Beschreibung (Automatisch, Zeigen und Verbergen)

• Konflikte

◦ Stark

◦ Schwach

• Fortgeschritten
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◦ Änderungen hervorheben

◦ Details in sekundärer Ansicht

◦ Auswahlabhängige Stile

◦ Gesperrte Felder abdimmen

◦ Benachbarte Linien bündeln

◦ Verläufe

◦ Schatten

• Objekte und Sortierungsfelder
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Inspektor »Darstellungsoptionen: Ressources«

Dieser Inspektor erscheint, wenn die Ansicht Ressources aktiviert ist.

Er enthält folgenden Optionen:

• Ressourcenpools (wichtig falls Sie Ressourcenpool verwenden)

• Fortgeschritten

◦ Änderungen hervorheben

◦ Details in sekundärer Ansicht

◦ Auswahlabhängige Stile

◦ Gesperrte Felder abdimmen

• Objekte und Sortierungsfelder
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Inspektor »Darstellungsoptionen: Netzplan«

Dieser Inspektor erscheint, wenn die Ansicht Netzplan aktiviert ist. Er enthält folgenden
Optionen:

• Für Auswahl

◦ Layout

• Kritischer Pfad

• Hierarchielinien

• Abhängigkeiten

• Gruppenbegrenzungen

• Durchkreuzungen

• Konflikte

◦ Stark
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◦ Schwach

• Fortgeschritten

◦ Änderungen hervorheben

◦ Details in sekundärer Ansicht

◦ Auswahlabhängige Stile

◦ Gesperrte Felder abdimmen

◦ Verläufe

◦ Schatten

• Objekte und Sortierungsfelder
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Inspektor »Darstellungsoptionen: Zuweisungen«

Dieser Inspektor erscheint, wenn die Ansicht Zuweisungen aktiviert ist.

Er enthält folgenden Optionen:

• Kritischer Pfad

• Ressourcenpools (wichtig falls Sie Ressourcenpool verwenden)

◦ Alle Pool-Ressourcen

◦ Zuweisungen aus Pools

• Balken

◦ Etiketten

◦ Zweitrangig
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◦ Gruppenbegrenzungen

• Zeitphase

◦ Etiketten

◦ Beschreibung (Automatisch, Zeigen und Verbergen)

• Konflikte

◦ Stark

◦ Schwach

• Fortgeschritten

◦ Änderungen hervorheben

◦ Details in sekundärer Ansicht

◦ Auswahlabhängige Stile

◦ Gesperrte Felder abdimmen

◦ Benachbarte Linien bündeln

◦ Verläufe

◦ Schatten

• Objekte und Sortierungsfelder
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Inspektor »Darstellungsoptionen: Bericht«

Dieser Inspektor erscheint, wenn die Ansicht Bericht aktiviert ist.

Er enthält folgenden Optionen:

• Seitengröße

• Ausrichtung

• Fortgeschritten

◦ Details in sekundärer Ansicht
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Inspektor »Darstellungsoptionen: Anhänge«

Dieser Inspektor erscheint, wenn die Ansicht Anhänge aktiviert ist.

Er enthält folgenden Optionen:

• Fortgeschritten

◦ Änderungen hervorheben

◦ Details in sekundärer Ansicht

◦ Auswahlabhängige Stile

◦ Gesperrte Felder abdimmen
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◦ Anhänge von Unterstruktur
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Darstellungsoptionen in Detail

Ressourcenpools

Die Option Ressourcenpools steht Ihnen in den Darstellungsoptionen der Ansichten
Ressourcen und Zuweisungen zur Verfügung.

Haben Sie in Ihrem Projekt eine Ressourcenpool-Datei eingebunden, aktivieren Sie diese
Option, um die Ressourcen des Ressourcenpools in dieser Ansicht aufzulisten.

Alle Pool-Ressourcen

Die Option Alle Pool-Ressourcen steht Ihnen in den Darstellungsoptionen der
Zuweisungen-Ansichten zur Verfügung.

Haben Sie in Ihrem Projekt eine Ressourcenpool-Datei eingebunden, aktivieren Sie diese
Option, um alle Ressourcen des Ressourcenpools in dieser Ansicht aufzulisten. Ist diese
Option deaktiviert, zeigt Merlin Project nur diese Ressourcen aus dem Ressourcenpool,
die im Projekt übernommen wurden.

Zuweisungen aus Pools

Die Option Zuweisungen aus Pools steht Ihnen in den Darstellungsoptionen der
Zuweisungen-Ansichten zur Verfügung.

Haben Sie in Ihrem Projekt eine Ressourcenpool-Datei eingebunden, aktivieren Sie diese
Option, um in dieser Ansicht auch die Zuweisungen der Ressourcen auf anderen Projekten
aufzulisten, mit denen der Ressourcenpool verknüpft wurde. Wenn diese Option
deaktiviert ist, listet Merlin Project nicht alle Zuweisungen für Ressourcenpool-
Ressourcen auf. Zuweisungen von Ressourcen in anderen Projekten werden dann
ausgeblendet.

Für Auswahl

Der Optionenabschnitt Für Auswahl steht Ihnen in Netzplan-Ansichten zur Verfügung und
beeinflusst das Layout der Kärtchen.
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Das Layout eines Netzplans kann wie folgt gesetzt werden:

• Top-Down

• Mind-Map

• Linke Mind-Map

• Rechte Mind-Map

• Organigramm (weitere Optionen: Organigrammtiefe, Unterspalten)

• Organigramm nach oben (weitere Optionen: Organigrammtiefe, Unterspalten)

• Organigramm geteilt (weitere Optionen: Organigrammtiefe, Unterspalten)

• Gliederung (weitere Option: Unterspalten)

• Gliederung geteilt (weitere Option: Unterspalten)

• Raster (weitere Optionen: Zeilenlayout, Schwimmbahn, Unterspalten)



Die Form der Kärtchen einer Netzplan > Organigramm Ansicht ändern
sich nicht zu Kreise, wenn Sie das Layout von Organigramm zu Mind-
Map ändern. Um die Form der Kärtchen zu ändern, müssen Sie die Stil
und Inhalt > Karten Optionen aufrufen.

Die Rasteroptionen sind für die Ansichten Netzplan > Kanban und Netzplan > Kanban
Kompakt konzipiert.

Kritischer Pfad

Die Option Kritischer Pfad aktiviert/deaktiviert die Anzeige des kritischen Pfades im Gantt-
Diagramm. Hierbei werden die Abhängigkeiten zwischen den Vorgängen grafisch
hervorgehoben.

Die Anzeige des Kritischen Pfads lässt sich auch über das dazugehörige Symbol der
Symbolleiste steuern.



Der kritische Pfad ist immer dann vorhanden, wenn die miteinander
verknüpften Vorgänge Einfluss auf das Projektende nehmen. Jede
Änderung eines der verknüpften Vorgänge auf dem kritischen Pfad führt
automatisch zur einer Veränderung des Endes vom gesamten Projekt.
Mehr Informationen zum kritischen Pfad findet man bei Wikipedia.
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

In der Netzplan > Mind-Map-Ansicht, wo die Verknüpfungslinien per
default nicht angezeigt werden, aktivieren Sie bitte zusätzlich die
Anzeige der Verknüpfungslinien der Abhängigkeiten, wenn Sie den
Kritischen Pfad hervorheben möchten.

Abhängigkeiten

Die Option Abhängigkeiten steht Ihnen in den Darstellungsoptionen der Ansichten
Strukturplan und Netzplan zur Verfügung.

Damit können Sie die Anzeige der Verknüpfungslinien im Gantt zwischen den Balken oder
im Netzplan zwischen den Kärtchen aktivieren oder deaktivieren.
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
Diese Option hat im Strukturplan keine Wirkung, falls Ihre Gantt-Grafik
nicht ein Balkendiagramm sondern eine Zeitphasen-Darstellung ist.

Hierarchielinien

Die Option Hierarchielinien steht Ihnen in Netzplan-Ansichten zur Verfügung.

Die Option Hierarchielinien aktiviert/deaktiviert die Anzeige von Linien, die von
höherliegenden Strukturen in tieferliegenden Strukturen führen. Diese Linien erleichtern im
Netzplan das Hierarchie-Verständnis der jeweiligen Kärtchen, können aber bei Bedarf
abgeschaltet werden.

Durchkreuzungen

Die Option Durchkreuzungen steht Ihnen in Netzplan-Ansichten zur Verfügung.
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Die Option Durchkreuzungen aktiviert/deaktiviert die Anzeige von Durchkreuzungen an
gestarteten und erledigten Kärtchen von Netzplan-Ansichten, welche nach dem Status
kodiert sind. Das sind zB PERT, Organigramm mit Status, Phasen, Kanban , Kanban
Kompakt und Ablauf. Eine Linie am Kärtchen zeigt dass ein Vorgang gestartet ist, zwei
Linien am Kärtchen, dass der Vorgang 100% erledigt ist.

Balken

Der Optionenabschnitt Balken steht Ihnen in den Ansichten Strukturplan und
Zuweisungen zur Verfügung und beeinflusst die Darstellung von Balken im Gantt-
Diagramm.
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Die Option Etiketten aktiviert/deaktiviert die Anzeige der Balken-Beschriftungen.

Es können bis zu drei Etiketten pro Gantt-Element in den Stilen definiert werden.

Die Option Zweitrangig aktiviert/deaktiviert die Anzeige von geplanten Werten. Diese
Werte werden als graue Balken dargestellt und erscheinen automatisch, falls die wirklichen
Werten von den geplanten Werten abweichen.

Darstellungsoptionen | Merlin Project-Handbuch 47



Gruppenbegrenzungen

Die Option Gruppenbegrenzungen aktiviert/deaktiviert die Anzeige von grafischen
Begrenzungen von Gruppen im Gantt-Diagramm.


Die Option Gruppenbegrenzungen erhöht die Übersichtlichkeit bei
Gruppen und Untergruppen.
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Zeitphase

Der Optionenabschnitt Zeitphase steht Ihnen in den Ansichten Strukturplan und
Zuweisungen zur Verfügung und beeinflusst die Darstellung von Zeitphasen im Gantt-
Diagramm.

Die Option Etiketten aktiviert/deaktiviert die Anzeige von Beschriftungen in der jeweiligen
Zeitphase.

Die Option Beschreibung enthält Einstellungen für die Anzeige der Beschreibung der
Zeitphasen-Zeile und kann eine der folgenden Werten haben:
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• Zeigen: Zeitphasenbeschreibung immer anzeigen

• Verbergen: Zeitphasenbeschreibung immer verbergen

• Automatisch: Beschreibungen der Zeitphasen nur dann einblenden, wenn
mehrere Zeitphasen-Zeilen in der aktuellen Ansicht aktiviert sind, wie zB in im
Gantt der Strukturplan > Leistungswert-Ansicht. Es können maximal 3
Zeitphasenzeilen aktiviert.

Konflikte

Diese Optionen erlauben es, die Anzeige von Konflikten im Strukturplan zu kontrollieren.
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Die Option Konflikte aktiviert/deaktiviert die Anzeige aller möglichen Planungskonflikten.

Klappen Sie diese auf, falls Sie Starke oder Schwache Konflikten unterschiedlich anzeigen
lassen möchten.

Die Option Stark aktiviert/deaktiviert die Anzeige von möglichen starken
Planungskonflikten.

Die Option Schwach aktiviert/deaktiviert die Anzeige von möglichen schwachen
Planungskonflikten.

Sie erfahren mehr darüber, was Konflikte sind und wie Sie diese lösen können, hier.

Seitengröße

Der Optionenabschnitt Seitengröße steht Ihnen in den Darstellungsoptionen der Bericht
-Ansichten zur Verfügung.

Wählen Sie das gewünschte Papierformat für die Bericht-Ansicht aus der Liste aus, oder
klicken Sie auf den Papierformat…-Knopf, um den dazugehörigen Seiteneinstellungen-
Dialog aufzurufen und die Optionen dort zu verwenden.


Die Einstellungen für das Papierformat aller anderen Ansichten (wie
Strukturplan, Netzplan, Ressourcen, Zuweisungen, Anhänge) finden Sie
in den Drucken-Dialog.
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Ausrichtung

Der Optionenabschnitt Ausrichtung steht Ihnen Ihnen in den Darstellungsoptionen der
Bericht-Ansichten zur Verfügung.

Setzen Sie die gewünschte Ausrichtung für die Bericht-Ansicht als Querformat oder
Hochformat, oder klicken Sie auf den Papierformat…-Knopf, um den dazugehörigen
Seiteneinstellungen-Dialog aufzurufen und die Optionen dort zu verwenden.


Die Einstellungen für das Ausrichtung aller anderen Ansichten (wie
Strukturplan, Netzplan, Ressourcen, Zuweisungen, Anhänge) finden Sie
in den Drucken-Dialog.

Fortgeschritten

Der Abschnitt Fortgeschritten enthält fortgeschrittene Darstellungsoptionen.

Änderungen hervorheben

Die Option Änderungen hervorheben aktiviert/deaktiviert das Hervorheben der zuletzt
geänderten Werten. Diese Hervorhebung wirkt nur für die Anzeige, wird somit nicht
gedruckt.

Details in sekundärer Ansicht

Die Option Details in sekundärer Ansicht definiert, ob sich die Information der Details-
Ansicht nur auf die aktuelle Selektion der Hauptansicht oder auf das gesamte Projekt
bezieht.


Deaktivieren Sie diese Option, wenn Sie in der Detailansicht
Informationen zu Ihrem gesamten Projekt anzeigen möchten.
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Auswahlabhängige Stile

Die Option Auswahlabhängige Stile aktiviert/deaktiviert die Anzeige von Stilen je nach
Auswahl.

Gesperrte Felder abdimmen

Die Option Gesperrte Felder abdimmen stellt die Anzeige von berechneten oder
gesperrten Feldern in Grau ein/aus.

Anhänge von Unterstruktur

Die Option Anhänge von Unterstruktur steht Ihnen in den Darstellungsoptionen von
Anhänge-Ansichten zur Verfügung. Sie steuert die Anzeige der Anhänge in der Detail-
Ansicht, falls das Projekt-Fenster als eine Haupt- mit einer Detailansicht konfiguriert ist.

Ist diese Option aus, und wählt man in der Hauptansicht eine Zeile in welcher einige
Anhänge definiert sind, so zeigt die Anhänge-Detail-Ansicht diese Anhänge.

Ist diese Option aus, und wählt man in der Hauptansicht eine Zeile in welcher keine
Anhänge definiert sind, so zeigt die Anhänge-Detail-Ansicht keine Anhänge.

Ist diese Option aktiviert, und wählt man in der Hauptansicht eine Zeile, wo Anhänge in
derer Unterstruktur (in Untervorgänge bzw. Kindervorgänge) definiert sind, so zeigt die
Anhänge-Detail-Ansicht die Anhänge der Unterstruktur.

Ist diese Option aktiviert, und wählt man in der Hauptansicht eine Zeile, wo einige Anhänge
und in derer Unterstruktur (in Untervorgänge bzw. Kindervorgänge) weitere Anhänge
definiert sind, so zeigt die Anhänge-Detail-Ansicht die Anhänge der ausgewählten Zeile
und die der Unterstruktur.

Darstellungsoptionen | Merlin Project-Handbuch 53



Benachbarte Linien bündeln

Die Option Benachbarte Linien bündeln stellt die Anzeige von Verknüpfungslinien im
Balkendiagram gebündelt dar. Damit ist die Darstellung der Verknüpfungen im Projekt
grafisch ansprechender.

Verläufe

Die Option Verläufe aktiviert/deaktiviert die Anzeige von Farbverläufen, falls der Verlauf
-Stil für Balkenelemente dieser Ansicht aktiviert ist.

Schatten

Die Option Schatten aktiviert/deaktiviert die Anzeige von Schatten, falls der Schatten-Stil
für Balkenelemente dieser Ansicht aktiviert ist.
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Objekte und Sortierungsfelder

Mit dieser Tabelle lässt sich die aktuelle Ansicht nach bestimmten Feldern ab- oder
aufsteigend sortieren.

Mit einem Mausklick auf das + wird eine neue Sortierungsoption erstellt.
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Projektinhalte erstellen

Plus-Symbol

Am einfachsten geht das erstellen von neuen Vorgängen mit einem Mausklick auf Neu

(das Plus-Symbol in der Symbolleiste) oder noch schneller mit dem Tastaturkurzbefehl
cmd + N.


Wiederholen Sie den Schritt mehrfach, erscheinen die Vorgänge
chronologisch in ihrer Reihenfolge untereinander angeordnet.

Ein neu erstellter Inhalt ist aktiviert und bereit zum Benennen. Versehen Sie den Vorgang

mit einem Titel.



Sie können einen Vorgang schnell in einen Meilenstein umwandeln.
Hierzu setzen Sie im Inspektor das Häkchen bei der Option Meilenstein.
Entfernen Sie das Häkchen, wird aus einem Meilenstein wieder ein
Vorgang.

Optionen beim Einfügen

Klicken Sie auf den Pfeil rechts neben dem Plus, erscheint ein Menü mit weiteren Inhalten
zur Auswahl.
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Damit können Sie je nach aktueller Selektion folgende Inhalte erstellen:

• Vorgang (Erstellt einen Vorgang)

• Meilenstein (Erstellt einen Meilenstein)

• Kind (Erstellt einen eingerückten Vorgang)

• Tante (Erstellt einen ausgerückten Vorgang)

• Vorgänger (Erstellt eine Verknüpfung zum Nachfolger)

• Nachfolger (Erstellt eine Verknüpfung zum Vorgänger)

• Zuweisung (Erstellt eine zugewiesene Ressource)

• Anhang (Erstellt einen Anhang)

• Projekt… (Verknüpft ein anderes Projekt)

• Spalte (Fügt eine Spalte ein)


Tante ist so lange ausgegraut, bis mindestens eine Ebene weiter ein
eingerückter Vorgang selektiert wird. Erst dann wird ein aus dieser
Ebene ausgerückter Vorgang mit der Option Tante erstellt.
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Einfügen-Menü

Die oben aufgeführten Inhalte können Sie auch über das Menü Einfügen erstellen.

Einfügen im Kontextmenü

Zudem lässt sich in der Ansicht mit einem sekundären Mausklick das abgebildete

Kontextmenü aufrufen. Darin befindet sich unter anderen auch die Option Einfügen.


Neue Inhalte werden unter der aktuellen Selektion erstellt. Ist nichts im
Hauptbereich selektiert, werden neue Inhalte direkt unter der letzten
Zeile - am Projektende - angelegt.
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Inhalte

Ein Projekt benötigt Inhalte. Diese Inhalte lassen sich manuell einfügen, aus Vorlagen, der
Bibliothek oder unterschiedlichen Dokumenten übernehmen.


Die Bibliothek ist eine Funktion, die nur in Merlin Project und nicht in
Merlin Project Express zur Verfügung steht.

Import

Merlin Project unterstützt die wichtigsten Dateiformate für den Import:

• CSV Text (für den Import von EXCEL Dateien)

• ics (iCalendar Dateien)

• Merlin 2

• Microsoft Project (.mpp Dateien aus MS Project 2003, 2007, 2010, 2013 und 2016
sowie XML und MPX)

• MindManager / FreeMind / NovaMind 4 & NovaMind 5

• Omniplan 2

• OPML

• Merlin Project XML

Es gibt unterschiedliche Wege neue Inhalte zu importieren:

• Ablage > Öffnen

• Bewegen mit der Maus

Ablage > Öffnen

Rufen Sie Ablage → Öffnen … auf. Es öffnet vorhandene Dokumente. Wird das
ausgewählte Format unterstützt, importiert Merlin Project die Inhalte in einem neuen
Dokument.
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Bewegen mit der Maus

Bewegen Sie ein vorhandenes Dokument direkt auf das Merlin Project Programmsymbol.
Merlin Project importiert die Inhalte in einem neuen Dokument.

Bewegen Sie ein vorhandenes Dokument in ein bereits geöffnetes Projekt-Fenster, so wird
der Inhalt darin eingefügt.
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Inhalte aus Vorlagen

Mit Vorlagen gestaltet sich das Arbeiten mit wiederkehrenden Inhalten einfacher. Sie
eignen sich für die schnelle Erstellung neuer Projekte.

Eine vielzahl von Vorlagen befindet sich im Menü Ablage → Neu … (1).

Selbsterstellte Projekte lassen sich für die spätere Verwendung als Vorlagen sichern.
Wählen Sie Ablage → Als Vorlage sichern … (2), um aus einem Projekt eine eigene
Vorlage zu erstellen.
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Inhalte aus der Bibliothek

In der Bibliothek existieren Inhalte, die sich für das modulare Erstellen von Projekten
eignen. Desweiteren lassen sich eigene Inhalte in der Bibliothek ablegen und jederzeit in
allen Projekten verwenden.

Rufen Sie Fenster → Bibliothek im Menü auf, um die Bibliothek zu öffnen.

Eigene Vorgangsgruppen bewegt man in die Bibliothek mithilfe des Mauszeiger. Diese
Inhalte werden automatisch in der Bibliothek für die spätere Nutzung gesichert.
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Arbeit und Dauer

In Merlin Project können Sie Vorgänge nach Arbeit, Dauer, Start- und
Enddatumseinschränkungen planen.

Wählen Sie einfach einen Vorgang aus, verwenden Sie den Plan-Inspektor und definieren
Sie Ihren Vorgang wie gewünscht. Alternativ können Sie zugehörige Spalten in der
Gliederung verwenden.


Für eine flexible Planung und leichtere Anpassung während der
gesamten Laufzeit Ihres Projekts empfehlen wir Ihnen, so wenige Start-
und Enddaten wie möglich und so viele wie nötig zu definieren.

Arbeit

Wenn Sie Ihren Vorgang nach dem Aufwand planen möchten, der für seine Durchführung
erforderlich ist, verwenden Sie den Plan-Inspektor oder geben Sie den Aufwand in der
Spalte Vorgabe Arbeit in der Gliederungsspalte ein.

Beispiel

Sie möchten den Anstrich eines Raumes planen. Sie schätzen den erforderlichen Aufwand
für die Tätigkeit auf 2,5 Arbeitstage. Sie erwarten, dass bei der Zuweisung dieses
Vorgangs an z.B. zwei Ressourcen der Aufwand für jede Ressource nur halb so groß sein
wird.

• Sie legen hierzu einen neuen Vorgang an.

• Wählen Sie diesen aus.

• Wechseln Sie zum Plan-Inspektor.

• Ändern Sie den Wert Arbeit in 2,5 Tage.

• Lassen Sie den Wert im Feld Dauer leer.



Sie können den Standardwert '1 Tag ?' für Arbeit in Einstellungen >
Allgemein > Arbeit ändern. Das ? zeigt an, dass der Wert geschätzt ist.
Entfernen Sie es, wenn Sie sich über den Wert sicher sind oder nicht so
viele Details in Ihrer Planung benötigen.
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Alternativ: Sie können den Wert Vorgabe Arbeit in der Gliederungsspalte bearbeiten.

Dauer

Wenn Sie Ihren Vorgang nach einer festen Dauer planen möchten, verwenden Sie den
Plan-Inspektor oder geben Sie den Aufwand in der Gliederungsspalte Vorgabe Dauer ein.

Beispiel

Sie möchten ein Seminar planen. Die Dauer für dieses Seminar beträgt 2 Arbeitstage. Sie
erwarten, dass bei der Zuweisung an Ihr Trainer-Personal alle zugewiesenen Trainer
während der gesamten Dauer dieses Seminars arbeiten werden.

• Sie legen hierzu einen neuen Vorgang an.

• Wählen Sie diesen aus.

• Wechseln Sie zum Plan-Inspektor.

• Löschen Sie den Wert Arbeit.

• Geben Sie 2 Tage in das Feld Dauer ein.


Sie können den Standardwert für die Dauer unter Einstellungen >
Allgemein > Dauer anpassen.

Alternativ: Sie können den Wert Vorgabe Dauer in der Gliederungsspalte bearbeiten.

Beispiel Team Meeting

Sie planen ein Team Meeting an einem Standort ausserhalb des Unternehmens. Sie
möchten mit einem Aufwand von 1,5 Arbeitstagen planen, müssen aber auch 3
Arbeitstage Ihres Teams für die Gesamtdauer blockieren. Innerhalb dieser 3 Tage fährt Ihr
Team zur Location, arbeitet für diese 1,5 Arbeitstage und kehrt anschliessend zurück zu
Ihrem Unternehmensstandort.

• Sie legen hierzu einen neuen Vorgang an.

• Wählen Sie diesen aus.

• Wechseln Sie zum Plan-Inspektor.

• Ändern Sie den Wert Arbeit in 1,5 Tage.

Arbeit und Dauer | Merlin Project-Handbuch 65



• Geben Sie 3 Tage in das Feld Dauer ein.

Beispiel für ein 72-Stunden-Ereignis

Sie möchten eine Veranstaltung planen, von der Sie wissen, dass sie 3 Kalendertage lang
sein wird. Sie beginnt am Freitag, und das Wochenende (das normalerweise keine
Arbeitszeit ist) sollte in die Gesamtdauer einbezogen werden.

• Sie legen hierzu einen neuen Vorgang an.

• Wählen Sie diesen aus.

• Wechseln Sie zum Plan-Inspektor.

• Leeren Sie den Wert Arbeit.

• Geben Sie 3 fTage in das Feld Dauer ein.

Alternativ: Sie können den Wert Vorgabe Dauer in der Gliederungsspalte bearbeiten.


Eine solche Veranstaltung, die am Freitag beginnt und am Montag endet,
umfasst nur die Arbeitszeiten am Freitag. Wenn Sie den enthaltenen
Aufwand anpassen möchten, ändern Sie den Wert Arbeit entsprechend.

Beispiel für das Verlegen einer Betonplatte

Sie möchten das Verlegen einer Betonplatte planen. Sie schätzen den erforderlichen
Aufwand für die Aktivität auf 1,5 Arbeitstage. Sie wissen, dass Beton direkt beim Gießen
zu trocknen beginnt und eine Gesamttrocknungszeit von mindestens 1 Kalenderwoche
benötigt.

• Sie legen hierzu einen neuen Vorgang an.
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• Wählen Sie diesen aus.

• Wechseln Sie zum Plan-Inspektor.

• Ändern Sie den Wert Arbeit in 1,5 Tage.

• Geben Sie 1 fWoche in das Feld Dauer ein.

Alternativ: Sie können die Werte Vorgabe Arbeit und Vorgabe Dauer in den
Gliederungsspalten bearbeiten.

Arbeitszeiten

In den vorhergehenden Beispielen haben wir die Begriffe Arbeitstage, Arbeitswoche
verwendet.

Der Einfachheit halber geben wir sie in Merlin Project als "2 Tage" oder "1 Woche" ein.

Wie wird in anderen Einheiten umgerechnet?

Überprüfen wir die Standardeinstellungen in Einstellungen > Allgemein > Arbeit

Standardmäßig beträgt 1 Arbeitstag 8 Arbeitsstunden, 40 Arbeitsstunden ergeben eine
Woche und 20 Tage im Monat.

Also sind "2 Tage" die "2 Arbeitstage" von jeweils "8 Arbeitsstunden". 1 Woche" bedeutet
"40 Arbeitsstunden", was sich als "5 Arbeitstage" oder "8 Arbeitsstunden" jeweils
berechnet.

Wann beginnen oder enden die Arbeitszeiten?
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Überprüfen wir die Standardeinstellungen in Einstellungen > Kalender

• Wählen Sie den Kalender, bei dem das Kontrollkästchen Projektkalender
aktiviert ist

• Prüfen Sie die Registerkarte Regulare Woche.

Standardmäßig gibt es 5 Arbeitstage: Montag bis Freitag. Jeder Arbeitstag umfasst
Arbeitsintervalle von 8.00 bis 12.00 Uhr und 13.00 bis 17.00 Uhr.

Die Arbeitszeit am Montag beginnt also um 8 Uhr morgens und endet um 17 Uhr abends.



Sollten Sie sich dafür entscheiden, Ihre Regulare Wochen- oder
Arbeitsintervalle in Einstellungen > Kalender anzupassen, stellen Sie
sicher, dass Sie auch Ihre Standardeinstellungen in Einstellungen >
Allgemein > Arbeit an die neuen Werte anpassen.

Wie lang sind die Arbeitszeiten wirklich?

Wählen wir eine Aktivität von '2,5 Tagen' Arbeit und öffnen den Plan-Inspektor.

Wir sehen in der Erwartet Gruppe
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• Arbeit: 2,5 Tage

• Dauer: 2,5 Tage (2,17 Tage)

Wir wissen, dass 2,5 Tage 2,5 Arbeitstage und 20 Arbeitsstunden sind. Diese Tätigkeit hat
den gleichen Aufwand und die gleiche Dauer.

2,17 Tage ist die fortlaufende Kalenderzeit und der Zeitraum, in dem die Aktivität
voraussichtlich abgeschlossen sein wird. Das Präfix "f" steht für "fortlaufend".

Wie werden die fortlaufende F-Dauern berechnet?

Die verstrichene Dauer ist die Dauer einschließlich der darin enthaltenen Freizeit.

Standardmässig und gemäss den Einstellungen (Einstellungen > Kalender) beginnt ein
regulärer Arbeitstag um 8 Uhr, enthält eine Mittagspause zwischen 12 und 13 Uhr und
endet um 17 Uhr.
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Einen Vorgang mit den geplanten 2,5 Tagen Arbeit, die um 8 Uhr morgens beginnt,
erfordert für die ersten 8 Stunden (vier am Morgen, vier am Nachmittag) 9
aufeinanderfolgende Stunden (fStunden) am ersten Tag.

Die Arbeiten enden um 17.00 Uhr und beginnen am nächsten Tag um 8.00 Uhr. Es gibt
also 15 Stunden freie Zeit. Von 8.00 Uhr bis 17.00 Uhr am zweiten Tag sind es weitere 8
Stunden (9 fStunden), bis um 17.00 Uhr wieder 15 Stunden Freizeit beginnen.

Die verbleibenden 4 Stunden können am dritten Tag von 8 Uhr morgens bis 12 Uhr abends
eingeplant werden. Zu den 20 Stunden Arbeit kommen also 32 Stunden Freizeit hinzu, was
52 Stunden ergibt.

52 fStunden geteilt durch 24 fStunden ergibt 2,16666 fTage oder 2,17 fTage.

Sollten Sie die Berechnungseinheit auf Stunde ändern in Einstellungen > Allgemein >
Dauer …
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Und noch einmal Ihren Vorgang auswählen, werden Sie die erwarteten Werte in Stunden
sehen:

• Arbeit: 20 Stunden

• Dauer: 20 Stunden (52 fStunden)
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Erstellen von Projektstruktur

Zum Strukturieren des Projektes eignet sich das Zusammenfassen von Vorgängen in
Gruppen. Damit lassen sich einzelne Phasen im Projekt übersichtlicher abbilden.

Einrücken

Das Einrücken von Vorgängen in der Gliederung erzeugt automatisch Gruppen und bei

Bedarf weitere eingerückte Untervorgänge (Kinder) und Untergruppen.

Die Folge einer Einrückung in eine weitere Ebene ist die Erstellung eines Untervorgangs
und automatisch einer daraus resultierenden Gruppe.

Der jeweils über den eingerückten Inhalten liegende Vorgang wird automatisch zu einer
Gruppe grafisch erkennbar an dem Gruppenbalken.


Ein Projekt ist immer eine Gruppe und lässt sich wie alle Gruppen mit
dem kleinen Dreieck auf- und zuklappen.

Ausrücken

Mit dem Ausrücken-Symbol bewegt man Vorgänge aus einer Gruppe und den
untergeordneten Gruppen heraus.

Markieren Sie einen oder mehrere Vorgänge und klicken anschließend auf das Ausrücken
-Symbol.
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Das Ausrücken ist nur aktiv, wenn sich die selektierten Vorgänge oder Meilensteine bereits

in einer Gruppe befinden. Ein ausgerückter Vorgang heißt Tante.



Die Einrückung lässt sich auf mehrere gleichzeitig ausgewählte
Vorgänge/Meilensteine anwenden. Zudem lassen sich Vorgänge
mithilfe der Maus in andere Vorgänge verschachteln oder über das
Menü Struktur > Einrücken oder Struktur > Ausrücken und den
dazugehörigen Tastaturkurzbefehlen cmd + → oder cmd + ← in den

Ebenen ein- bzw. ausrücken.
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Verknüpfen

Diese Anleitung zeigt wie man in Merlin Project Abhängigkeiten schafft.

Weshalb Verknüpfen

Das verbinden von Inhalten im Projekt hat ein Ziel, die Reihenfolge, in der sich die
Vorgänge logisch abarbeiten lassen, zu bestimmen.

Beispiel: Erst wenn Vorgang A zu ende (fertiggestellt) ist, kann Vorgang B beginnen.
Vorgang A ist der Vorgänger von Vorgang B dem Nachfolger.

Verknüpfungen erstellen

Vorhandene Vorgänge im Projekt lassen sich verknüpfen. Beim Verknüpfen entstehen
Abhängigkeiten, die eine logische Reihenfolge bestimmen.

Wählen Sie mindestens zwei Vorgänge, die Sie miteinander verknüpfen möchten.

In der Symbolleiste befindet sich die Schaltfläche Verknüpfen. Klickt man auf den Pfeil
rechts neben dem Verknüpfen-Symbol, erscheint die Auswahl der Möglichen
Verknüpfungsarten sowie die Option zum Trennen von vorhandenen Verknüpfungen.

Klicken Sie auf Verknüpfen oder verwenden den Tastaturkurzbefehl ctrl + cmd + L für

die Verknüpfungsart Ende zu Start. Die beiden Vorgänge sind nun mit einem Pfeil
miteinander verknüpft.
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Alternativen

Alle Wege führen nach Rom, so auch die verschiedenen Möglichkeiten für die Erstellung
von Verknüpfungen.

Menü und Kontextmenü

Im Menü Struktur → Verknüpfen befinden sich die gleichen Optionen.


Mit einem sekundären Mausklick auf ausgewählte Inhalte erscheint das
Kontextmenü. Darin befindet sich die Option Verknüpfen mit den vier
Verknüpfungsarten.

Verknüpfen mit Maus

Die Verknüpfungen lassen sich auch mithilfe der Maus direkt im Gantt-Diagramm erstellen.
Halten Sie die alt-Taste gedrückt, bewegen Sie den Mauszeiger auf einen Vorgangsbalken
oder Meilenstein.

Der kleine schwarzen Punkt erscheint auf dem Vorgang. Bewegen Sie die Maus, bei
gleichzeitig gedrückter alt-Taste, auf einen weiteren Vorgang (Nachfolger).

Beim Loslassen der Maustaste wird die Verknüpfung erstellt.

Verknüpfungen erstellen | Merlin Project-Handbuch 75



Verknüpfen mit Spalten

In den Spalten Vorgänger oder Nachfolger sieht man die Vorgangsnummern (#) der
Vorgänger bzw. Nachfolger.

Tragen Sie in die Spalten einen Wert, wird automatisch eine Verknüpfung zu dem
Vorgänger oder Nachfolger erstellt.

 Die Spalte Nachfolger ist standardmäßig nicht aktiviert.

Verknüpfungen trennen

Zum Trennen von Verknüpfungen, selektieren Sie eine Verknüpfungslinie mit einem
Mausklick und drücken die Löschtaste auf der Tastatur.

Bei mehreren zu löschenden Verknüpfungen, selektiert man alle Vorgänge und verwendet
die Option Trennen in einem der Verknüpfen-Menüs.
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Inspektor Abhängigkeit

Selektieren Sie eine Verknüpfung, erscheint der Inspektor Abhängigkeit.

Die im Inspektor enthaltenen Optionen sind zuständig für die Abhängigkeit der
verknüpften Vorgänge, Gruppen und Meilensteine.

An dieser Stelle lassen sich die Vorgänger und Nachfolger anpassen und zudem schnell im
Projekt mit einem Mausklick auf den Pfeil auffinden.

Im Klappmenü Art stehen die Verknüpfungsarten zur Auswahl. Hiermit ändert man die
aktuelle Verknüpfung:

• Ende zu Start

• Ende zu Ende

• Start zu Start

• Start zu Ende

Puffer in Verknüpfungen

Mit einem Mausklick auf eine Verknüpfungslinie rufen Sie den Inspektor für die
Abhängigkeit auf.

Tragen Sie in das Feld Puffer einen beliebigen Zeitwert ein, damit verlängern Sie die
Abhängigkeit zwischen den miteinander verknüpften Vorgängen.
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Wird ein negativer Zeitwert eingetragen, bewegt sich die Abhängigkeit und somit der
verknüpfte Vorgang in der Zeitlinie um den eingetragenen Pufferwert zurück. Tragen Sie

zum Beispiel -2 Tage in das Feld Puffer ein.


Puffer lassen sich manuell in den Spalten Vorgänger oder Nachfolger
eintragen.

Beispiel: Tragen Sie bei einem Vorgang in die Spalte Nachfolger den Wert 5EA+2 Tage
ein wird eine Ende zu Start-Verknüpfung mit dem Vorgang #5 erstellt und einem Puffer

von 2 Tagen.

Vorgang #5 erhält automatisch den Eintrag 1EA+2Tage in der Spalte Vorgänger.
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Ressourcen

Was sind Ressourcen

Ressource ist ein Begriff für Personen, Materialien und Ausrüstung, die im Projekt
verwendet werden.

In Merlin Project sind folgende Ressourcentypen möglich:

• Person (aktiv oder inaktiv am Projekt beteiligt)

• Material

• Firma

• Ausrüstung

 Der standardmäßig erstellte Ressourcentyp ist die Ressource Person.
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Ressourcen erstellen

Das Symbol Ressourcen öffnet ein Pop-Up-Fenster, das Ressourcenquelle genannt
wird, in dem alle Ressourcen Ihres Projektes aufgelistet sind.

In der Ressourcenquelle lassen sich neue Ressourcen mit einem Mausklick auf Neue
Ressource schnell im Projekt erstellen.
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Ressourcenquelle benutzen

Die Ressourcenquelle eignet sich für die schnelle Übersicht von bereits vorhandenen
Ressourcen im Projekt.

Für mehr Informationen über Ihre Ressourcen und für eine detailliertere Bearbeitung derer
Werte klicken Sie auf Ressourcen-Ansicht. Merlin Project blendet schnell diese Ansicht
ein.


Wechseln Sie in die Ressourcen-Ansicht, um ein Bild für Ihre
Ressource einzufügen.

Die Ressourcenquelle lässt sich als eigenständiges Fenster verwenden. Bewegen Sie das
Fenster mit dem Mauszeiger nach unten.
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
Mit der F4-Taste oder über das Menü Fenster wird die
Ressourcenquelle schnell als eigenständiges Fenster ein- und
ausgeblendet.
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Zuweisungen erstellen

Bewegen Sie eine Ressource aus der Ressourcenquelle auf einen Vorgang, Gruppe oder
Meilenstein. Es wird automatisch eine Zuweisung erstellt.


Eine zum Vorgang zugewiesene Ressource nennt man Zuweisung.
Diese Ressource übernimmt die Arbeit an dem ihr zugewiesenen
Vorgang im Projekt.

Die Zuweisungen sind an dem weißen Dreieck erkennbar. Es lassen sich mehrere
Zuweisungen zum einem Vorgang erstellen. Diese teilen sich automatisch die Arbeit.

Bei selektierten Vorgängen in einer Ansicht, erscheint in der Ressourcenquelle die Option
Zuweisen. Damit lassen sich durch das Setzen eines Häkchens weitere Ressourcen
schnell als Zuweisungen zum Vorgang hinzufügen.
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Entfernt man das Häkchen, wird die zugewiesene Ressource ebenfalls vom Vorgang
entfernt.


Über das Menü Einfügen → Zuweisung oder den dazugehörigen

Tastaturkurzbefehl alt + cmd + A lassen sich automatisch neue
Zuweisung für die selektierten Vorgänge erstellen.
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Zuweisung zu Kontakten aus der Kontakte.app

Merlin Project erlaubt es Ihnen, Kontakte aus der Kontakte.app als Ressourcen in Ihrem
Projekt zu verwenden.

Öffnen Sie die Kontakte.app, wählen Sie die betreffenden Kontakte aus. Verwenden Sie
die Maus, um sie auf Vorgänge, Meilensteine oder Gruppen zu ziehen und fallen zu lassen.
Diese Kontakte werden dem Projekt als Ressourcen hinzugefügt und den Vorgängen
automatisch zugeordnet.
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Zeitskala

In dieser Anleitung finden Sie grundlegende Informationen im Umgang mit der Zeitskala in
Merlin Project.

Was ist die Zeitskala

Die Zeitskala ist die Anzeige der Zeit im Balkendiagramm. Die Zeitskala beinhaltet
standardmäßig zwei Reihen, die obere und die untere.

Im Inspektor für die Zeitskala lassen sich unterschiedliche Anpassungen für die
Zeiteinheiten und weitere Optionen bestimmen.

Zeitskala Inspektor

Klicken Sie auf eine Reihe in der Zeitskala, der dazugehörige Inspektor öffnet sich.

Darin befinden sich Optionen für die Anpassung der angeklickten Zeitskala sowie
Einstellungen für den Zeitbereich und die Arbeitsfreien Zeiten.


Die selektierte Zeitskala ist blau eingefärbt. Die Optionen gelten jeweils
nur für diese ausgewählte Reihe der Zeitskala.

• Einheit (Minuten / Stunden / Tagen / Wochen / Monate / Quartale / Jahre)

• Zeiteinheit fixieren (fixiert die gewählte Gantt-Einheit, damit sie auch beim
etwaigen Zoomen der Ansicht beibehalten wird)

• Datumsformat (absolute und relative Formate für die Anzeige der Einheiten, zB
vom Projektstart oder Ende)
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Aktuelle Einheit

Wenn Sie die Option Aktuelle Einheit aktivieren, wird die Zeiteinheit im Gantt-Diagramm,
in der das Statusdatum enthalten ist, blau schattiert. Damit haben Sie am Gantt des
Projekts eine zusätzliche Markierung, die Ihnen hilft, die Aufgaben, die in diesem Zeitraum
anstehen, schnell visuell zu identifizieren.

Zeitlinie

Mit der Option Zeitlinie können Sie - ähnlich zu der Option aktuelle Einheit - eine vertikale
Markierung im Gantt-Chart.

Setzen Sie ein Häkchen bei der Option Zeitlinie, erscheint das Statusdatum als eine
dünne rote Linie am Gantt des Projekts.


Das Statusdatum aktualisiert sich standardmäßig automatisch und
bezieht sich auf das Datum und Uhrzeit des macOS, lässt sich aber auch
bei Bedarf in den Projekt-Einstellungen festlegen.
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Zeitskala Kontexmenü

Mit einem sekundären Mausklick auf die Zeitskala erscheint das Kontextmenü.

Neue oberste Reihe

Mit der Option Neue oberste Reihe können Sie eine weitere Reihe in die Zeitskala
einfügen.

 Die Zeitskala kann bis zu vier Reihe zeigen.

Reihe entfernen

Mit der Option Reihe entfernen lässt sich die ausgewählte Reihe aus der Zeitskala
löschen.

 Die Zeitskala erfordert mindestens eine Reihe.

Skalierung an Texte anpassen

Die Option Skalierung an Text anpassen ermöglicht die automatische Anpassung der
Breite aller aktiven Zeitskala-Spalten.

Der vorhandene Platz der Zeitskala wird automatisch auf die optimale Breite eingestellt.

Vergrößern / Verkleinern

Die Zeitskala wird entsprechend der Auswahl vergrößert oder verkleinert.

Die Inhalte der Zeitskala wachsen oder schrumpfen mit. Die Zeiteinheiten werden
automatisch bei Bedarf angepasst.

An Projekt anpassen

Mit der Option An Projekt anpassen wird die Zeitskala an das Projekt angepasst.

Das gesamte Projekt wird soweit gezoomt, bis es insgesamt in den sichtbaren Bereich
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passt. Die Zeitskala wächst dabei automatisch mit.

An Auswahl anpassen

Mit der Option An Auswahl anpassen wird die Zeitskala an die im Projekt ausgewöhlten
Vorgänge angepasst.

Die Auswahl wird soweit gezoomt, bis sie insgesamt in den sichtbaren Bereich passt. Die
Zeitskala wächst oder schrumpft dabei automatisch mit.


Es muss mindestens ein Vorgang, Gruppe oder Meilenstein im Projekt
ausgewählt sein, damit diese Option aktiv ist.

Erledige Arbeit bis

Die Option Erledige Arbeit bis stellt alle im Projekt enthaltenen Vorgänge auf den Status
Erledigt, bis zum in der Zeitskala angeklickten Datum.

So lässt sich leicht der Fortschritt des Projekts mit einem Mausklick bestimmen.

Stil

Die Option Stil ändert das grafische Aussehen der Zeitskala.

 Mehr zu den Stiloptionen findet Sie in der Anleitung Stile und Inhalte.
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Zeitbereich

Die Option Zeitbereich beinhaltet Einstellungen für die Einschränkung des sichtbaren
Zeitbereichst im Projekt.

Das ist besonders bei großen Projekten hilfreich. Zeitabschnitte die sich in der
Vergangenheit befinden lassen sich ausblenden. Der Fokus liegt auf den sichtbaren
Zeitbereich.

Zeitbereich einschränken

Den Zeitbereich bestimmt man im Inspektor für die Zeitskala.

Klicken Sie auf die Zeitskala. Der Inspektor wird eingeblendet. Darin befinden sich die
Optionen für den Zeitbereich.

Bestimmen Sie das gewünschte Start- und Enddatum für die Anzeige des Zeitbereichs.
Klicken Sie hierzu auf das Kalendersymbol und auf das gewünschte Datum.


Lassen Sie das Enddatum leer, wird automatisch das Ende des Projekts
als Enddatum für das Ende des Zeitbereichs übernommen.
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Ist der Zeitbereich eingestellt, wird die Anzeige des Projekts automatisch auf den
festgelegten Zeitraum beschnitten. Ein blauer Balken oberhalb des Gantt-Diagramms (1)
deutet auf den aktivierten Zeitbereich hin.

Zeilen Ausblenden

Im Inspektor erscheint eine weitere Option, mit der Sie die Anzeige von ausgeblendeten
Zeilen in der Gliederung steuern können.

Sie haben drei Optionen zur Auswahl:

• Nie

• Mit Hauptbalken außerhalb des Bereichs (standardmäßig)

• Mit Haupt- und Referenzbalken außerhalb des Bereichs

Nie blendet alle Zeilen ein, beispielsweise auch die Zeilen mit Verknüpfungslinien die sich
im Zeitbereich befinden, aber die dazugehörigen Vorgangsbalken nicht im Zeitbereich
sichtbar sind.

Mit Hauptbalken außerhalb des Bereichs sind alle Zeilen gemeint, die einen
Vorgangsbalken enthalten, diese aber nicht im Zeitbereich liegen.

Mit Haupt- und Referenzbalken außerhalb des Bereichs sind alle Zeilen gemeint, die
einen Vorgangsbalken und einen Referenzbalken enthalten, diese aber nicht im
Zeitbereich liegen.

Zeitbereich | Merlin Project-Handbuch 91




Referenzbalken sind die grauen Balken, die den ursprünglich geplanten
Zustand des Vorgangs darstellen. Sie lassen sich in den
Darstellungsoptionen mit der Option Zweitrangig steuern.

Etiketten

Im Klappmenü Etiketten befinden sich Einstellungen für das Steuern der Anzeige von
Etiketten beim aktivierten Zeitbereich.

Mit der standardmäßig voreingestellten Option Sichtbaren Bereich erweitern, werden
die Etiketten komplett angezeigt.

Mit der Option Am Rand abschneiden, werden die Etiketten am Rand des Zeitbereichs
abgeschnitten.
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Arbeitsfreie Zeit

Arbeitsfreie Zeit anzeigen

Die arbeitsfreie Zeit wird in Merlin Project ausgegraut dargestellt. Beispielsweise sind die
Wochenenden im Projektkalender standardmäßig abgedimmt.

Klicken Sie auf die Zeitskala. Im Inspektor finden Sie drei Optionen für die Anpassung der
arbeitsfreien Zeit.

Basiert auf

Mit der Option Basiert auf bestimmen Sie den Kalender anhand dessen die arbeitsfreie
Zeit im Projekt dargestellt ist.



Standardmäßig ist der Projektkalender als Basis für die als arbeitsfreie
Zeit voreingestellt. Im Klappmenü befinden sich weitere Kalender zur
Auswahl. Die Kalender befinden sich in den Projekteinstellungen und
lassen sich dort bearbeiten.
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Abdimmen

Die Option Abdimmen verfügt über drei Optionen für die Anzeige der arbeitsfreien Zeit
im Projekt:

• Nicht

• Einheitlich

• Individuell pro Zeile

Die Option Nicht schaltet die abgedimmte Darstellung der arbeitsfreien Zeit im Projekt
aus.

Die Option Einheitlich ist standardmäßig eingestellt. Es werden die arbeitsfreien Zeiten
für die reguläre Woche im Projekt angezeigt.

Schalten Sie die Option Individuell pro Zeile ein, damit Sie die arbeitsfreien Zeiten von
Ressourcen und deren Urlaubszeiten im Projekt in der jeweiligen Zeile sehen.
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Regelmäßige arbeitsfreie Zeit

Mithilfe des Schiebereglers bestimmen Sie, ob die regelmäßig auftretenden
arbeitsfreien Zeiten gezeigt oder verborgen werden.

Dabei stehen Ihnen die folgenden Optionen für die Anzeige der regelmäßigen
Arbeitszeiten zur Auswahl:

• Alles zeigen

• Alle regelmäßig arbeitsfreien Minuten verbergen

• Alle regelmäßig arbeitsfreien Stunden verbergen

• Alle regelmäßig arbeitsfreien Tage verbergen

• Alle arbeitsfreien Tage verbergen

• Alle arbeitsfreien Zeiten verbergen


Die Auswirkungen der Einstellung des Schiebereglers sind abhängig von
der gewählten Zoom-Stufe in der aktiven Ansicht.

Arbeitsfreie Zeit | Merlin Project-Handbuch 95



Kommentare

Mit Merlin Project können Sie Kommentare nutzen, um die Zusammenarbeit mit Ihren
Teammitgliedern bei Ihren Projekten zu verbessern.

Neuer Kommentar

Sie können bei Bedarf Kommentare zu jedem sichtbaren Zeilenelement jeder
Projektansicht einfügen.

• Wählen Sie eine Zeile in Ihrer Ansicht aus.

• Rufen Sie Einfügen → Kommentar im Menü auf (oder verwenden Sie das
Tastaturkürzel alt + cmd + K ).

• Geben Sie den gewünschten Text ein.

• Drücken Sie RETURN, um den neuen Kommentar zu bestätigen.

Alternativ

• Wählen Sie eine Zeile in Ihrer Ansicht aus.

• Öffnen Sie den Anmerkungen-Inspektor.

• Wechseln Sie zur Registerkarte Kommentare .

• Klicken Sie auf Neuer Kommentar, wie unten auf dem Anmerkungen-Inspektor
angezeigt wird.
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• Geben Sie den gewünschten Text ein.

• Drücken Sie RETURN, um den neuen Kommentar zu bestätigen.

Eingefügte Kommentare zeigen folgende Informationen:

• Erstellungsdatum

• Autor

• Autor-Initialen oder Bild

• Text

Erstellungsdatum

Das Erstellungsdatum wird als relativer Zeitpunkt (heute, gestern usw.) angezeigt und
enthält das Datum und die Uhrzeit des jeweiligen Kommentars.

Autor

Merlin Project berechnet den Namen des Autors in den Kommentar.

Es gibt verschiedene Fälle:

Wenn ein Projekt nur die Standard-Ressource enthält
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Neue Kommentare zu Projektdateien zeigen Anonym als Autor.

Wenn ein Projekt Ressourcen enthält, aber keine von ihnen als Benutzer-Ressource
eingestellt ist

Neue Kommentare zu Projektdateien zeigen Anonym als Autor.


Sie können eine Ressource aus der Liste auswählen, um den Autor des
Kommentars zu definieren.

Wenn ein Projekt Ressourcen enthält und einige von ihnen als Benutzer-Ressource
eingestellt sind

Neue Kommentare zu Projektdateien zeigen den Titel der Benutzer-Ressource, die sie
eingefügt hat.
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Autor-Initialen oder Bild

Es gibt verschiedene Fälle:

Wenn für eine Ressource kein bestimmtes Bild definiert hat.

Neue Kommentare zeigen die Initialen der Ressource.

Wenn man ein Ressourcenbild für die spezifische Ressource in eine Ressourcenansicht
eingefügt hat

Neue Kommentare zeigen eine Miniaturansicht des Bildes des Autors.
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Text

Der Text zum Kommentar.


Sie können den Text der Kommentare bei Bedarf zu einem späteren
Zeitpunkt bearbeiten.

Kommentare betrachten

Wenn Sie ein Projekt mit Kommentaren öffnen, gibt es verschiedene Möglichkeiten, die
eingefügten Kommentare anzuzeigen.

Verwenden Sie den Inspektor

• Eine Zeile in Ihrer Ansicht auswählen.

• Öffnen Sie den Anmerkungen-Inspektor.

• Wechseln Sie zur Registerkarte Kommentare.

Klicken Sie auf das Kommentar-Symbol, wie in der Info-Spalte angezeigt wird.

Falls die Infospalte in der Gliederung sichtbar ist und Kommentare zu beliebigen Zeilen
dieser Ansicht eingefügt wurden, klicken Sie einfach auf das Kommentarsymbol einer
beliebigen Zeile, damit Merlin Project alle Kommentare im Anmerkungen-Inspektor für
diese bestimmte Zeile anzeigt.

Im Fenster Mitteilungen

Neue Kommentare werden im Mitteilungen Fenster aufgelistet.

• Klicken Sie auf das Mitteilungen Symbol in der Symbolleiste, um dieses Fenster
zu öffnen.

• Wechseln Sie zur Registerkarte Kommentare.
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Dieses Fenster listet alle Kommentare auf, die zu allen Elementen eingefügt wurden.
Klicken Sie eine beliebige Zeile doppelt, damit Merlin Project zum jeweiligen Kommentar im
Anmerkungen-Inspektor wechselt, wo Sie bei Bedarf mit einem neuen Kommentar
antworten können.

Falls Sie sich entscheiden, gelesene Kommentare aus der Liste zu entfernen, klicken Sie
einfach auf die Schaltfläche "Gelesene entfernen".

Bearbeiten

Wenn Sie Kommentare bearbeiten möchten, gibt es verschiedene
Anwendungsmöglichkeiten

Wenn ein Projekt nur die Standardressource enthält oder keine der vorhandenen
Ressourcen als Benutzer-Ressource eingestellt ist

Jeder, der die Datei öffnet, kann jeden beliebigen Kommentar bearbeiten.

• Wählen Sie einfach ein Kommentarrechteck im Inspektor aus

• Klicken Sie den Text doppelt, um in den Bearbeitungsmodus zu gelangen

• Bearbeiten Sie den Text

Wenn ein Projekt Ressourcen enthält und einige von ihnen als Benutzer-Ressource
eingestellt sind

• Wählen Sie ein Kommentarrechteck im Inspektor, das Ihre Benutzer-Ressource
anzeigt.

• Klicken Sie auf den Text doppelt, um in den Bearbeitungsmodus zu gelangen.

• Bearbeiten Sie den Text.
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
Sie können weder anonym eingegebene Kommentare noch die von
anderen Benutzer-Ressourcen bearbeiten.

Alternativ

Sie können auch den Menüpunkt Bearbeiten aus dem (…) Menü wählen, wie unten auf dem
Anmerkungen-Inspektor angezeigt wird.

Löschen

Um einen gegebenen Kommentar zu löschen:

• Wählen Sie ein Kommentarrechteck im Inspektor aus.

• Wählen Sie Löschen aus dem Menü (…), wie unten auf dem Anmerkungen
-Inspektor angezeigt wird.

Sortierreihenfolge

Die Kommentare können auf folgende Weise sortiert werden:

• Neueste Kommentare zuerst

• Älteste Kommentare zuerst

Standardreihenfolge ist Neueste Kommentare zuerst.

Um die Sortierreihenfolge zu ändern:

• Öffnen Sie den Anmerkungs-Inspektor

• Wechseln Sie zur Registerkarte Kommentare

• Wählen Sie Neueste Kommentare zuerst oder Älteste Kommentare zuerst aus
dem Menü (…), wie unten auf dem Anmerkungen-Inspektor angezeigt wird.
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Filter

Was sind Filter?

Die Funktion Filter erlaubt es Informationen im Projekt nach unterschiedlichen Vorgaben
sichtbar zu machen. Andere Informationen werden ausgeblendet. Es entsteht eine
Vielzahl von Auswertungsmöglichkeiten durch die Filterung der Inhalte im Projekt.


Filter helfen Ihnen bei großen Projekten bestimmte Informationen
herauszusuchen und grafisch in den verschiedenen Ansichten
darzustellen.

Mit einem Mausklick auf das Trichter-Symbol öffnet sich der Inspektor mit den
eingebauten Filtern.

Setzen Sie ein Häkchen links neben einem Eintrag im Inspektor, damit der Filter aktiviert
wird. Die Inhalte im Projekt werden darauf hin automatisch durch den aktivierten Filter
eingeblendet.


Ein aktiver Filter wird neben dem Trichter mit seiner Bezeichnung
solange eingeblendet und angewandt, bis Sie erneut auf den Trichter
klicken und im Inspektor das Häkchen beim aktiven Filter entfernen.
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Filter anpassen

Klicken Sie auf die Lupe rechts neben einem Eintrag, es öffnet sich ein Dialog in dem Sie
die Bedingungen für den aktiven Filter sehen und anpassen.

In den Klappmenüs stehen Ihnen Informationen und Werte, nach denen Sie die
Bedingungen, fürs Filtern Ihres Projekts, festlegen.

Die Anzeige der gefilterten Ergebnisse steuern Sie mit den drei unten aufgeführten
Optionen:

• Nicht zutreffende Hierarchie anzeigen

• Nur zutreffende Hierarchie einblenden

• Als flache Liste darstellen

Mit einem Mausklick auf das Plus fügen Sie neue Bedingungen für einen Filter dazu. Mit
dem Minus entfernen Sie vorhandene Bedingungen aus dem Filter.

Eigene Filter erstellen

Erstellen und fügen Sie eigene Filter zu den bereits eingebauten Filtern hinzu. Klicken
Sie hierzu auf das Plus in der Filterliste.

Es wird automatisch die Kategorie Eigene erstellt. Damit lassen sich die selbsterstellten
(eigenen) und die mitgelieferten (eingebauten) Filter voneinander unterscheiden.

Bennenen Sie eigene Filter eindeutig, dies hilft bei einer spätere Nutzung.
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Klicken Sie auf die Lupe und erstellen die Bedingungen für den Filter.

Benutzen Sie die dabei die Optionen zum Anpassen des Filters in den Klappmenüs. Mit
einem Mausklick auf das Plus fügen Sie bei Bedarf weitere Bedingungen hinzu oder
entfernen die bereits vorhandenen Bedinungen mit einem Mausklick auf das Minus.

Mit dem Klappmenü Alle lassen sich die Bedingungen auf alle oder aber auch auf Eine
oder Keine der eingestellten Werte filtern.

Die grafische Anzeige des Filters steuert man mit den drei aufgeführten
Darstellungsoptionen für Hierarchie und flache Liste.


Eigene Filter löschen Sie aus der Liste, indem Sie einen Filter anklicken
und die Löschtaste drücken.
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Mehr Filter Optionen

Im Zahnradmenü befinden sich nützliche Optionen für die Nutzung der Filter:

• Filter deaktivieren (schaltet den aktiven Filter aus. Wie das Häkchen beim Filter
entfernen)

• Duplizieren (erstellt eine Kopie von einem vorhandenen Filter)

• Mit anderen lokalen Projekten teilen (der Filter wird in allen Projekten auf dem
lokalen Mac zur Verfügung gestellt)

• Änderungen veröffentlichen (bei geteilten Filtern werden die Änderungen für
alle lokalen Projekte veröffentlicht)

• Änderungen sichern (bei geteilten Filtern werden die Änderungen nur in dem
aktuellen Projekt gesichert und nicht veröffentlicht)

Filter duplizieren

Verwenden Sie diese Option, um einen vorhandenen Filter zu modifizieren. Es wird eine
Kopie erstellt.

Das Duplizieren spart das manuelle Einstellen aller Bedingungen aus dem ursprünglichen
Filter.

Alle Bedingungen sind beim Duplizieren übernommen und lassen sich angepassen oder
erweitern.

Der originale Filter bleibt unverändert.
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Filter lokal teilen

Verwenden Sie diese Option, um einen Filter auf Ihrem Mac immer in allen lokalen
Projekten zur Verfügung zu haben.

Finden Änderungen in einem lokal geteilten Filter statt, erscheint ein weißer Punkt neben
dem Filter.

Verwenden Sie die Optionen aus dem Zahnradmenü zum Übernehmen der Änderungen:

• Änderungen veröffentlichen

• Änderungen sichern

Filter zurücksetzen

Änderungen in einem geteilten Filter, lassen sich zurücksetzen.

Klicken Sie auf den gedrehten Pfeil. Es erscheint ein Dialog in dem Sie die Änderungen
rückgängig machen.

Setzen Sie den Filter zurück:

• durch Verwerfen der Änderungen

• zur mit anderen lokalen Projekten geteilten Version
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Gruppierung

Was sind Gruppierungen?

Die Gruppierungen erlauben es die Inhalte im Projekt nach unterschiedlichen Vorgaben zu
gruppieren. Das ermöglicht eine individuelle Sortierung der Informationen in der jeweiligen
Ansicht.

Merlin Project ist bereits mit einer Vielzahl an vorgefertigten Gruppierungen ausgestattet.
Weitere eigene Gruppierungen lassen sich schnell erstellen.


Die Kanban-Ansicht setzt zwingend eine Gruppierung nach Statusfeld

voraus. Mehr hierzu erfahren Sie in der Anleitung Kanban.

Vorteile bei der Projektplanung

Die Gruppierungen werden grafisch hervorgehoben und mit den jeweiligen Informationen
in der aktuellen Ansicht dargestellt.

Beispielsweise lassen sich so schnell unterschiedliche Fortschritte im Projekt sichtbar
machen. Schnell Vorgänge klassifizieren und Informationen auswerten sowie visualisieren.
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Gruppierungen verwenden

Mit einem Mausklick auf das Gruppierungen-Symbol öffnet sich der Inspektor mit der
Liste der eingebauten Gruppierungen.

Setzen Sie ein Häkchen links neben einem Eintrag zum Aktivieren einer Gruppierung. Die
Inhalte in der aktuellen Ansicht werden automatisch anhand der Gruppierung sortiert und
dargestellt.


Eine aktive Gruppierung wird neben dem Gruppierungen-Symbol am
oberen Rand mit deren Bezeichnung blau eingeblendet und bleibt
solange aktiv, bis Sie das Häkchen in der Liste entfernen.
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Gruppierungen erstellen

Erstellen und fügen Sie eigene Gruppierungen zu den bereits eingebauten Gruppierungen

hinzu. Klicken Sie auf das links angebrachte Plus-Symbol unter der Liste.

Es wird automatisch die Kategorie »Eigene« erstellt. Das dient zur Unterscheidung von
selbsterstellten und den mitgelieferten Gruppierungen. Bennen Sie die selbsterstellte
Gruppierung mit einem eindeutigen Namen für eine bessere Wiedererkennung.


Eigene Gruppierungen löschen Sie aus der Liste, indem Sie eine
Gruppierung anklicken und die Löschtaste auf der Tastatur drücken.
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Gruppierungen anpassen

Klicken Sie auf das Lupen-Symbol und verwenden die zur Auswahl stehenden Optionen
für die Gruppierung.

Die Gruppierung erfolgt mit dem Klappmenü »Gruppiere«. Je nach aktiver Ansicht
befinden sich im Klappmenü die folgenden Auswahlmöglichkeiten für die Gruppierung:

• Vorgänge

• Ressourcen

• Zuweisungen

Legen Sie Optionen fest, nach denen die die Gruppierung erfolgen soll. Verwenden Sie
hierzu die zur Wahl stehenden Klappmenüs.
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Mit einem Mausklick auf das Plus-Symbol fügen Sie bei Bedarf weitere Bedingungsreihen

hinzu oder entfernen bereits vorhandene Optionen mit einem Mausklick auf das Minus-
Symbol.

Die hierarchische Anzeige der Gruppierung lässt sich mit einer der am unteren Rand
angebrachten Darstellungsoptionen zusätzlich verändern:

• Ohne Vorgangshierarchie

• Vorgangshierarchie verflachen

• mit Vorgangshierarchie

Nach Statusfeld gruppieren

Die Schaltfläche Nach Statusfeld gruppieren… wird für die Gruppierung bei Kanban
benötigt. Mit einem Mausklick auf die Schaltfläche öffnet sich der Kanban-Assistenten für
den Kanban-Status.

Mehr Optionen

Mit dem Zahnrad-Symbol stehen weitere Optionen für die Nutzung von Gruppierungen
parat.

Bei einer selektierten Gruppierung in der Liste stehen die folgenden Optionen im Menü des
Zahnrads zur Verfügung:

• Gruppierung aktivieren/deaktivieren (gleich zu setzen mit einem Häkchen
an/aus)

• Duplizieren (Erstellt eine Kopie einer bereits vorhandenen Gruppierung)

• Mit anderen lokalen Projekten teilen (Ermöglicht die Nutzung in anderen
lokalen Projekten)

• Änderungen veröffentlichen (Überträgt die Änderungen in einer geteilten
Gruppierung an alle lokalen Projekte)

• Änderungen sichern… (Bei geteilten Gruppierungen, erstellt eine Kopie)
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Gruppierungen duplizieren

Diese Option kann nützlich sein um eine bereits vorhandene Gruppierung als Vorlage für
eine weitere Gruppierung zu übernehmen. Es wird eine Kopie von der Gruppierung erstellt.

Selektieren Sie eine Gruppierung und klicken Sie auf das Zahnrad-Symbol, anschließend

klicken Sie auf Gruppierung duplizieren

Es wird eine Kopie der Gruppierung erstellt, die mit einer Nummer versehen wird.
Benennen Sie die Gruppierung nach Wunsch.

Anschließend klicken Sie auf das Lupen-Symbol zur Anpassung und Erweiterung der
Optionen für die Gruppierung.

Gruppierungen lokal teilen

Mit der Option Mit anderen lokalen Projekten teilen teilen Sie einzelne Gruppierungen
für alle weiteren Projekte die sich lokal auf Ihrem Mac befinden.

Die geteilten Gruppierungen sind in der Liste unter der Kategorie Geteilt angeordnet.

Änderungen veröffentlichen

Sollen Änderungen in einer geteilten Gruppierung an lokale Projekte veröffentlicht werden,

klicken Sie auf das Zahnrad-Symbol und anschließend auf die Option Änderungen
veröffentlichen

Änderungen sichern

Sollen Änderungen in einer Gruppierung gesichert werden, klicken Sie auf das Zahnrad-
Symbol und anschließend auf die Option Änderungen sichern …
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Änderungen zurücksetzen

Zum Wiederruf von Änderungen in geteilten Gruppierungen ist das Pfeil-Symbol nützlich.

Es dient dem Zurücksetzen von Änderungen, die in geteilten Gruppierungen erfolgt sind.

Klicken Sie auf das Symbol, erscheint ein Dialog, der Auswahlmöglichkeiten für das
Zurücksetzen von Änderungen enthält.

Wählen Sie eine Option fürs Zurücksetzen aus und klicken anschließend auf die
Schaltfläche »Zurücksetzen«.

Gruppierung nicht mehr teilen

Soll eine Gruppierung nicht mehr lokal geteilt werden, klicken Sie auf die gewünschte

Gruppierung und anschließend auf das Zahnrad-Symbol.

In der Liste klicken Sie auf Mit anderen lokalen Projekten teilen. Das Häkchen vor der
Option signalisiert, dass die Gruppierung bereits geteilt wird.
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Manuelles Ranking

Wird in unterschiedlichen Ansichten eine manuelle Sortierung vorgenommen und eine

Gruppierung aktiviert, so entsteht ein manuelles Ranking.

Diese Option wird in der #-Spalte mit einem Stern-Symbol signalisiert.

Klicken Sie auf die Spalte und klicken Sie auf Manuelles Ranking zurücksetzen, um die
Option bei Bedarf zu deaktivieren.
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Stile und Inhalte

Diese Anleitung enthält Informationen zur Nutzung und Anpassung von Stilen und Inhalten
in Merlin Project.

Was sind Stile?

Stile erlauben Ihnen die Darstellung der Bestandteile (Balken, Gruppen, Meilensteine,
Spalten, Zeitskalen uvm.) in den Ansichten zu verändern und den eigenen Wünschen
anzupassen. Dies geschieht mithilfe der Stiloptionen für Bestandteile einer Ansicht,
beispielsweise werden so Farben, Rahmen, Schatten oder Schriften gestaltet.

Was sind Inhalte?

Inhalte erlauben es Ihnen diverse Informationen aus dem Projekt in der Ansicht
unterzubringen, beispielsweise in den Etiketten (links und rechts neben den Balken sowie
auf den Balken selbst) oder in den Karten der Netzplan- oder Kanban-Ansicht.

Stil- und Inhaltsinspektor

Mit dem Stil- und Inhaltsinspektor haben Sie Stile und Inhalte mit wenigen Mausklicks
unter Kontrolle.

Der Stil- und Inhaltsinspektor lässt sich mit einem sekundären Mausklick auf ein
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Bestandteil in der aktiven Ansicht und das dazugehörige Kontextmenü schnell aufrufen.



Je nach sekundär angeklicktem Bestandteil, erscheint im Kontextmenü

entweder nur die Option Stil oder Stil und Inhalt. Die darin enthaltenen

Auswahlpunkte öffne die dazugehörigen Optionen im Stil- und
Inhaltsinspektor.

Zudem existiert ein neuer Weg zum Stil- und Inhaltsinspektor mit einem Mausklick auf

das Pinsel-Symbol.

Im Stil- und Inhaltsinspektor befindet sich eine grafische Darstellung von Bestandteilen.

Je nach aktiver Ansicht, sind schematische Darstellungen für Balken/Gruppen oder
Karten darin zu sehen.
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Inspektor verwenden

Klicken Sie auf ein Bestandteil zum Aufrufen der Optionen für Stil oder Inhalt. Im
Klappmenü darüber, sieht man die getroffene Auswahl und das markierte Element wird
blau markiert.

Stil

Nachfolgend sind der Balken (1), die gesamte Zeile (Zeilentyp für Balken) (2) und der
Referenzbalken (3) aktiviert.

1

2

3

118 Stil- und Inhaltsinspektor



Inhalt

Aktivieren Sie das linke Etikett mit einem Mausklick auf Titel und ändern den Inhalt des
linken Etiketts über die Auswahl im gleichnamigen Klappmenü. Zudem befinden sich hier
die Stiloptionen für die Anpassung von Farbe und Schrift der Inhalte.

Wählen Sie aus dem Klappmenü Inhalt anstatt der voreingestellten Auswahl Titel den

Erwarteten Start, dadurch wird im linken Etikett der erwartete Start des Vorgangs als
Datum eingeblendet.
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Allgemein

Das Register Allgemein steuert die Stile für die Darstellung vieler allgemeiner Elemente in
der aktiven Ansicht.

Ist keine Selektion in der Ansicht aktiv und Sie klicken auf das Pinsel-Symbol, öffnet sich

der Stil-Inspektor mit dem Register Allgemein.

Die Allgemeinen Einstellungen für Stil- und Inhalt dienen für die über das gesamte Projekt
grundsätzlich geltenden Stiloptionen.

Im Klappmenü befinden sich die Bestandteile für die jeweilige Ansicht, die sich mithilfe
der im Inspektor angebotenen Optionen nach eigenen Vorstellungen konfigurieren lassen.

120 Stil- und Inhaltsinspektor



Stil- und Inhaltsinspektor | Merlin Project-Handbuch 121



Nach Regeln

Das Register Nach Regeln erlaubt es die Stil- und Inhaltsoptionen nach bestimmten
Bedingungen automatisch zu steuern.

Beispiel: alle Vorgänge, an denen eine bestimmte Ressource zugewiesen ist, sollen
automatisch mit einer besonderen Farbe oder einer anderen Schrift ausgestattet sein.

Wählen Sie eine Bedingung, um Stile beispielsweise für Gruppe anzuwenden.


Verwenden Sie "Merlin Project", so können Sie eigene Bedingungen
definieren. "Merlin Project Express" verfügt nicht über diese Funktion.
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Für Auswahl

Das Register Für Auswahl steuert die Stile und Inhalte für die getroffene Auswahl. Somit
lassen einzelne Bestandteile individuell anpassen.

Selektieren Sie in einer Ansicht ein Bestandteil und klicken Sie auf das Pinsel-Symbol,
öffnet sich der Stil-Inspektor mit dem Register Auswahl.


Grundsätzlich lassen sich Stile und Inhalte mit einem sekundären

Mausklick und der Option Stil bzw. Stil & Inhalt aus dem Kontextmenü
als Auswahl steuern.

Auswahl im Strukturplan

Klicken Sie beispielsweise mit einem sekundären Mausklick auf einen Balken in der
Netzplanansicht, auf die Spaltenzeile oder in die Gliederung, so können Sie damit die
dazugehörigen Stil- und/oder Inhaltsoptionen aufrufen und bearbeiten.

• (1) Stil- und Inhaltsoptionen für Text in der Gliederung
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• (2) Stiloptionen für Spaltenzeilen

• (3) Stiloptionen für Gliederung

• (4) Stiloptionen für Zeitskalen

• (5) Stil- und Inhaltsoptionen für Balken, Meilensteine und Gruppen

• (6) Stiloptionen für den Gantt
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Beispiele für Stil und Inhalt

Nachfolgend finden Sie eine kleine Auswahl an praktischen Beispielen.

Beispiel 1: Arbeitsfreie Zeit Farbanpassung

Führen Sie einen sekundären Mausklick auf die freie Arbeitszeit (6) im Gantt aus und

klicken Sie im Kontextmenü auf die Option Stil > Arbeitsfreie Zeit.


Alternativ geht das auch mit einem Mausklick auf das Pinsel-Symbol
und anschließend im Register Allgemein mit der Auswahl im Klappmenü
Arbeitsfreie Zeit.

Im Inspektor öffnet sich das Register Allgemein mit der Stiloption für die Arbeitsfreie
Zeit.

Klicken Sie auf das Farbfeld Hintergrundfarbe zum Ändern der Darstellungsfarbe der

Arbeitsfreien Zeit im Gantt.
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Daraufhin erscheint das macOS-Fenster Farben. Darin befinden sich diverse Optionen für
die Festlegung von Farben und Deckkraft.


Erfahren Sie mehr zur Nutzung des vom Betriebssystem zur Verfügung

gestellten Fenters Farben direkt bei Apple online.

Ändern Sie die Farbe für die Hintergrundfarbe. Daraufhin wird direkt die Anzeige der
Arbeitsfreien Zeit im Strukturplan der gewünschten Farbwahl angepasst.
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Beispiel 2: Individuelle Balkenfarbe

Öffnen Sie ein neues oder bereits vorhandenes Projekt in Merlin Project

Zum Ändern der Farbe eines Balkens, Meilensteins oder Gruppe klicken Sie zuerst mit
einem sekundären Mausklick auf einen Balken, Gruppe oder Meilenstein.

Es erscheint das Kontextmenü, selektieren Sie daraus die Option Stil und Inhalt >
Balken.

Im Inspektor wird das Register Für Auswahl geöffnet. Darin stehen Ihnen Optionen für die
Anpassung der Stile für den ausgewählten Balken.
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Klicken Sie auf das Feld Hintergrundfarbe. Im Fenster Farben treffen Sie eine Auswahl
für die gewünschte Farbe. Diese wird sofort für den ausgewählten Balken übernommen.

Fahren Sie nach dem gleichen Schema für die Füllstandsfarbe fort.


Die Füllstandsfarbe wird erst bei einem Fortschritt des Vorgangs im
Balken angezeigt.
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Bearbeiten Sie weitere Optionen im Inspektor nach Bedarf, damit der ausgewählte Balken
individuell in seinem Stil angepasst wird.

Klicken Sie jeweils auf das Kreuz-Symbol falls Sie den Wert einer Option wieder
rückgängig machen möchten. Es wird stattdessen der Wert der übergeordneten Ebene
oder Bedingung für die Option verwendet.
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
Die oben genannten Schritte funktionieren auch bei einer mehrfachen
Selektion. Hierzu sollten Sie mehrere Balken mit der Großschreibtaste
oder mit der cmd-Taste auswählen und den Inspektor verwenden.

Sind bei einer Mehrfachselektion unterschiedliche Werte bei den Balken bereits

eingetragen, erscheint im Feld die Info Mehrere Werte. Klicken Sie auf das Feld und
passen Sie die Farbe an, damit alle ausgewählten Balken die neue Farbe zugewiesen
bekommen. Die alten Werte werden überschrieben.

Klicken Sie ansonsten auf das Kreuz-Symbol um von mehreren Werten zu den
Standardwerten zurückzukehren.
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Stileigenschaften

Stileigenschaften für die Gliederung

Für alle Bestandteile in der Gliederung stehen Ihnen unterschiedliche Optionen zur
Verfügung um Stile anzupassen, diese sind grafisch in der nachfolgenden Abbildung
zusammengefasst.


Führen Sie einen sekundären Mausklick auf einen Titel in der Gliederung
aus. Selektieren Sie aus dem Kontextmenü die Stiloptionen für Zeilen,
Zellen und Trennlinien in der Gliederung.
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Stileigenschaften für die Spalten der Gliederung

Für die Spalten über der Gliederung stehen Ihnen unterschiedliche Optionen zur
Verfügung, um die Spaltenstile anzupassen. Diese sind grafisch in der nachfolgenden
Abbildung zusammengefasst.


Führen Sie einen sekundären Mausklick auf eine Spaltenzeile oberhalb
der Gliederung aus. Selektieren Sie aus dem Kontextmenü die
Stiloptionen für Zeilen, Zellen und Trennlinien in der Gliederung.
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Stileigenschaften für Gantt-Balken

Für die Balken im Gantt-Diagramm stehen Ihnen unterschiedliche Optionen zur Verfügung
um die Balkenstile anzupassen. Diese sind grafisch in der nachfolgenden Abbildung
zusammengefasst.


Führen Sie einen sekundären Mausklick auf einen Balken, Meilenstein
oder Gruppe aus. Selektieren Sie aus dem Kontextmenü die Stiloptionen
für Balken im Gantt-Diagramm.
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Stileigenschaften für Kästen und Histogramme im Gantt

Für die Kästen und Histogramme im Netzplan stehen Ihnen unterschiedliche Optionen zur
Verfügung um die Balkenstile anzupassen. Diese sind grafisch in der nachfolgenden
Abbildung zusammengefasst.



Führen Sie einen sekudären Mausklick auf einen Balken, Meilenstein

oder Gruppe aus. Selektieren Sie im Kontextmenü Stil und Inhalt >
Balken. Im Inspektor wählen Sie aus dem Klappmenü Zeilentyp anstatt

Balken entweder Kästen oder Histogramm aus.
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Suchen

Fürs Auffinden von Inhalten in Projekten ist die eingebaute Suche in Merlin Project
zuständig.

Mit dem Tastaturkurzbefehl cmd + F öffnen Sie das Suchfeld am oberen Rand der
aktiven Ansicht.


Im Menü Bearbeiten → Suchen finden Sie alle Suchoptionen mitsamt
der dazugehörigen Tastaturkurzbefehle.

Tragen Sie einen Begriff in das Suchfeld ein, erscheinen automatisch alle Treffer in der
Ansicht farblich hervorgehoben und sind dadurch leicht zu erkennen.

Links im Suchfeld befindet sich das Lupensymbol. Mit einem Mausklick darauf erscheint
das Menü mit den abgebildeten Optionen.
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Mit der Funktion Muster einfügen öffnet sich ein weiteres Menü. Darin finden Sie eine
Auswahl an vorgefertigten Mustern. Diese Muster erleichtern die Suche.

Wählen Sie beispielsweise die Option Wort aus, automatisch sind damit einzelne Wort-
Zeichen als Treffer markiert.

Tragen Sie vor dem Wort einen Buchstaben an, bspw. ein N, werden alle Worte die auf
N beginnen im Projekt gefunden.

In der rechten Ecke des Suchfeldes befindet sich die Anzeige für die Anzahl der
Suchtreffer und das x zum Löschen der aktuellen Suche.

Rechts neben dem Suchfeld befinden sich Schaltflächen für das Navigieren in den
Suchergebnissen.
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Bei mehr als einem Suchtreffer verwendet man die Pfeile nach links und rechts. So
gelangt man zum nächsten (→) oder vorherigen (←)Suchtreffer.

Ein Klick auf die Schaltfläche Fertig beendet die Suche und blendet das Suchfeld wieder
aus.

Setzen Sie ein Häkchen bei der Option Ersetzen, erscheint ein weiteres Feld. Nun lassen
sich im Projekt Begriffe suchen und ersetzen.

Ersetzen

Die Funktion Ersetzen ist denkbar einfach zu bedienen. Tragen Sie ins obere Suchfeld
das/die Wort(e) zum Ersetzen. Im darunterliegenden Feld tragen Sie das Wort mit dem die
Suche ersetzt wird.

Rechts neben dem Ersetzenfeld befinden sich drei Schaltflächen:

• Ersetzen (ersetzt schrittweise die Suchtbegriffe)

• Alle (ersetzt alle Suchbegriffe auf ein Mal)

• Fertig (beendet das Ersetzen)
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Menü Suchen

Im Menü Bearbeiten → Suchen findet man alle oben beschriebenen und die
nachfolgenden Suchoptionen.

Auswahl suchen

Mit Auswahl suchen lassen sich Suchergebnisse zusätzlich durchsuchen.

Verwenden Sie für die Option den Tastaturkurzbefehl bestehend aus den Tasten cmd +
E.

Auswahl anzeigen

Mit Auswahl anzeigen springt man zu einer zuvor getroffenen Auswahl. Beispielsweise
einem markierten Vorgang oder mehreren markierten Inhalten im Projekt.

Verwenden Sie für die Option den Tastaturkurzbefehl bestehend aus den Tasten cmd +
J.

Aktuelles Datum anzeigen

Mit Aktuelles Datum findet man schnell den heutigen Tag im Projekt.

Verwenden Sie für die Option den Tastaturkurzbefehl bestehend aus den Tasten cmd + D.

Springen zu …

Mit Springe zu … gelangt man schnell zu einzelnen Zeilen im Projekt.

 Diese Funktion ist besonders praktisch bei sehr großen Projekten.

Verwenden Sie für die Option den Tastaturkurzbefehl bestehend aus den Tasten cmd + L.
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In der aktiven Ansicht erscheint das Springe zu-Feld. Tragen Sie die gewünschte
Zeilennummer in das Feld ein.

Mit einem Mausklick auf das Dreieck bestimmen Sie welche Nummerierung Sie
bevorzugen:

• #

• Code

• WBS-Code


Verwenden Sie außer der standardmäßigen Nummerierung # auch einen
eigenen Code oder WBS-Code, sollten Sie die dazugehörigen Spalten
einblenden.
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Projekt-Einstellungen

In Merlin Project steht Ihnen eine Reihe von Einstellungen für das geöffnete Projekt parat.

Klicken Sie auf das Symbol Einstellungen oder verwenden Sie das Menü Ablage →
Projekteinstellungen zum Öffnen des Inspektors.

Allgemein

Im Register Allgemein finden Sie die folgenden Einstellungen für das Projekt:

• Datumsvorgaben

• Arbeit

• Dauer

• Statusdatum

• Ressourcen


Die Sichtbarkeit des Projekts bezieht sich auf die Nutzung mit
mehreren Benutzern und Merlin Server.

Zudem finden Sie hier Einstellungen für das im Projekt verwendete Währungssymbol und

die Sichtbarkeit des Projekts.
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Datumsvorgaben

Die Datumsvorgaben betreffen das Projekt und sind somit wichtig.

Richtung

Die Richtung legt fest ob das Projekt Vorwärts oder Rückwärts geplant ist.

Die Option Vorwärts ist standardmäßig aktiv, und lässt ein Projekt vom Startdatum
beginnen.

Die Option Rückwärts, lässt das Projekt von einem Enddatum ausgehend verlaufen.

Start

Der Start ist das Stardatum für das Projekt und wird vorausgesetzt.


Bei einem neuen Projekt wird automatisch ein Start mit dem morgigen
Datum festgelegt.

Erster Wochentag

Die Option Erster Wochentag legt den Tag an dem die Woche beginnt fest. Je nach Land
ist dies unterschiedlich. Standardmäßig beginnt eine Woche in Europa am Montag.
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Arbeit

Hier stehen Einstellungen für die Arbeit im Projekt zur Verfügung.

Folgende Werte lassen sich festlegen:

• Stunden je Arbeitstag

• Stunden je Arbeitswoche

• Tage je Arbeitsmonat

Standardwert

Der Standardwert wird bei neu angelegten Vorgängen verwendet. Jeder neue Vorgang
erhält automatisch den Standardwert für die Arbeit.

Das ? ist nur ein Hinweis, dass der Standardwert geschätzt ist. Löschen Sie das ? falls
nicht gewünscht.

Dauer

Hier stehen Einstellungen für die Dauer im Projekt zur Verfügung.

Wie bei der Arbeit, lässt sich optional auch ein Standardwert für die Dauer einstellen.
Somit werden neue Vorgänge automatisch mit dem Standardwert für die Dauer
versehen.

Berechnungseinheit

Die Berechnungseinheit bestimmt die Einheit für berechnete Felder.

Sie ist standardmäßig auf Dynamisch gestellt. Das heißt, die Einheiten werden dynamisch
und entsprechend den Arbeit-Projekteinstellungen berechnet. Aus 8 Arbeitsstunden wird
1 Arbeitstag, aus 40 Arbeitsstunden wird 1 Arbeitswoche, aus 20 Arbeitstage wird 1
Arbeitsmonat.

Im Klappmenü stehen Einheiten zur Auswahl. Legt man eine Einheit fest, wird diese für
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Berechnungen im gesamten Projekt verwendet.

Statusdatum

Gegen diesem Datum wird die aktuelle Fortschritt im Projekt verglichen. Das Statusdatum
aktualisiert sich standardmäßig automatisch und zeigt das Datum und Uhrzeit des macOS.

Wird ein Statusdatum festgelegt, kann die Fortschritt Projekts relativ zu diesem
bestimmte Datum betrachtet werden. Dies kann praktisch sein, wenn Sie rückwirkend zum
Beispiel am Monatsende einen Status-Bericht erstellen müssen.

Haben Sie das Statusdatum festgelegt, und möchten dass es sich wieder standardmäßig
automatisch aktualisiert, klicken Sie auf das Symbol neben dem Datum und dann auf die
Schaltfläche Auto.

Dynamische Planung

Standardmäßig ist die dynamische Planung ausgestellt.

Die aktivierte dynamische Planung verschiebt die Inhalte des Projekts bezogen auf das
Statusdatum.

Es stehen zwei Variangten für die dynamische Planung im Klappmenü zur Auswahl:

• Erwartete & geplante Werte

• Nur erwartete Werte

Wählt man die erste Option aus, wird die dynamische Planung sowohl auf die erwarteten
als auch die geplanten Werte im Projekt angewand.


Aktiviert man die Spalten Erwarteter Start und Geplanter Start, lassen
sich die Folgen der dynamischen Planung besser erkennen.
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Wird die dynamische Planung aktiviert, erscheinen weitere Einstellungen.

Die Granularität bestimmt wie fein die dynamische Planung bezogen auf das Statusdatum
sein soll. Im Klappmenü stehen die Zeiteinheiten zur Auswahl.

Wird beispielsweise Woche als Granularität gewählt, erscheint ein anderes Datum, das
bezogen auf das Statusdatum und die Granularität errechnet wird. Es dient als Grundlage
für das dynamische Planen.

Wirklicher Start/Ende

Die Option wirklicher Start/Ende wird standardmäßig automatisch berechnet.

Es stehen zwei weitere Optionen im Klappmenü parat:

• Aus erwarteten Werten bei Änderung der Erledigung

• Aus Statusdatum beim Ändern der Erledigung

Diese Optionen greifen beim Ändern der Erledigung von Vorgängen und haben Einfluß auf
den wirklichen Start/Ende der Vorgänge.

Bei der Option Aus Statusdatum beim Ändern der Erledigung wird zusätzlich die
Einstellung für die Granularität eingeblendet.
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Damit das Statusdatum deaktiviert wird, klicken Sie erneut auf das Kalendersymbol und die
Schaltfläche Heute. Soll sich das Statusdatum automatisch verschieben, klicken Sie auf
Auto.

Ressourcen

An dieser Stelle bestimmt man den Stil der Initialen für Ressourcen im Projekt. Die
Initialen tauchen in den Stiloptionen auf. Hier muss das Format dann auf Initialen
gestellt sein.

Teilen sich die Arbeit

Die Option teilen sich die Arbeit ist für mehrere Zuweisungen gleichzeitig
ausschlaggebend. Werden beispielsweise zwei Ressourcen auf einen Vorgang bewegt,
teilen sich beide die Arbeit zur Hälfte.

Entfernen Sie das Häkchen, damit die Arbeitsteilung für zugewiesene Ressourcen nicht
mehr automatisch erfolgt.

Kalender

Im Bereich Kalender können Sie die verschiedenen Kalender in Ihrem Projekt verwalten.
Hier können Sie Kalender bearbeiten, neu anlegen, umbenennen, löschen und festlegen,
welcher Kalender der Standardkalender sein soll.
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Neue Merlin Project Dokumente werden mit folgenden vordefinierten Kalendern
ausgeliefert:

• Standard - 5 Tage bei 8 Stunden verteilt auf 8-12 Uhr und 13-17 Uhr.

• Nachtarbeit - 5 Tage bei 8 Stunden, verteilt auf die Nachtstunden 23.00-3.00
Uhr und 4.00-8.00 Uhr.

• 24 Stunden - 7 Tage bei 24 Stunden



Der Projektkalender mit dem aktivierten Häkchen ist der Kalender, den
Merlin Project bei der Planung von neuen Aktivitäten verwendet.
Ressourcenkalender, die für neue Ressourcen gelten, basieren
automatisch auf dem Projektkalender.

Neue Kalender lassen sich mit einem Klick auf + erstellen.

Zum Entfernen von vorhandenen Kalendern, wählen Sie den Kalender aus, und klicken Sie
auf das -.

Reguläre Woche

Im Bereich Reguläre Woche können Sie die regelmäßigen Arbeitsintervalle pro
Wochentag verwalten. Wählen Sie einfach den Kalender aus, den Sie verwalten möchten,
wählen Sie die verschiedenen Wochentage aus und bearbeiten Sie seine regelmäßigen
Arbeitsintervalle wie gewünscht.
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Ausnahmen

Mit einem Mausklick auf Ausnahmen (1) bestimmt man einzelne Tage oder auch
Zeitabschnitte als Ausnahmen für Freizeit und extra Arbeitszeit im aktiven Kalender.

Neue Ausnahmen werden mit einem Mausklick auf Plus (2) erstellt. Jede Ausnahme lässt
sich mit folgenden Informationen anpassen:

• Titel

• Starttag

• Enddtag

Standardmäßig sind neue Ausnahmen, als arbeitsfreie Zeiten definiert.

Erst beim Hinzufügen von Zeiten in der Leiste Arbeitsintervalle (3), sind diese Zeiten als
zusätzliche Arbeitszeiten (außerhalb der regulären Arbeitszeit) aktiv.
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
Ausnahmen mit Arbeitsintervalle werden in der Liste mit einem

Uhrensymbol angezeigt.

Import / Export von Kalender

Wählen Sie die Option Exportieren, um einen konfigurierten Kalender aus einem Projekt
zu exportieren, um ihn in ein anderes Merlin Project-Dokument zu importieren. Die
exportierte Datei enthält den Namen des Kalenders, die Reguläre Woche und die
Ausnahmen

Verwenden Sie die Option Importieren, um einen zuvor exportierten Merlin Project-
kalender zu importieren oder aus einer ics-Kalenderdatei Ausnahmen in Ihr bestehendes
Projekt einzufügen.


Beim Importieren einer ics-Kalenderdatei werden Ganztags-Termine als
Ausnahmen in das Projekt importiert.
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Arbeitszeiten für Ressourcen

Sie können die Reguläre Woche und Ausnahmen der Arbeitszeiten für Ihre Ressourcen
genauso konfigurieren wie Ihre Kalender.

Hierzu selektieren Sie eine Ressource in einer Ressourcen oder Zuweisungen Ansicht und
klicken im Inspektor auf das Register Kalender.

Die Ressourcenkalender basieren standardmäßig auf dem Projektkalender.

Verwenden Sie das Dropdown-Menü Basiskalender, um bei Bedarf einen anderen
Projektkalender für die aktive Ressource auszuwählen.

Wenn Sie Änderungen am Ressourcenkalender vornehmen, haben diese Einstellungen

Vorrang vor dem ausgewählten Basiskalender.

Sie können auf Basiswerte zurücksetzen und Änderungen im Ressourcenkalender für
die einzelnen Tage entfernen.

Zusätzliche Optionen

Das Register Kalender des Inspektors bietet folgende zusätzliche Optionen:
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• Auf Basiswerte zurücksetzen - Stellt Änderungen für einzelne Tage zurück

• Alle Tage auf Basiswerte zurücksetzen - Stellt alle Änderungen für alle Tage
zurück

• Ressourcenkalender importieren… - importiert Merlin Project-Kalender oder
ics-Kalenderdateien als Ausnahmen

• Ressourcenkalender exportieren… - exportiert Merlin Project-Kalender

Codes

Strukturplan-Elemente (in Englisch WBS: Work Breakdown Structure) werden
typischerweise innerhalb der hierarchischen Struktur fortlaufend nummeriert, damit eine
konsistente Identifizierung gewährleistet ist. So kennzeichnet z. B. 1.1.2 ein Element als
WBS-Element der Stufe 3, da es drei Zahlen enthält, die durch zwei Dezimalpunkte
getrennt sind.

Mit den Einstellungen für Codes können Sie das Format von WBS Codes und Outline-
Codes steuern.

Standardmäßig werden für Codes und WBS Codes nur Zahlen verwendet, die durch
Punkte getrennt sind.

Wenn Sie ein eigenes Kodierschema definieren möchten, klicken Sie auf das Symbol + und
konfigurieren Sie Ihr Schema entsprechend.
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• Präfix - Hier können Sie ein pauschales Vorzeichen eingeben, das für alle
Strukturplan-Elemente gleich gilt.

• # - Zeigt die Gliederungsebene an, für die eine bestimmte Reihenfolge definiert
ist.

• Reihenfolge - Wählen Sie aus, wie diese Ebene kodiert werden soll. Verfügbare
Optionen: Ziffern (Standard), Kleinbuchstaben, Großbuchstaben, Kleine
Römische Zeichen, Große Römische Zeichen, Ausgeschrieben

• Min. Länge - Verfügbare Optionen: unbegrenzt (Standard), min: 1, max: 10

• Trenner - Verfügbare Optionen: ., -, /,

• Beispiel - Hier sehen Sie ein Code-Beispiel für das benutzerdefinierte
Kodierschema.


Aktivieren Sie die Spalte Code in der Gliederung, als Beschriftung auf
dem Gantt oder in Netplan-Karten. Code-Werte werden berechnet und
können vom Anwender nicht bearbeitet werden.

Sollten Sie ein eigenes Kodierschema für den WBS-Code definieren wollen, wechseln Sie
auf die entsprechende Registerkarte, klicken Sie auf das Symbol + und konfigurieren Sie
Ihr Schema entsprechend.

• Präfix - Hier können Sie ein pauschales Vorzeichen eingeben, das für alle
Strukturplan-Elemente gleich gilt.

• # - Zeigt die Gliederungsebene an, für die eine bestimmte Reihenfolge definiert
ist.

Um den Projektmanagement-Standards zu entsprechen, bieten Ihnen die
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Projekteinstellungen des WBS-Codes folgende Reihenfolge-Optionen:

• Reihenfolge - Ziffern (Standard), Kleinbuchstaben, Großbuchstaben, Zeichen

• Min. Länge - Verfügbare Optionen: unbegrenzt (Standard), min: 1, max: 10

• Trenner - Verfügbare Optionen: ., -, /,

• Beispiel - Hier sehen Sie ein WBS-Code-Beispiel für das benutzerdefinierte
Kodierschema.

Zusätzliche Optionen:

• Code für neue Vorgänge erstellen - Deaktivieren Sie diese Option, falls Sie den
WBS-Code leer lassen möchten, wenn neue Aktivitäten eingefügt werden.

• Eindeutigkeit neuer Codes überprüfen - Deaktivieren Sie diese Option, wenn
Sie beim nachträglichen Bearbeiten von WBS-Codes die Prüfung auf eventuelle
Duplikaten nicht wünschen.


Aktivieren Sie die Spalte WBS-Code in der Gliederung, als Beschriftung
auf dem Gantt oder in Netplan-Karten. WBS-Code-Werte werden
berechnet, können jedoch bei Bedarf vom Anwender bearbeitet werden.

Wertelisten

Hier können Sie Einträge von Wertelisten bearbeiten, die in Anhänge oder für Kosten
verwendet werden.

Es können Wertelisten für folgende Inhalte bearbeitet werden:

• Kosten (Art, Status)
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• Datei (Status)

• Ereignis (Status)

• Information (Art)

• Problem (Kategorie, Art, Status)

• Ressource (Rolle)

• Risiko (Risikogruppe)

So tragen Sie neue Werte in eine Liste ein:

• Wählen Sie im Popup-Menü Für die gewünschte Liste aus.

• Klicken Sie in den Bereich der Liste zu der Sie einen neuen Eintrag einfügen
möchten

• Klicken Sie auf das +.

• Bearbeiten Sie den neuen Eintrag wie gewünscht.


Sie können den neuen Eintrag nach oben oder unten ziehen, um seine
Reihenfolge zu ändern.

Ändern Sie den Namen von vorhandenen Einträgen mittels eines Doppelklicks auf den
Titel des Eintrags.

Mit einem Klick auf -, löschen Sie Werte aus der Liste.

Bei einigen Wertelisten können Sie ein Ssymbol einstellen. Wählen Sie einfach die
gewünschten Symbole nach Bedarf aus.

Auslastung

Im Register Auslastung befinden sich diverse Optionen für die Auslastungsberechnung,
den Auslastungsabgleich sowie für die Ressourcenpools.
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Auslastungsberechnung

Für die Auslastungsberechnung stehen drei Optionen zur Verfügung.

Stellen Sie hier die %-Werte für die Schwellenwerte der Überlastung und der
Unterlastung ein. Diese Werte haben direkten Einfluss bei der Auslastungsberechnung im
Projekt.

Mit der Option Pool-Zuweisungen beachten, lassen sich auch zugewiesene Ressourcen
aus Ressourcenpools für die Auslastungberechnung anhand der Schwellenwerte
einbeziehen.

Auslastungsabgleich

Für den Auslastungsabgleich im Projekt steht Ihnen eine Vielzahl an Optionen parat um
den Auslastungsabgleich durchzuführen.

• Für (gesamtes Projekt oder einen Bereich)
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• Überlastungsintervall (Einheit)

• Vorherigen Verzug löschen (standardmäßig an)

• Nur innerhalb Puffer (standardmäßig aus)

• Reihenfolge (Standard, Priorität oder # manuelle Reihenfolge)

• Jetzt abgleichen

Klicken Sie auf das Zahnradsymbol Jetzt abgleichen und wählen Sie eine der
Abgleichungsoptionen aus:

• Alles abgleichen

• Alles zurücksetzen (stellt den ursprünglichen Zustand her)

• Auswahl abgleichen

• Auswahl zurücksetzen (stellt den ursprünglichen Zustand her)

Ressourcenpools

In der Liste für Ressourcenpools lassen sich Projektdateien als Pools hinzufügen.

Mit der Option Zuweisungen veröffentlichen lassen sich die Zuweisungen aus den
Ressourcenpools sichtbar machen.


Mehr zum Thema Ressourcenpools findet man in der gleichnamigen
Anleitung.
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Einstellungen

Zum Öffnen des Fensters mit den »Einstellungen« für Merlin Project wählen Sie den Menü
Merlin Project → Einstellungen …

Es beinhaltet folgende Optionen:

• Einstellungen - Allgemein

• Einstellungen - Vorlagen

• Einstellungen - Bibliothek

• Einstellungen - Accounts

• Einstellungen - Zugriff auf Ordner

Einstellungen - Allgemein

In Einstellungen > Allgemein befinden sich allgemeine Optionen für die Nutzung von Merlin
Project.

Programmsprache

Diese Option ist nur dann verfügbar, wenn Merlin Project nicht über den Mac App Store
gekauft wurde.

Die Option Programmsprache ermöglicht Ihnen die Sprache für das Program zu wählen.
Standardmäßig wird die Systemsprache verwendet. Möchten Sie Ihr Merlin Project-
Programm in einer anderen Sprache als die des macOS verwenden, wählen Sie diese aus
dem Ausklappmenü aus.
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
Im Beispiel läuft das macOS auf Deutsch, Merlin Project soll aber in
englischer Sprache ausgeführt werden.

Nach externen Änderungen an Dateien

Die Option Nach externen Änderungen an Dateien enthält drei Möglichkeiten für die
Änderungen in Anhängen des Typs Datei:

• Aktion nachfragen

• Ignorieren

• In alte Version integrieren
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Aktion nachfragen ist standardmäßig eingestellt und fragt bei Änderungen, ob die Datei als
neues Duplikat mit den veränderten Inhalten gesichert wird oder die neuen Inhalte in die
alte Version der Datei übernommen werden.

Ignorieren übergeht die Änderungen und belässt die Datei im ursprünglichen Zustand.

In alte Version integrieren werden die Änderungen in die alte Version integriert.

Softwareaktualisierung

Diese Option ist nur dann verfügbar, wenn Merlin Project nicht über den Mac App Store
gekauft wurde.

Es existieren drei Einstellungen für die Option Softwareaktualisierung:

• Automatisch herunterladen und installieren

• Lediglich über Aktualisierungen benachrichtigen

• Nicht nach Aktualisierungen suchen

Die Option Automatisch herunterladen und installieren sucht nach Aktualisierungen. Bei
einer neuen Programmversion wird diese automatisch heruntergeladen und installiert.

Die Option Nur über Aktualisierungen benachrichtigen weist auf eine neuere
Programmversion hin. Das Herunterladen und Installieren erfolgt manuell.

Die Option Nicht nach Aktualisierungen suchen schaltet die Suche nach Aktualisierungen
aus.
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
Es sollte grundsätzlich immer die neueste Version von Merlin Project
verwendet werden. Die Nutzung von veralteten Programmversionen
kann zu Problemen und unvorhersehbaren Ergebnissen führen.

Ansichten-Erscheinungsbild

Die Option Ansichten-Erscheinungsbild enthält zwei Einstellungen:

• Automatisch anpassen

• Immer hell

Wählen Sie Automatisch anpassen, damit die Ansichten in den dunklen oder hellen Modus
wechseln, wie es in macOS Mojave oder neuer möglich ist.

Wählen Sie Immer hell, um Ihre Ansichten im hellen Erscheinungsbild zu behalten, auch
wenn sich Ihr macOS gerade im dunklen Modus befindet.


Auch wenn Sie die App im dunklen Modus verwenden, erfolgt der Druck
immer im hellen Modus, während der Bildexport im aktuell ausgewählten
Modus erfolgt.

Inspektor-Erscheinungsbild

Die Option Inspektor-Erscheinungsbild enthält zwei Einstellungen:

• Automatisch anpassen

• Immer dunkel
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Wählen Sie Automatisch anpassen, damit der Inspektor in den dunklen oder hellen Modus
wechselt, wie es in macOS Mojave oder neuer möglich ist.

Wählen Sie Immer dunkel, um den Inspektor im dunklen Erscheinungsbild zu behalten,
auch wenn sich Ihr macOS gerade im hellen Modus befindet.

Inspektor-Position

Die Option Inspektor Position enthält zwei Einstellungen:

• Integriert

• Eigenes Fenster
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Standardmäßig ist der Inspektor im Hauptfenster integriert und ein fester Bestandteil.
Durch die Option Eigenes Fenster lässt sich der Inspektor aus dem Hauptfenster lösen und
als eigenes Fenster verwenden.



Das Verwenden des Inspektors im eigenen Fenster ist beispielsweise bei
der Nutzung von mehreren Monitoren vorstellbar. Das Hauptfenster
kann auf dem Hauptmonitor und der Inspektor auf dem Nebenmonitor
platziert werden. Dadurch hat man den Vorteil, dass im Hauptfenster
mehr Platz für die Inhalte geschaffen wird.

Beim Drücken des Zeilenschalters

Die Option Beim Drücken des Zeilenschalters enthält zwei Einstellungen:

• Bearbeiten beenden

• Nächste Zeile bearbeiten

Standardmäßig ist die Einstellungen Bearbeiten beenden gesetzt. Sollten Sie häufiger das
Keyboard statt der Maus bzw. des Trackpads nutzen, so können Sie die Nächste Zeile
bearbeiten Einstellung verwenden.

Diagnose

Standardmäßig ist die Einstellung Diagnose- und Nutzungsdaten an ProjectWizards
senden deaktiviert. Schalten Sie diese Diagnoseoption ein, wenn Sie dem zustimmen
möchten.

Merlin Server-Funktionen zeigen

Standardmäßig ist diese Option ausgeschaltet. Wenn aktiviert, zeigt Merlin Project die
Merlin Server Funktionen im Ablage-Menü.

Einstellungen - Vorlagen

In Einstellungen > Vorlagen befinden sich allgemeine Optionen für die Nutzung von
Vorlagen in Merlin Project.

Das Register »Vorlagen« erlaubt es Ihnen, die Sprache der angebotenen eingebauten
Vorlagen auszuwählen und Ihre eigenen Projektdateien als Vorlagen zu verwalten.
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Sprachen für Standardvorlagen

Merlin Project enthält Projektvorlagen in folgenden Lokalisierungen:

• Chinesisch

• Deutsch

• Englisch

• Französisch

• Japanisch

• Spanisch
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Die mitgelieferten Vorlagen finden Sie beim Aufruf von Ablage > Neu > Neues Dokument.

Standardmäßig zeigt Merlin Project seine eingebauten Projektvorlagen in der
Programmsprache an.

Wenn Sie Vorlagen aus einer anderen Sprache verwenden oder Vorlagen aus mehreren
Sprachen aktivieren möchten, wählen Sie die gewünschte(n) Sprache(n) aus. Sie können
mehrere Markierungen vornehmen.

Wenn Sie die eingebauten Vorlagen vollständig entfernen möchten, deaktivieren Sie die
Programmsprache.

Ordner mit Vorlagen

In Merlin Project können Sie eigene Ordner mit Projektdateien als Vorlagen einrichten und
verwenden.
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Mit einem Mausklick auf »+« wählen Sie einen Ordner mit Projekten aus.

Der Ordner wird in der Seitenleiste des Dialogs angeboten, wenn Sie Datei > Neu aufrufen.
Wählen Sie das Element in der Seitenleiste, um die enthaltenen Projektdateien anzuzeigen
und neue Projekte mit deren Inhalt zu starten.

Einstellungen - Bibliothek

Die Optionen für die Verwendung der Merlin Project Bibliothek finden Sie unter
Einstellungen - Bibliothek.

Das Register »Bibliothek« ist in zwei weitere Registerkarten unterteilt:

• Ordner

• Addressbücher

Und bietet dazu folgende zwei Schalter an:

• Neu laden

• Bibliothek einblenden

Ordner

Die "Ordner" Registerkarte ermöglicht die Auswahl der Sprache der angebotenen
eingebauten Bibliothekselemente und die Verwaltung eigener Inhalte:
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Sprachen für Standardinhalte

Standardmäßig zeigt Merlin Project seine eingebauten Bibliothekselemente in der
Programmsprache an.

Wenn Sie Bibliotheksinhalte in einer anderen Sprache verwenden oder mehr Sprachen
aktivieren möchten, wählen Sie die gewünschte(n) Sprache(n) aus. Sie können mehrere
Markierungen vornehmen.


Diese Einstellung ist mit der Option Sprachen für Standardvorlagen aus
Einstellungen - Vorlagen verbunden.

Beschreibbarer Ordner
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Mit der Option Beschreibbarer Ordner können Sie den Standardordner ändern, in dem
Inhalte gespeichert werden, wenn Sie Elemente in der Merlin Project Bibliothek ziehen.

Klicken Sie auf das Pfeilsymbol, um den ausgewählten Bibliothek-Ordner im Finder-
Fenster zu öffnen.



Standardmäßig befindet sich der Ordner im Benutzerordner. Sie können
darauf unter folgendem Pfad auf dem lokalen Volume Ihres Macs
zugreifen: HD > Users > User name > Library > Containers >
net.projectwizards.merlinproject > Data > Library > Application Support
> net.projectwizards.merlinproject > Library

Um den Standardordner zu ändern, klicken Sie auf Standard und wählen Sie einen
gewünschten Ordner aus.

Nur lesbare Ordner

Sie können weitere Ordner mit Inhalten für die Bibliothek in der Liste Nur lesbare Ordner
konfigurieren.

Klicken Sie auf »+«, um neue Ordner hinzuzufügen, oder auf »-«, um sie zu entfernen.
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Die Bibliothek listet alle Inhalte und Unterordner aus den eingefügten schreibgeschützten
Ordnern auf.

Addressbücher

Die »Addressbücher« Registerkarte ermöglicht die Auswahl und Konfiguration der
Adressbücher, die die Bibliothek für die Auflistung von Kontakten verwenden soll.

macOS-Kontakte anzeigen

Mit der Option macOS-Kontakte anzeigen können Sie in der Bibliothek Kontakte aus der
Apple "Kontakte.app" ein- oder ausblenden.


Damit Merlin Project Ihre Kontakte aus der Apple "Kontakte.app"
anzeigen kann, müssen Sie den Merlin Project den Zugriff auf Ihre
Kontaktinformationen, wie hier beschrieben wird, gestatten.

Microsoft Outlook-Kontakte anzeigen
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Die Option Microsoft Outlook-Kontakte anzeigen ermöglicht es Ihnen, in der Bibliothek
Kontakte aus der "Outlook.app", die Teil der Microsoft Office Suite ist, ein- oder
auszublenden.



Damit Merlin Project Ihre Kontakte aus der "Outlook.app" in der
Bibliothek anzeigen kann, müssen Sie bestätigen, dass die App
Outlook.app zugreifen und Aktionen ausführen darf. Bestätigen Sie dies
bei Aufforderung oder aktivieren Sie in Sicherheit > Datenschutz >
Automation das Kontrollkästchen für "Microsoft Outlook", welches unter
"Merlin Project" aufgeführt wird.

LDAP Verzeichnisdienste

In der Liste LDAP Verzeichnisdienste können Sie LDAP-Server eintragen. Dadurch können
Sie Kontakte aus einem LDAP Verzeichnisdienste über die Bibliothek verwenden.

Klicken Sie auf »+«, um Informationen einzugeben, mit denen Sie eine Verbindung
herstellen und einen LDAP-Verzeichnisdienst verwenden können.

Klicken Sie auf »-«, um einen Eintrag zu entfernen. Um Einträge zu bearbeiten, klicken Sie
auf "Bearbeiten".
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
Ein verknüpfter LDAP-Server zeigt nicht die vollständige Liste seiner
Kontakte in der Merlin Project Bibliothek an. Um Kontakte von diesem
Server zu verwenden, müssen Sie zuerst eine Suche starten.

Bibliothek einblenden

Klicken Sie auf Bibliothek einblenden, um die Bibliothek zu öffnen.

Neu laden

Wenn Sie derzeit die Bibliothek geöffnet und Änderungen im Einstellungsbereich
vorgenommen haben, klicken Sie auf Neu laden, um alle aufgeführten Inhalte zu
aktualisieren.

Einstellungen - Accounts

In Einstellungen > Accounts befinden sich Optionen für die Nutzung von Accounts in
Merlin Project.

Sie können Accounts für folgende Protokolle einfügen und verwalten:

• Merlin Server

• FTP

• SMTP

• WebDAV
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Klicken Sie auf »+«, und dann das Serverprotokoll, um einen neuen Account zu
konfigurieren.

Geben Sie auf der rechten Seite die Verbindungsdaten des jeweiligen Servers ein.


Hier wurde ein FTP Server als Account für die Verwendung mit Merlin
Project und die Export-Option der Funktion »Veröffentlichen«
eingetragen.

Einstellungen - Zugriff auf Ordner

Die Optionen "Zugriff auf Ordner" finden Sie unter Einstellungen > Zugriff auf Ordner.
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Dies ermöglicht Merlin Project, Dokumente aus Ordnern von Box Sync zu synchronieren
und automatisch Konflikte zu lösen, wenn diese von mehreren Nutzern bearbeitet werden.

Ordner mit Zugriff für Merlin Project

Sie können Ordner manuell einfügen oder bei Bedarf entfernen.

Klicken Sie auf »+« oder ziehen Sie Ordner in diesen Bereich, um den Zugriff für Merlin
Project einzurichten.

Klicken Sie auf »-«, um einen Eintrag zu entfernen.

Erlaubnis beim Öffnen von Dokumenten erfragen

Die Option "Erlaubnis beim Öffnen von Dokumenten erfragen" zeigt beim Öffnen von
Dokumenten aus Box Sync einen Dialog an, in dem Sie aufgefordert werden, den Ordner
des Dokuments in die Liste der Ordner mit Zugriff einzufügen. Sie können die
automatische Aufnahme bestätigen oder den Ordner später manuell einfügen.

Standardmäßig ist die Option Erlaubnis beim Öffnen von Dokumenten erfragen aktiviert.
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Sichern

Ablage > Sichern…

Beim erstmaligen Sichern eines Dokuments benennen Sie es und wählen einen Speicherort
aus – z. B. auf Ihrem Schreibtisch oder in einem Ordner.

Anschließend sichert Merlin Project Ihr Dokument automatisch, während Sie daran
arbeiten.

• Klicken Sie auf eine beliebige Stelle des Dokumentfensters, um es zu aktivieren.

• Wählen Sie „Ablage“ > „Sichern“

• Geben Sie im Feld „Sichern unter“ einen Namen ein.

• Wählen Sie ein Speicherort für das Dokument aus.

• Klicken Sie auf „Sichern“.

Ablage > Duplizieren…

Sie können ein offenes Dokument duplizieren. Das Duplikat wird im gleichen Speicherort
wie das Original gesichert.

In Merlin Project stehen Ihnen noch folgende zwei Optionen zur Verfügung:

• Dokument-Historie erhalten

• Neue Dokument-Identität erzeugen

Dokument-Historie erhalten

Wählen Sie diese Option, um ein Duplikat mit der gleichen Dokument-Historie zu erstellen
und alle bisherigen Aktionen seit Dokument-Erstellung rückgängig machen zu können.
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Neue Dokument-Identität erzeugen

Wählen Sie diese Option, um die Dokument-Historie zu entfernen und ein Duplikat mit
neuer Dokument-Identität zu erzeugen. Dies erlaubt Ihnen zum Beispiel das Original und
das Duplikat in einem Projekt zusammen zu fassen.

Ablage > Duplizieren… | Merlin Project-Handbuch 175



Drucken

In Merlin Project steht Ihnen über das Menü Ablage → Drucken das Druckfenster zur

Verfügung. Es handelt sich um den in macOS integrierten und vereinheitlichten
Druckdialog. Die Einstellungen für das Papierformat sind darin zu finden.

Projektinhalte ausdrucken

Das Druckfenster ist in macOS in zwei Ansichten vorhanden: Die Ansicht mit weniger und
mehr Details.

Die einfache Ansicht bietet nur wenige Anpassungsmöglichkeiten. Klicken Sie auf den
Schalter Details einblenden. Damit wird die erweiterte Druckansicht geöffnet. Darin
finden Sie die im Anschluss beschriebenen Optionen.
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
Das Papierformat und die Ausrichtung sind durch die Auswahl des
verwendeten Druckers festgelegt.
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Inhalte

Das Klappmenü Inhalte bietet Optionen zur Einstellung der zu druckenden Inhalte.

Bestimmen Sie beispielsweise den Druckbereich:

• Wie in Projektansicht

• Gliederung und Gantt

• Nur Gliederung

• Nur Gantt

Die weiteren Optionen steuern die grafische Ausgabe des Projekts im Ausdruck:

• Hintergrund drucken

• Verläufe drucken

• Schatten drucken

• Spaltenkopf auf jeder Seite wiederholen (für einen Ausdruck über mehrere
Seiten nützlich)

• Umbruch an Spaltengrenzen (für einen Ausdruck über mehrere Seiten
nützlich)

• Umbruch an Zeilengrenzen (für einen Ausdruck über mehrere Seiten nützlich)
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Skalierung

Mit der Skalierung bestimmen Sie die Seitenaufteilung des Projekts auf das eingestellte
Papierformat. Falls Sie auf einem DIN A4-Papierblatt ein großes Projekt ausgeben
möchten, wird es womöglich sehr klein dargestellt.

Die Anzahl von Seiten, bezogen auf die Breite oder die Höhe des gewählten
Papierformats, bestimmt die größe der Ausgabe.


Stellen Sie beispielsweise eine Seite als Breite ein, wird das Projekt
automatisch auf eine Seitenbreite skaliert. Siehe nachfolgenden
Abschnitt.
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Ausdruck des Projekts auf einem Blatt Papier

Klicken Sie auf die Ausrichtung des Papiers. Damit bestimmen Sie, ob das Blatt im Hoch-
oder Querformat mit den Projektinhalten bedruckt wird.

Anschließend Selektieren Sie aus dem Klappmenü Skalierung. Wählen Sie bei einem
zuvor ausgewählten Querformat eine Seite für Breite aus.

Dadurch wird das gesamte Projekt automatisch auf das Blatt Papier in der gesamten
Breite angepasst.


Diese Einstellung hat einen Stern als Markierung. Von dieser Einstellung
werden alle weiteren Werte abgeleitet.
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Kopf- und Fußzeilen

Die Optionen für die Kopf- und Fußzeilen bieten eine Vielzahl an Einstellungen.
Vorgefertigte Einträge sind am unteren Rand angeordnet. Im Klappmenü Format
befinden sich Optionen für die Textformatierung.

Selektieren Sie die Kopf- und Fußzeile sowie die Platzierung in der Zeile (links, mitte
oder rechts) aus. Danach bewegen Sie mit der Maus einen der Einträge in das Feld. Die
Einträge sind durch individuelle Texteingabe erweiterbar.

Ränder

Die Option Ränder eignet sich für die Nutzung von Kopf- und Fußzeile sowie einem
Wasserzeichen.

Vergößern Sie die Ränder, falls die Kopf- und Fußzeile sowie das Wasserzeichen im
Ausdruck von Projektinhalten überdeckt sind.


Je nach verwendetem Druckermodell variieren die Abstände zum
Papierrand.
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Wasserzeichen

Mithilfe der Option Wasserzeichen wird eine Grafik in den Ausdruck eingebunden. Somit
lassen sich auch eigene Firmenlogos in den Ausdruck einbauen.

Die diversen Optionen steuern die Position, Größe und Deckkraft des Bildes im
Ausdruck.

Setzen Sie zuerst ein Häkchen bei Wasserzeichen drucken.

Bewegen Sie danach eine Grafikdatei , die für das Wasserzeichen als Logo dienen soll,

in das Feld Bild.

Bestimmen Sie anschließend Position, Stil, Skalierung, Ebene und Deckkraft des
Wasserzeichens.
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Stellen Sie die Skalierung auf manuell, damit lässt sich das Bild in seiner Größe
prozentual verändern.

In der mini Vorschau sehen Sie in Echtzeit das Ergebnis der Änderungen.


Für das Wasserzeichen lassen sich alle Grafikformate verwenden

(JPEG, GIF, TIFF, PNG u.a.), die auch von macOS und der Vorschau
unterstützt werden.
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Export

Merlin Project unterstützt die wichtigsten Dateiformate für den Export von Daten.

• CSV Text (zur Weiterleitung an EXCEL)

• ics (iCalendar Dateien)

• Bild (PDF, PNG, JPG, JPEG 2000, TIFF, BMP, GIF, mit Wasserzeichen und andere
Einstellungen)

• OPML

• Merlin Project XML

• HTML

• Microsoft Project (als MS Project XML)

• Omniplan 2

• MindManager / FreeMind (optional mit HTML-Darstellungsmodul) / NovaMind 5

Zum Exportieren wählen Sie den Menü Eintrag Ablage → Exportieren und das gewünschte
Format.
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Maus und Tastatur

Für die Nutzung von Merlin Project sind sowohl die Maus, als auch die Tastatur hilfreich.

Sehr viele Befehle lassen sich direkt und schnell mit Tastaturkurzbefehlen aufrufen,
andere Aufgaben sind leicht mit der Maus erledigt.


Die Tastaturkurzbefehle findet man direkt neben den Befehlen in den
Menüs.

Maus

Mit Maus ist das Eingabegerät zur Steuerung des Mauszeigers gemeint. Dies kann bei
mobilen Macs beispielsweise das Trackpad sein.


Alle aktuellen Macs unterstützen eine Vielzahl von Eingabegeräten
(Maus, Trackpad, Stifttablet etc.)

Die speziellen Gesten für die Nutzung von Maus und Trackpads, entnehmen Sie den
Systemeinstellungen von macOS, dort finden Sie die Anleitungsvideos zur
Veranschaulichung der jeweiligen Gesten.

Darin findet man beispielsweise die Optionen für den Sekundärklick, unter Windows auch
als rechter Mausklick bezeichnet.
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In Systemeinstellungen → Trackpad unter dem Register Zeigen und Klicken befinden
sich die Optionen für die Steuerung der Eingabegesten fürs Trackpad.

Kontextmenüs

Öffnen Sie Kontextmenüs in Merlin Project mit einem sekundären Mausklick. Damit
stehen zusätzliche Funktionen für die angeklickten Inhalte zur Verfügung.
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Bewegen (Drag & Drop)

Das Bewegen von Inhalten mittels Eingabegerät, wird im Englischen Drag & Drop
genannt. Damit wird der Vorgang des Bewegens und Loslassens gesteuert.


Auf diese Art und Weise lassen sich neue Gruppen erstellen, die
Reihenfolge von Inhalten des Projekts in der Gliederung anordnen,
Ressourcen zu Vorgängen zuweisen oder Anhänge erstellen.

Der Ablauf ist gleich:

1. Objekt(e) auswählen

2. Die Auswahl mit gleichzeitig gedrückter Maustaste bewegen

3. Die Auswahl auf ein Objekt durch das Loslassen der Maustaste ablegen

Gruppe mittels »Drag & Drop« erstellen

In Merlin Project werden neue Gruppen mit dieser Technik angelegt. Dabei werden
mehrere Vorgänge per »Drag & Drop« bewegt und auf einen anderen Vorgang abgelegt.

Der Vorgang auf den die Inhalte abgelegt werden, erscheint blau markiert und wird nach
dem Loslassen der Maustaste automatisch zu einer Gruppe (fett) und die Vorgänge zu
seinen Untervorgängen (eingerückt).

1. Auswahl mit einem Mausklick anklicken und die Maustaste gedrückt halten

2. Den Mauszeiger samt gedrückter Maustaste auf ein Objekt, in diesem
Beispiel auf einen Vorgang, bewegen (Maustaste noch nicht loslassen)
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3. Maustaste loslassen um die Auswahl abzulegen

Reihenfolge der Projektstruktur ändern

In Merlin Project werden Vorgänge, Gruppen und Meilensteine in Ihrer Reihenfolge
umsortiert. Dazu werden mehrere Vorgänge per »Drag & Drop« bewegt und zwischen
anderen Vorgängen abgelegt.

Es erscheint eine blaue Linie mit einem Kreis um die Position zwischen den Inhalten zu
markieren.

1. Auswahl mit einem Mausklick anklicken und die Maustaste gedrückt halten

2. Den Mauszeiger samt gedrückter Maustaste zwischen zwei Objekte, in
diesem Beispiel zwischen »Vorgang A« und »Vorgang B«, bewegen
(Maustaste noch nicht loslassen)
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3. Maustaste loslassen um die Auswahl abzulegen

Der Vorgang C befindet sich jetzt zwischen den Vorgängen Vorgang A und Vorgang B.
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Tastatur

Folgende Tasten sind auf dem Mac für die Verwendung von Tastaturkurzbefehlen von
Bedeutung.

Wichtige Tasten

Tasten und ihre Bezeichnungen:

1. Umschalttaste (Shift) → Großschreibtaste

2. Kontrolltaste (Control) → Entspricht Strg

3. Optionstaste (Option) → Entspricht Alt/Alt Gr

4. Befehlsstaste (Command) → Entspricht Windows

 In den Menüs wird die ctrl-Taste mit dem ^-Symbol dargestellt.

Die Befehlstaste wird mit cmd abgekürzt.

Beispielsweise wird die Option Vollbild ein/aus im Menü Fenster mit dem

Tastaturkurzbefehl ctrl + cmd + F gesteuert.

Zum Editieren von Inhalten eignen sich die nachfolgenden Tasten besonders gut.

190 Tastatur



5. Löschtaste (Backspace) → Rückschritttaste

6. Funktionstaste (Function) → Keine entsprechende Taste unter Windows

7. Eingabetaste (Return) → Enter

8. Entferntaste (Delete) → DEL

Tastaturkurzbefehle

Merlin Project verwendet eine Vielzahl von Tastaturkurzbefehlen.

Die Tastaturkurzbefehle bestehen aus mehreren gleichzeitig gedrückten Tasten, zum

Beispiel wird das Sichern von Projekten mit cmd + S ausgeführt. F-Tasten (F1,F2 etc.) sind
bei allen neueren Apple Tastaturen mithilfe der Funktionstaste fn verfügbar.

Die meisten Menüeinträge sind mit den dazugehörigen Tastaturkurzbefehlen versehen.
Sie stehen direkt hinter den einzelnen Menüeinträgen. Damit lassen sich mithilfe der
Tastatur schnell und effizient diese Menüeinträge aufrufen.
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Rollbalken

Rollbalken auch Scrollbalken genannt, dienen dem Bewegen des sichtbaren Bereichs im
Programmfenster.

Systemeinstellungen


Die Rollbalken und deren Verhalten werden durch das
Betriebssystem vorgegeben. Standardmäßig werden Rollbalken in
macOS nur beim Scrollen eingeblendet.

Die Inhalte in den unterschiedlichen Ansichten von Merlin Project lassen sich mithilfe von
Eingabegeräten, wie einer Maus oder einen Touchpad, im sichtbaren Auschnitt
bewegen. Die Rollbalken erscheinen erst wenn dies der Fall ist.



Bei der Apple Magic Mouse und dem Apple Trackpad sehen Sie die
Gesten für das Bewegen von Inhalten anhand von kleinen Animationen in

Systemeinstellungen → Maus und Systemeinstellungen →
Trackpad.
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Rollbalken einblenden

Öffnen Sie die Systemeinstellungen von macOS und klicken Sie auf das Symbol

Allgemein. Darin befinden sich die Optionen für das Verhalten der Rollbalken beim
Scrollen.

Die drei Optionen für das Scrollen mit Rollbalken sind Systemübergreifend und wirken
sich bei allen verwendeten Programmen aus.

• Automatisch auf Maus oder Trackpad basiert

• Beim Scrollen
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• Immer

Wählen Sie die Option Immer aus. Daraufhin erscheinen in Merlin Project die Rollbalken
und sind zudem programmübergreifend und permanent sichtbar.
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Fortgeschritten …
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Projekte abonnieren

Verfügen Sie über einer Merlin Server-Installation und haben dort Projekte freigegeben?
So müssen Sie diese Merlin Server-Projekte zunächst abonnieren, um sie in Merlin Project
öffnen und bearbeiten zu können.

Rufen Sie hierzu Ablage → Merlin Server → Dokumente aus dem Menü auf.

Ist ein Merlin Server in Ihrem LAN aktiv, wird dieser über Bonjour entdeckt und automatisch
angezeigt. Andernfalls sollten Sie einen Merlin Server-Account erstellen. Wählen Sie die
benötigte Datei aus und abonnieren Sie eine Kopie.


Abonnierte Kopien sollten in einem Verzeichnis auf der lokalen
Festplatte und nicht in Google Drive, Dropbox oder anderen Cloud-
Diensten gespeichert werden.

Sie arbeiten anschliessend mit der lokalen Kopie der abonnierten Datei. Die Datei muss
nicht neu abonniert werden.

196 Projekte abonnieren



Dokumente freigeben

Sie haben eine Projektdatei erstellt und möchten diese auf Ihrem Merlin Server freigeben?
Falls der Administrator Ihrer Merlin Server-Installation Ihnen das Kennwort für die
Fernverwaltung der Dokumenten geben kann, so rufen Sie Ablage > Merlin Server >
Dokument freigeben auf, klicken Sie auf 'Freigeben' und tragen das Kennwort ein.



Ist Ihnen das Fernverwaltungskennwort unbekannt, so müssen Sie das
Dokument dem Administrator Ihrer Merlin Server Installation zur
Verfügung stellen und dieser fügt es über die Benutzeroberfläche des
Merlin Server Programms zu den Server-Dokumenten hinzu.
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Synchronisierungs Hinweise

Immer wenn Sie die Projektdatei per cmd+S speichern oder wenn diese automatisch
gespeichert wird, werden Änderungen mit der Datei auf den Merlin Server synchronisiert.
Hat das Gerät, auf dem Merlin Project installiert ist, momentan keine Verbindung zu Merlin
Server (weil das Gerät oder der Merlin Server vorübergehend offline bzw. nicht über das
Internet zugänglich sind), so werden die Änderungen lokal gespeichert und beim nächsten
Zugriff auf Merlin Server synchronisiert (z.B. wenn der Mac sich wieder im gleichen LAN
wie der Merlin Server befindet).

Beim Synchronisieren sendet die lokale Datei die lokal gespeicherten Änderungen auf den
Server und empfängt vom Server Änderungen, die von anderen Nutzern gemacht wurden.


Wenn Sie möchten dass Ihre lokale Kopie nicht mehr mit dem Server
synchronisiert werden sollte, zB falls Sie ein Backup des aktuellen Status
brauchen, so klicken Sie Ablage > Merlin Server > Verknüpfung lösen.

Eine so entkoppelte Datei kann wieder mit dem Server synchronisiert werden, falls Sie
Ablage > Merlin Server > Mit bestehendem Dokument auf Server verknüpfen aufrufen.
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Finanzen

In Merlin Project stehen Ihnen Optionen für die Finanzen im Projekt zur Verfügung. Jeder
Vorgang, Meilenstein, bzw. jede Gruppe oder Zuweisung lässt sich mit einem Budget
und mit Basiskosten versehen.

Der einfachste Weg ist die Nutzung des Finanzen Registers im Inspektor.

Dort finden Sie drei weitere Register:

• Budget

• Kosten

• Saldo
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Budget

Unter Budget versteht man Gelder, die für das Projekt zur Verfügung stehen.

Selektieren Sie einen Vorgang, einen Meilenstein oder eine Zuweisung und klicken dann
im Inspektor auf das Register Finanzen → Budget. Hier lassen sich alle Budget-
Informationen in die zur Verfügung stehenden Felder eintragen.


Haben Sie kein Budget und möchten die Basiskosten für das Projekt
eintragen, verwenden Sie das Register Finanzen → Kosten
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Kosten

Im Register Finanzen > Kosten steht Ihnen die Eingabe von Basiskosten für die Selektion
zur Verfügung.


Basiskosten sind feste Kosten, die bei der Planung und Ausführung
des Projekts entstehen, und zusätzlich zu etwaigen Arbeitskosten bzw.
Anhängekosten angerechnet werden sollen.

Haben Sie mehrere Kostenpositionen, erstellen Sie nacheinander neue Einträge mit
einem Mausklick auf das +. Merlin Project addiert die einzelnen Kostenpositionen
automatisch. Im Feld Basiskosten sind alle Kostenpositionen als Summe aufgeführt.

Sie können für die Fälligkeit der Basiskosten eine der möglichen Einstellungen wählen:

• Fällig sofort

• Fällig zu Beginn

• Anteilig fällig

• Fällig am Ende
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Fällig sofort

Basiskosten mit der Fälligkeit Fällig sofort erscheinen sofort und komplett in den
Wirklichen Basiskosten.

Fällig zu Beginn

Basiskosten mit der Fälligkeit Fällig zu Beginn erscheinen komplett in den Wirklichen
Basiskosten aber erst ab den Moment an, wo es wirklichen Fortschritt gibt.

Anteilig fällig

Basiskosten mit der Fälligkeit Anteilig fällig erscheinen anteilig zu dem wirklichen
Fortschritt in den Wirklichen Basiskosten.

Fällig am Ende

Basiskosten mit der Fälligkeit Fällig am Ende erscheinen komplett in den Wirklichen
Basiskosten aber erst ab den Moment an, wo es eine 100%-ige Erledigung gibt.
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Saldo

Im Register Finanzen → Saldo finden Sie die Übersicht der Kostenwerte aufgeschlüsselt
nach Erwartet, Geplant und Wirklich.



Selektieren Sie das Projekt in der Zeile #0 und wechseln im Inspektor zu
Finanzen → Saldo. Sie erhalten die gesamte Auflistung im Projekt
enthaltenen Kostenpositionen aufgeschlüsselt nach Erwartet,
Geplant und Wirklich.
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Arbeitskosten

Arbeitskosten sind Kosten, die durch die Arbeit von zugewiesenen Ressourcen am
Vorgang und deren Kosteninformation entstehen.

Eine Ressource kann über folgende Kosteninformation verfügen:

• Standardsatz

• Überstundensatz

• Basiskosten


Tragen Sie Kosteninformation Ihrer Ressourcen in einer Ressourcen-
bzw. Zuweisungen-Ansicht im Kosten-Inspektor ein.

Anhängekosten

Anhängekosten sind Kosten, die durch die Anhängen am Vorgang und deren
Basiskosteninformation entstehen.


Tragen Sie Basiskosten Ihrer Anhänge in einer Anhänge-Ansicht im
Kosten-Inspektor ein.
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Kostenansichten

In Merlin Project finden Sie folgende vorkonfigurierten Kostenansichten:

• Strukturplan > Budgetierung

• Strukturplan > Kostenerwartung

• Strukturplan > Kostenplanung

• Strukturplan > Soll/Ist-Vergleich (Kosten)

• Zuweisungen > Kostenerwartung

• Zuweisungen > Kostenplanung

• Zuweisungen > Soll/Ist-Vergleich (Kosten)

• Ressourcen > Kosten

Diese Ansichten enthalten Spaltensets, die Ihnen einen Überblick über die Kosten für die
einzelnen Gruppen, Vorgänge, Meilensteine, Zuweisungen und Ressourcen bieten.


Wechseln Sie in eine der vielen Kostenansichten, um schnell an
Budget-Informationen im Projekt zu gelangen.
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Kanban

Was ist Kanban?

Kanban stammt aus dem Japanischen und bedeutet so viel wie Karte, Tafel oder Beleg.

Kanban ist neben Scrum eine der am weitesten verbreiteten agilen Methoden im
Projektmanagement.

Es wurde ursprünglich für die Produktionssteuerung entwickelt, mittlerweile ist die agile
Methode weit verbreitet auch im Projektmanagement.

Die Nutzung von Kanban ermöglicht eine bessere Auslastung, höhere Transparenz und
schnellere Iterationen im Projektverlauf.

Prinzip von Kanban

Das Kanban-System basiert auf Karten die auf einer Tafel in Spaltenreihen von links nach
rechts bewegt werden.

Jede Aufgabe wird auf einer Karte notiert. Je nach Bearbeitungsstatus wandert eine Karte
auf der Tafel von links nach rechts bis zu ihrer Fertigstellung.

Die Karten erhalten durch das Verschieben in den Spalten einen definierten Status. Mit
dem Fortschritt des Projekts wandern immer mehr Karten von links nach rechts.

Spalten in Kanban

Im einfachsten Kanban-System wird die Kanban-Tafel in drei Spalten eingeteilt. Der
Verlauf erfolgt immer von links nach rechts.
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Anstehend (To Do): In die linke Spalte werden Aufgaben eingetragen, deren Bearbeitung
noch nicht begonnen wurde. Diese Aufgaben sind geplant und stehen demnächst an.

In Bearbeitung (In Progress/Doing): Sobald die Bearbeitung einer Aufgabe beginnt, wird
die dazugehörige Karte in die mittlere Spalte verschoben. Solange die Aufgabe bearbeitet
wird, verbleibt die Karte in dieser Spalte.

Erledigt (Done): Ist die Aufgabe erledigt, wandert die Karte in die rechte Spalte. Die
Aufgabe wurde erfolgreich fertiggestellt.
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Kanban in Merlin Project

Merlin Project bietet die Möglichkeit mit dem klassischen und dem agilen
Projektmanagement zu planen und jederzeit zu wechseln oder beide Methoden
gleichzeitig zu verwenden.

Der Fortschritt und somit der Status zwischen den Ansichten der klassischen und der
agilen Planung wird automatisch aktualisiert. Diese einmalige Funktion ermöglicht es ein
flexibles Arbeiten und das Planen innerhalb der verschiedenen Methoden.

Die Grenzen zwischen dem agilen und klassichen Projektmanagement verschwinden
erstmalig mit der Einführung von Merlin Project.



Der Wechsel zwischen der klassischen Ansicht Strukturplan >
Eingabe und der Ansicht Netzplan > Kanban ist jederzeit möglich.
Schalten Sie die sekundäre Projektansicht ein, um beide Methoden
gleichzeitig zu überblicken.

Es existieren zwei grafische Darstellungen von Kanban Merlin Project, die klassische und

die Kompakte. Für die Kompakte wählen Sie aus dem Klappmenü Netzplan die Ansicht

Kanban Kompakt aus.
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Kanban-Ansicht nutzen

Kanban ist ein sehr flexibler Ansatz für das Arbeiten mit Projekten. Lernen Sie
nachfolgend, wie man in Merlin Project mit Kanban schnell loslegt.

Öffnen Sie ein neues oder bestehendes Projekt. Klicken Sie hierzu im Menü auf Ablage >
Öffnen oder verwenden Sie den Tastaturkurzbefehl cmd + O.

Zum erstellen eines neuen Projekts klicken Sie im Menü auf Ablage > Neu oder verwenden

Sie den Tastaturkurzbefehl alt + cmd + N.

Wechseln Sie aus der Ansicht Strukturplan > Eingabe in die Ansicht Netzplan >
Kanban.


Das Wechseln der Ansichten erfolgt schnell über das Menü

Darstellung. Wählen Sie hierzu im Menü Darstellung > Netzplan >
Kanban aus.
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Kanban-Ansicht erstellen

Beim ersten Aufrufen der Kanban-Ansicht erscheint ein Hinweis mit der Schaltfläche Nach
Statusfeld gruppieren….


Kanban benötigt eine Gruppierung nach einem Statusfeld und die

darin enthaltenen Statuswerte für die Kanban-Spalten.

Klicken Sie auf die Schaltfläche, zum öffnen des Assistenten Gruppieren nach
Statusfeld.
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Der Assistent beinhaltet vorgefertigte Statusfeld-Vorlagen.


Mehr zur Funktion "Gruppierungen" in Merlin Project erfahren Sie in der

Anleitung »Gruppierungen«.

Automatisch ist die Option »Nach neuem Feld aus Vorlage:« und »Einfaches Kanban«
voreingestellt. Klicken Sie auf OK um mit diesem Kanban-Status zu arbeiten.


Mit "Feld" sind benutzerdefinierte Felder gemeint. Die Felder lassen sich
in jedem Vorgangsinspektor im Register »Tags und Felder« erstellen
und verwalten.

Die im mitgelieferten Feld »Einfaches Kanban« vorhandenen Statuswerte sind als
Spalten nachher in der Kanban-Tafel zu sehen.


Neue Felder lassen sich schnell erstellen oder vorhandene Felder
bearbeiten. Wie das geht, erfahren Sie in der Anleitung Tags und
Felder.

Anhand dieser Statuswerte lassen sich die Kanban-Karten ordnen und in der klassischen
Ansicht mit einem definierten Kanban-Status bearbeiten.

Die Statuswerte lassen sich im Assistenten verändern. Klicken Sie auf einen Eintrag zum
Verändern.


Mehr zu den einzelnen Statuswert-Optionen erfahren Sie im späteren
Verlauf der Anleitung.
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Klicken Sie auf das Plus zum erstellen von neuen Statuswerten oder entfernen Sie

vorhandene Statuswerte mit dem Minus


Das Feld »Einfaches Kanban« eignet sich für eine Vielzahl von
Projekten. Damit wird der schnelle Einstieg in die Kanban-Methodik
ermöglicht.

Kanban-Methodik anwenden

Nachfolgend erfahren Sie mehr über die Nutzung von Kanban in Merlin Project.

In der Kanban-Tafel erscheinen die aus dem Feld »Einfaches Kanban« vorgegebenen
Statuswerte in einzelnen Spalten.

Die Spalten sind von links nach rechts in folgenden Statuswerten geordnet:

• Aufgaben

• In Arbeit

• Prüfen

• Erledigt
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Befinden sich bereits Vorgänge im Projekt, erscheinen sie automatisch in den Spalten als
Kanban-Karten. In welcher Spalte die Karten angeordnet sind, hängt von Ihrem Status in
dem Projekt ab.

Neue Kanban-Karten erstellt man mit einem Mausklick auf das Plus-Symbol oder mit dem

Tastaturkurzbefehl cmd + N.

Die dadurch erstellte Karte wird automatisch als Vorgang in der klassischen Ansicht
erscheinen. Mit einem Mausklick auf den Pfeil rechts neben dem Plus-Symbol lassen sich
weitere Karten-Typen und auch Anhänge erstellen.
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
Die gleichen Funktionen wie unter dem Pfeil, befinden sich zudem im

Menü Einfügen.

Selektieren Sie eine oder mehrere Karten und klicken Sie anschließend auf Anhang.

Diese Option ermöglicht das Hinzufügen von beliebigen Dateien und Informationen an die
markierte(n) Karte(n). Anhänge werden in der unteren linken Ecke der Karte mit einer
Büroklammer symbolisiert.
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Assistent: Kanban nach Statusfeld gruppieren

Die Gruppierung nach Statusfeld ist eine Voraussetzung für die Kanban-Ansicht.

Im Assistenten für die Auswahl des Statusfelds sind folgende Optionen enthalten:

• Nach neuem Feld:

◦ Einfaches Kanban

◦ Software-Entwicklung

◦ Problembehebung

◦ Redaktion

◦ Aussteller

◦ Vertrieb

◦ Aufmerksamkeitsstufe

◦ Feld mit eigenen Statuswerten

• Nach neuem Feld aus Vorlage:

◦ Status (berechnet)

Nachdem eine Auswahl des Statusfelds erfolgt ist, erscheint eine Vorschau der im
Statusfeld enthaltenen Statuswerte.

Die Option nach neuem Feld aus Vorlage ermöglicht es Ihnen direkt mit einer
vorgefertigten Vorlage loszulegen. Damit geht die Erstellung eines Kanbans am
einfachsten.

Die im Klappmenü vorhandenen Auswahlmöglichkeiten sind bereits für eine vielzahl von

Projekten verwendbar. Mit der Option Nach neuem Feld aus Vorlage lassen sich eigene
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Felder, die bereits im Projekt enthalten sind, für die Gruppierung der Spalten auswählen.


In neu erstellten Projekten erscheint im Klappmenü das bereits

vorhandene Feld Status (berechnet).

Das Feld Status (berechnet) unterscheidet sich zu den meisten Feldern, da es auf
berechnete Werte im Projekt zugreift. Damit lassen sich die Kanban-Karten nicht mehr
manuell in der Kanban-Ansicht bewegen, sondern werden automatisch durch berechnete
Werte im Projektfortschritt beinflusst.

Die Spalte Ungeplant wird bei Status (berechnet) solange als einzige Spalte
eingeblendet, bis ein Projektfortschritt in wirklichen Werten stattfindet.

Der Status wird mit der gleichnamigem Spalte in der Ansicht Strukturplan > Eingabe
angezeigt.

Assistent für Gruppierung erneut aufrufen

Klicken Sie auf das Symbol Gruppierung zum Einblenden der Liste mit den eingebauten
Gruppierungen.
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Führen Sie einen Mausklick auf die Schaltfläche Nach Statusfeld gruppieren… aus.

Der Assistent für die Gruppierung nach Statusfeld erscheint. Wählen Sie eine gewünschte
Gruppierung für die Kanban-Ansicht aus.
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Eigene Gruppierung erstellen

Klicken Sie auf das Symbol Gruppierung zum Einblenden der Liste mit den eingebauten
Gruppierungen.

Klicken Sie auf das Plus-Symbol unten links im Gruppierung-Inspektor, es wird eine neue
Gruppierung in der Kategorie "Eigene" erstellt.

Benennen Sie die Gruppierung und klicken Sie anschließend auf die Lupe.
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Es wird der Dialog für die Anpassung der Gruppierung eingeblendet. Hier lassen sich die
Gruppierungsoptionen festlegen. Anhand dieser Optionen erfolgt die Gruppierung der
Ansicht. Verwenden Sie hierzu die Klappmenüs.

Mit einem Mausklick auf das Plus lassen sich weitere Bedingungen für die Gruppierung

hinzufügen. Mit einem Mausklick auf das Minus wieder entfernen.

Klicken Sie aufs Rechteck links neben einer Gruppierung, wird sie aktiviert und in der
Kanbanansicht direkt angewandt.
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

Die vorhandenen Gruppierungen lassen sich bei Bedarf anpassen.
Hierzu selektieren Sie eine vorhandene Gruppierung und klicken rechts

davon auf die Lupe. Nach erfolgter Anpassung wird die neue Einstellung
in der ausgewählten Gruppierung übernommen.

Die aktive Gruppierung wird neben dem Symbol Gruppierung angezeigt. Mit einem
Mausklick darauf gelangt man zu der Liste und kann jederzeit die Gruppierung ändern oder
anpassen.

Statusfelder Anpassen

Klicken Sie auf einen Spaltentitel in der Kanban-Ansicht, wird der Inspektor

"Gruppierung" eingeblendet. Darin wird der angeklickte Wert des Statusfelds angezeigt
und lässt sich anpassen.


Eine Ausnahme bilden Spalten mit berechneten Werten, diese lassen
sich im Inspektor nicht ändern oder anpassen.

Im Inspektor "Gruppierung" stehen die folgenden Optionen zur Verfügung:

• Wert (Name des Spaltentitels)

• Ab Erledigung (Klappmenü mit Erledigungswerten 0% bis 100%)
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• Anzahl Kästchen

◦ Minimale Anzahl

◦ Maximale Anzahl

◦ Alle Werte bearbeiten (Blendet den Inspektor für Benutzerdefinierte
Felder ein)


Die gleichen Einstellungen befinden sich auch im Assistenten

Gruppieren nach Statusfeld für die Werte.

Klicken Sie auf die Option Alle Werte bearbeiten im Inspektor Gruppierung, wird der
Inspektor für die aktuellen Werte der Gruppierung geöffnet. Lesen Sie hierzu mehr im
Abschnitt Feldwerte-Inspektor.

Mit den Optionen Minimale Anzahl lässt sich die minimale Anzahl der angezeigten
Karten in der Spalte steuern.

Bei einer festgelegten minimalen Anzahl der Karten, erscheint in der Titelspalte eine
Zählung mit der aktuellen Anzahl der Karten und dem vorgegebenen minimalen Wert.


Ist der minimale Wert höher als die aktuelle Anzahl der Karten, wird dies
mit einem orangenen Farbton der Titelspalte signalisiert.

Mit den Optionen Maximale Anzahl lässt sich die maximale Anzahl der angezeigten
Karten in der Spalte steuern.

Bei einer festgelegten maximalen Anzahl der Karten, erscheint in der Titelspalte eine
Zählung mit der aktuellen Anzahl der Karten und dem vorgegebenen maximalen Wert.

Kanban Felder

Die Feldwerte lassen sich im Inspektor für Benutzerdefinierte Felder bearbeiten und
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anpassen.

Diese Feldwerte bestimmen den Fortschritt für die Karten und damit auch für die Vorgänge
in der Kanban-Ansicht und den weiteren Ansichten in Merlin Project.

Feldwerte-Inspektor

Im Inspektor Benutzerdefinierte Felder befindet sich die aktuelle Gruppierung, sowie die
dazugehörigen Werte.

Klicken Sie auf das Symbol rechts neben dem Wert, erscheinen alle vorhadenen Werte der
aktiven Gruppierung im Klappmenü. Diese Werte werden für die Spalten in der Kanban-
Ansicht verwendet. Die Auswahl wird für die selektierte(n) Karte(n) umgehend angewandt.
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Vordefinierte Werte

Weiter unten im Inspektor befindet sich die Auflistung Vordefinierte Werte für die aktive

Gruppierung. Mit einem Mausklick auf das Plus-Symbol oder das Minus-Symbol lassen
sich neue Werte in der Gruppierung hinzufügen oder entfernen.

Die Werte können unterschiedliche Eigenschaften erhalten. Diese Eigenschaften sind:

• Wert

• Erledigung

• Min

• Max

• Stufe

Wert ist gleichzeitig der Titel der Spalte in der Kanban-Ansicht.
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Erledigung steuert den Fortschritt der Vorgänge sowohl in der Kanban-Ansicht als auch
in allen anderen Ansichten.

Es existieren folgende Auswahlmöglichkeiten:

• Leer (Kein Erledigungsstand)

• Nicht begonnen

• 0% bis 100% (in Zehnerschritten)

Beim Eintragen eines %-Wertes für einen Vorgang, der dem %-Wert in der Spalte

Erledigung entspricht, wird automatisch die zum Vorgang gehörende Karte in die
Kanban-Spalte verschoben.

Im Umkehrschluss funktioniert das manuelle Verschieben. Wird eine Karte in diese
Kanban-Spalte bewegt, erhält automatisch der Vorgang den %-Wert der Erledigung.

Min ist die minimale Anzahl der Karten in der Kanban-Spalte. Dieser Wert entspricht der
gleichnamigen Option im Inspektor für die Gruppierung.
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Max ist die maximale Anzahl der Karten für die Kanban-Spalte. Dieser Wert entspricht der
gleichnamigen Option im Inspektor für die Gruppierung.

Stufe beinhaltet die optionale Kategorisierung des Wertes in:

• Neutral (weißer Kreis)

• Normal (grüner Punkt)

• Warnung (gelbes Dreieck)

• Kritisch(rotes Rechteck)

Diese Kategorisierung ist nur in der Liste der Werte einsehbar und hat keinen Einfluss auf
die Planung, sie dient lediglich der Information des Planenden.


Die Option Freie Eingabe erlauben ist deaktiviert, da die Statusfelder
mit voreingestellten und oder berechneten Werte arbeiten. Die freie
Eingabe ist somit nicht möglich.
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Terminkonflikte

Merlin Project visualisiert Ihre Planung und warnt Sie, wenn es Terminkonflikte erkennt.
Planungswarnungen werden angezeigt, wenn ein bestimmter Wert nicht verwendet
werden kann. Es ist möglich, die Warnungen in den Darstellungsoptionen zu deaktivieren.

Merlin Project unterscheidet Konflikte in zwei Kategorien: stark und schwach. Rote
Zeilentitel stellen starke Konflikte dar. Orangefarbene Titel stehen für schwache Konflikte.

Fahren Sie mit der Maus über einen dieser roten oder orangefarbenen Titel, nach wenigen
Augenblicken erscheint ein sogenannter Tool Tip, mit dem entsprechenden Konflikt.

Wenn Sie die Spalte Info aktiviert haben, sehen Sie auch die entsprechenden Symbole.

Darüberhinaus sind alle Konflikte im Fenster Mitteilungen mit einer kurzen Beschreibung
aufgeführt.

Entfernen Sie das Häkchen bei Schwache Konflikte anzeigen, in der Liste erscheinen nur
noch starke Planungskonflikte.

Schwache Konflikte

• Erwartete Arbeit überschreitet den angegebenen Wert.

• Erwartete Dauer überschreitet den angegebenen Wert.

• Die Budgetsumme überschreitet den genehmigten Betrag.

Starke Konflikte

• Vorgang startet vor dem angegeben Datum.

• Vorgang startet nach dem angegeben Datum.

• Vorgang endet nach dem angegeben Datum.

• Vorgang endet vor dem angegeben Datum.

• Die Abhängigkeitsfolge ist verletzt.

• Mehr als n Vorgänge haben den Status "…"
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Konflikte lösen

Es kann mehrere Gründe geben, warum ein Konflikt entsteht und wie man damit umgeht.
Ein Algorithmus kann unmöglich entscheiden, welche der betroffenen Einstellungen
ignoriert werden soll. Daher unterstützt Merlin Project keine automatische Konfliktlösung.

Wenden Sie sich mit Ihrem Projekt an unseren Support, damit wir versuchen können, Ihnen
mit Ihren Optionen zu helfen.


In unserem blog bieten wir einige mögliche Lösungsansätze an. Klicken
Sie einfach auf den einzelnen Konflikt für weitere Informationen.
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Ressourcenpool

Was ist ein Ressourcenpool?

Ein Ressourcenpool erlaubt die zentrale Nutzung und den Abgleich von den selben
Ressourcen in mehreren Projekten.

Die Besonderheit eines Ressourcenpools besteht darin, dass die Ressourcen für mehrere
Projekte bereitstehen und sich somit alle Änderungen an den Ressourcen automatisch in
allen Projekten, die auf den Ressourcenpool zugreifen, angleichen.

Vorteile bei der Projektplanung

Bei der Nutzung von mehr als einem Projekt und einer Anzahl von immer wiederkehrenden
und somit gleichen Ressourcen, ist der Ressourcenpool die optimale Lösung.

Mithilfe des Ressourcenpools lassen sich bei mehreren Projekten die gleichen Ressourcen
verwenden, dabei stehen alle Ressourceninformationen aus dem Ressourcenpool für alle
mit dem Ressourcenpool-Datei verbundenen Projekte zur Verfügung.

Bei Änderungen der Ressourcen in der Ressourcenpool-Datei werden die Informationen
automatisch in den verbundenen Projekten aktualisiert.

Die Nutzung von Ressourcenpools erleichtert die Arbeit bei einer Vielzahl von Projekten
mit den selben Ressourcen und Zuweisungen.

Ressourcenpool erstellen

Zum Erstellen eines neuen Ressourcenpools wird eine neue Projektdatei benötigt.

Starten Sie Merlin Project und öffnen Sie ein neues Projekt. Klicken Sie hierzu im Menü auf

Ablage > Neu oder verwenden Sie den Tastaturkurzbefehl alt + cmd + N.


Alternativ klicken Sie unten links im Öffnen-Dialog auf die Schaltfläche

Neues Dokument.
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Ressourcen erstellen

Erstellen Sie auf die Schnelle neue Ressourcen für den Ressourcenpool.

Klicken Sie auf das Ressourcen-Symbol in der Symbolleiste.

Anschließend klicken Sie auf das Plus-Symbol zum Erstellen einer neuen Ressource.
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Benennen Sie die neu erstellte Ressource. Fahren Sie anschließend fort mit einem

Mausklick auf das Plus-Symbol. Wiederholen Sie die genannten Schritte bis Sie alle
benötigten Ressourcen für den Ressourcenpool erstellt haben.


Verwenden Sie bei eingeschalteter Ressourcen-Ansicht das Menü

Einfügen und den Punkt Ressource oder den dazugehörigen

Tastaturkurzbefehl cmd + N für das Anlegen von neuen Ressourcen.

Ressourcen-Ansicht

Wechseln Sie in die Ansicht Ressourcen > Eingabe für eine detaillierte Bearbeitung der
Ressourcen. In dieser Ansicht stehen Ihnen Spalten mit diversen Informationen für die
Anpassung von Ressourcen zur Verfügung.

Selektieren Sie eine Ressource, wird zudem der Ressourcen-Inspektor eingeblendet.
Darin finden Sie alle Felder für die Anpassung der selektierten Ressource.

Bild

Klicken Sie auf das Einfügen-Symbol in der Spalte Bild, um ein Bild für Ihre Ressourcen
einzufügen.
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
Das Bild erscheint in Kanban-Karten und in allen Kommentaren, die
diese Ressource in das Projekt einfügt.

Ressourcen aus Kontakten erstellen

Befinden sich Kontakte bereits in der Kontakte.app oder Microsoft Outlook, lassen sich

diese Kontakte direkt in die Ansicht Ressourcen > Eingabe mithilfe der Maus bewegen
und somit dem Ressourcenpool als Ressourcen hinzufügen.

Beachten Sie bitte, dass die blauen Linien einen Unterschied beim Hinzufügen der
Kontakte ausmachen.

Legen Sie die Visitenkarte zwischen den Zeilen ab, so wird der Kontakt aus der Karte zu
den bereits vorhandenen Ressourcen hinzugefügt.
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Legen Sie die Visitenkarte auf einer bereits vorhandenen Ressource ab (auf der Zeile), so
wird die Ressource mit dem Kontakt aus der Karte ersetzt.


Beim Hinzufügen aus der Kontakte.app oder Microsoft Outlook, werden

Visitenkarten im vCard-Format verwendet.

Haben Sie andere Apps, die das vCard(.vcf)-Format exportieren, lassen sich auch diese
Kontakte in die Ressourcen-Ansicht bewegen und als Ressourcen nutzen.

Die in den vCards vorhandenen Informationen, werden in den einzelnen Spalten der
Ressourcen-Ansicht automatisch übernommen. Darunter das Bild, die E-Mail und die
Telefonnummer des Kontaktes, falls diese Informationen in der vCard vorhanden sind.

Ressourcenpool zu Projekten hinzufügen

Sind alle Ressourcen und notwendigen Informationen, wie beispielsweise die
Standardsätze, also Kosten der Ressource pro Zeiteinheit im Ressourcenpool komplett
eingetragen, sichern Sie die Datei.

Verwenden Sie hierzu das Menü Ablage > Sichern oder den Tastaturkurzbefehl cmd + S

Benennen Sie die Ressourcenpool-Datei und klicken anschließend auf Sichern.


Der Dateiname wird in der Ressourcen-Ansicht für den Ressourcenpool
verwendet.

232 Ressourcenpool



Öffnen Sie ein neues oder leeres Projekt in dem die Ressourcenpool-Datei zum Einsatz
kommen soll.

Ressourcenpool | Merlin Project-Handbuch 233



Klicken Sie in der Symbolleiste auf das Symbol Einstellungen (1) und selektieren Sie das

erste Symbol von rechts, das Register Auslastung (2).

Im Inspektor für die Auslastung befindet sich im Bereich Auslastungsberechnung die

Option Pool-Zuweisungen beachten.

Sie ist standardmäßig aktiviert. Sind Ressourcenzuweisungen aus Ressourcenpools im
Projekt vorhanden, so werden Sie bei der Auslastungsberechnung beachtet. Entfernen Sie
das Häkchen, damit werden die Pool-Zuweisungen bei der Auslastungsberechnung nicht
beachtet.

Im unteren Bereich befindet sich die Liste für Ressourcenpools.

An dieser Stelle lassen sich Pool-Dateien als Ressourcenpools zum geöffneten Projekt
hinzufügen, entfernen und bearbeiten.

Die Option Zuweisungen veröffentlichen zeigt alle Zuweisungen aus den Projekten in
der Ressourcenpool-Datei. Standardmäßig ist diese Option aktiviert. Entfernen Sie das
Häkchen, falls die Anzeige der Zuweisungen in der Pool-Datei nicht erwünscht ist.


Das kann beispielsweise bei Projekte mit vertraulichen Informationen
betreffen, damit diese nicht in der Pool-Datei auftauchen.
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Ressourcenpools mit Maus hinzufügen

Der einfachste Weg eine oder mehrere Projektdateien als Ressourcenpool zu verwenden,
ist diese in das Feld des Inspektors mit der Maus zu bewegen.

Beim Hinzufügen des Ressourcenpools können alle Ressourcen automatisch übernommen
werden.


Projektdateien mit Vorgängen lassen sich nicht als Ressourcenpool
verwenden. Sind Vorgänge in der Projektdatei enthalten, wird der
nachfolgende Dialog eingeblendet.

Löschen Sie zuerst die Vorgänge aus der Projektdatei, um sie anschließend als
Ressourcenpool zu verwenden.
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Ressourcenpools mit Symbol hinzufügen

Verwenden Sie das Plus-Symbol zum Hinzufügen von einem oder mehreren
Ressourcenpools.

Klicken Sie im Öffnen-Dialog auf eine Projektdatei, die als Ressourcenpool dienen soll.

Wiederholen Sie gegebenfalls den Vorgang zum Hinzufügen von weiteren
Ressourcenpools.

Ressourcenpools entfernen

Selektieren Sie in der Liste ein oder mehrere Ressourcenpools und verwenden Sie die

Löschtaste oder klicken Sie mit der Maus auf das Minus-Symbol.

Die Verbindung zum Ressourcenpool wird aus dem Projekt entfernt und der folgende
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Hinweis wird eingeblendet.

Lösen Sie die Verbindung nur dann auf, wenn Sie sicher sind, dass Sie die Ressourcen
nicht mehr aktualisieren möchten. Die Ressourcen verbleiben in dem Projekt, werden aber
autark bei allen Änderungen. Das bedeutet es besteht keine Verbindung mehr zu der
ursprünglichen Ressourcenpool-Datei.


In einer Projektdatei die bereits als Ressourcenpool Verwendung findet,
lassen sich keine Ressourcenpools einbinden.

Ressourcenpools benutzen

Nach dem Einbinden eines Ressourcenpools im Projekt, werden die Ressourcen in der

Ressourcen-Ansicht aufgelistet.

In der Ansicht Ressourcen werden alle Ressourcen aus dem Ressourcenpool in das

Projekt eingebunden und aufgelistet. Diese Ressourcen sind in der Info-Spalte mit einem

Doppelpfeil-Symbol gekennzeichnet.
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Die Gruppe der Ressourcen, die sich im Ressourcenpool befindet, wird unterhalb der im

Projekt befindlichen Ressourcen mit einem Ordner, auf dem das Doppelpfeil-Symbol
abgebildet ist, repräsentiert.

Klicken Sie auf das Dreieck zum Auf- und Zuklappen des Ressourcen-Ordners.


Der Ressourcenpool-Ordner trägt den gleichen Namen wie die
entsprechende Ressourcenpool-Datei aus dem es die Ressourcen
bezieht.

Ressource aus Pool in Projekt bewegen

Zur Übernahme von Ressourcen aus dem Ressourcenpool ins Projekt, wechseln Sie in die

Ansicht Ressourcen.
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Bewegen Sie aus dem Ressourcenpool die gewünschte(n) Ressource(n) mithilfe der Maus
in den Bereich der Ressourcen, die sich im Projekt befinden.

Ressourcen aus Projekt in Pool bewegen

Zur Übernahme von Ressourcen aus dem Projekt in den Ressourcenpool, wechseln Sie in

die Ansicht Ressourcen.

Bewegen Sie aus dem Projekt die gewünschte(n) Ressource(n) mithilfe der Maus in den
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Bereich eines Ressourcenpools.

Änderung gegenüber Pool verwerfen

Möchten Sie Informationen von Ressourcen im Projekt gegenüber dem Ressourcenpool

verwerfen, sollten Sie in die Ansicht Ressourcen wechseln.

Führen Sie anschließend einen sekundären Mausklick auf eine Ressource oder mehrere
selektierte Ressourcen aus.

Im Kontextmenü klicken Sie auf die Option Änderung gegenüber Pool verwerfen.

Alle Änderungen der Ressource werden daraufhin aus dem Ressourcenpool verworfen.

Ressourcenpool aktualisieren

Möchten Sie Informationen von Ressourcen aus dem Projekt zum verbundenen

Ressourcenpool übertragen, sollten Sie in die Ansicht Ressourcen wechseln.

Führen Sie anschließend einen sekundären Mausklick auf eine Ressource oder mehrere
selektierte Ressourcen aus.
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Im Kontextmenü klicken Sie auf die Option Änderungen an Pool senden.

Alle neuen Informationen zu der Ressource werden daraufhin an den Ressourcenpool
übertragen und darin aktualisiert.

Vom Ressourcenpool lösen

Möchten Sie Ressourcen vom Ressourcenpool unabhängig machen, sollten Sie in die

Ansicht Ressourcen wechseln.

Führen Sie anschließend einen sekundären Mausklick auf eine Ressource oder mehrere
selektierte Ressourcen aus.

Ressourcenpool | Merlin Project-Handbuch 241



Im Kontextmenü klicken Sie auf die Option Vom Ressourcenpool lösen.

Alle neuen Änderungen und Anpassungen an den vom Ressourcenpool gelösten
Ressourcen werden nur noch im Projekt gesichert und es findet keine Übertragung zum
oder vom Ressourcenpool statt.

Ressourcenpool aus- und einblenden

Der Ressourcenpool wird in den Ansichten Ressourcen und Zuweisungen angezeigt. Das
für zu einer mehrfachen Anzeige von Ressourcen im Projekt und Ressourcenpools.

Zum Ein- und Ausschalten dieser Optionen klicken Sie auf das Symbol

Darstellungsoptionen.

Im Darstellungsoptionen-Inspektor entfernen oder setzen Sie gegebenfalls das

Häkchen bei der Option Ressourcenpools.

Mit dieser Option werden alle Ressourcenpools in der Ansicht ein- oder ausgeblendet.
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
Die mit einem Ressourcenpool verbundenen Ressourcen sind in der

Info-Spalte mit einem Doppelpfeil-Symbol gekennzeichnet, wenn die
Anzeige von Ressourcenpools ausgeschaltet ist.
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Zugriffsrechte

Kennwortschutz

In Merlin Project lassen sich einzelne Projektdateien mit individuellen Kennwörtern und
Zugriffsberechtigungen schützen. Hierzu wird mindestens eine Ressource als aktiver
Benutzer benötigt.


Jedes Projekt ist standardmäßig mit einem Gastzugriff ausgestattet.
Das bedeutet es ist ungeschützt und lässt sich durch Dritte mit Merlin
Project öffnen und bearbeiten.

Zum Aktivieren des Kennwortschutzes wird mindestens eine Ressource im Projekt
vorausgesetzt:

1. Erstellen Sie eine Ressource falls noch nicht vorhanden

2. Im Inspektor für die Ressource, setzen Sie das Häkchen bei der Option Ist
Benutzer

3. Klicken Sie auf die Schaltfläche Kennwort setzen…

4. Erstellen Sie ein Kennwort

5. Deaktivieren Sie den Gastzugriff, damit keine Unbefugten mehr auf das
Projekt zugreifen können.
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
Das Kennwort kann nicht nachträglich zurückgestellt werden, das
bedeutet Sie sollten es sich gut einprägen.

Rechtevergabe

Für alle Ressourcen im Projekt besteht zudem die Möglichkeit die Zugriffsrechte
einzustellen.

Die Zugriffsrechte gelten für das Projekt beim öffnen in Merlin Project und über Merlin
Server.

Die Zugriffsrechte gelten nicht nur für die Anmeldung, sondern auch für den Zugriff des
jeweiligen Benutzers auf das jeweilige Projekt.

Klicken Sie auf das Dreieck zum Aufklappen der Auswahl für die einzelnen Optionen zur
Rechtevergabe.

Bestimmen Sie die Zugriffsrechte für die selektierte Ressource nach Bedarf.


Beachten Sie, dass mindestens einer Ressource im Projekt alle Rechte
zur Verfügung stehen müssen.

Steuern Sie mit den Zugriffsrechen beispielsweise ob eine Ressource nur die ihr im
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Projekt zugewiesenen Vorgänge sehen und bearbeiten kann.

Anmeldung

Die geschützten Projektdateien lassen sich ab jetzt nur mit dem Benutzernamen
(Ressource) und dem Kennwort öffnen.

Merlin Project

Beim Öffnen einer geschützten Projektdatei in Merlin Project erscheint ein
Anmeldefenster.

Wählen Sie bei mehreren Benutzern den Namen aus dem Klappmenü aus. Tragen Sie
anschließend das zum Benutzer passende Kenntwort ein.

Setzen Sie optional das Häkchen bei Kennwort im Schlüsselbund sichern, dadurch wird
das Kennwort für Ihren Benutzer im Schlüsselbund gesichert. Beim nächsten Aufrufen
der Projektdatei wird automatisch das Kennwort aus dem Schlüsselbund in das
Kennwortfeld eingetragen.

Klicken Sie anschließend auf Öffnen.

Merlin Project auf dem iOS

Beim Öffnen einer geschützten Projektdatei in der iOS app erscheint die
Authentifizierung.

Wählen Sie bei mehreren Benutzern den Namen aus. Tragen Sie anschließend das zum
Benutzer passende Kenntwort ein.
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Tippen Sie optional Kennwort im Schlüsselbund sichern an, dadurch wird das
Kennwort für Ihren Benutzer im Schlüsselbund gesichert. Beim nächsten Aufrufen der
Projektdatei wird automatisch das Kennwort aus dem Schlüsselbund in das
Kennwortfeld eingetragen.

Tippen Sie anschließend auf Öffnen.

Merlin Server

In Merlin Server sind geschützte Projektdateien an einem Vorhängeschloss erkennbar.
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Wird eine geschützte Projektdatei mit Merlin Project geöffnet, erscheint das
Anmeldefenster.

Wird eine geschützte Projektdatei mit einem Webbrowser geöffnet, erscheint sie in der
Projektliste mit einem Vorhängeschloss.

Klicken Sie auf Öffnen, anschließend erscheint die Anmeldung.
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Wählen Sie bei mehreren Benutzern den Namen aus. Tragen Sie das zum Benutzer
passende Kenntwort ein.

In Safari klicken Sie auf den Schlüssel, dadurch erscheint ein Kontextmenü in dem Sie
das Kennwort im Schlüsselbund sichern können. Beim nächsten Aufrufen der
Projektdatei wird automatisch das Kennwort aus dem Schlüsselbund in das
Kennwortfeld eingetragen.

Klicken Sie anschließend auf Anmelden.

Sichtbarkeit

Die in Merlin Server vorhandenen Projekte werden bei der Anmeldung in einer Liste
dargestellt, sowohl in Merlin Project als auch einem beliebigen Webbrowser.

Die Projekte können vor Unbefugten unsichtbar gemacht werden. Nur wer ein Benutzer
ist und ein passendes Kennwort hat, kann sich anmelden und die Liste der unsichtbaren
Projektdateien einsehen.

 Standardmäßig sind alle Projekte für alle sichtbar.
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In Einstellungen → Allgemein, stellen Sie bei der Option Sichtbarkeit die Funktion Für
alle auf Für angemeldete Benutzer.

Damit wird das Projekt nur noch sichtbar sein, wenn ein im Projekt angelegter Benutzer
sich mit dem dazugehörigen Kennwort in Merlin Server oder Merlin Project anmeldet.

Webbrowser Anmeldung
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• Klicken Sie auf die Schaltfläche Anmeldung

• Melden Sie sich mit dem Benutzernamen und Kennwort an

• Nun sehen Sie alle Projekte in denen Sie als Benutzer angelegt sind

Zugriffsrechte | Merlin Project-Handbuch 251



Veröffentlichen

Mit der Funktion »Veröffentlichen« konfigurieren Sie Aktionen, mit denen Sie
Projektinhalte regelmäßig für andere Nutzer zur Verfügung stellen.

So konfigurieren Sie Ihre Aktionen zum Veröffentlichen:

• Öffnen Sie das Menü Ablage → Veröffentlichen → Einstellungen…

• Klicken Sie auf eine der drei zur Verfügung stehenden
Veröffentlichungsoptionen oder auf das + Symbol.

Es stehen drei Veröffentlichungsoptionen zur Auswahl:

• Kalender

• Export

• Erinnerungen


Um in Kalender und Erinnerungen veröffentlichen zu können, müssen
Sie den Zugriff für Merlin Project zu diesen Anwendungen in den
macOS-Systemeinstellungen erlauben.
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Öffnen Sie in macOS die Systemeinstellungen > Sicherheit > Privatsphäre. Wählen Sie
die Kalender app, setzen ein Häkchen bei Merlin Project und wiederholen Sie diesen
Schritt für die Erinnerungen app.
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Kalender

Mit der Option Kalender stellen Sie Inhalte aus Ihrem Projekt lokal der Kalender.app in
macOS zur Verfügung.

• Klicken Sie auf Kalender oder auf + zum Erstellen einer neuen
Veröffentlichung.

• Geben Sie einen Namen für die Kalenderveröffentlichungsaktion ein.

• Bestimmen Sie, welche Informationen veröffentlicht werden sollen und in der
Kalender App erscheinen sollen.
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• Vorgänge veröffentlichen

• Zuweisungen veröffentlichen

• Ereignisse veröffentlichen

Wählen Sie die gewünschten Optionen.

Klicken Sie auf die Lupen zum Einstellen der Veröffentlichungsoptionen für die Vorgänge,
Zuweisungen und Ereignisse im Kalender.

Bei der ersten Lupe weisen Sie die Merlin Project Informationen den Kalenderfeldern zu.
Die Kalenderfelder sind von der Kalender.app in macOS vorgegeben, und lassen sich
nicht ändern.
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Die zweite Lupe bietet Ihnen diverse Bedingungen für die Veröffentlichung. Dadurch
können Sie die Informationen, die Sie im Kalender veröffentlichen, filtern.

Sie können jederzeit und für jede Ihrer Kalenderveröffentlichungen die oben genannten
Optionen auch nachträglich anpassen.

Im letzten Schritt wählen Sie bei der Option In Kalender einen vorhandenen Kalender aus
der Kalender.app oder erstellen einen neuen Kalender.


Dieser Vorgang lässt sich nicht mehr Rückgängig machen!!! Wird ein
Kalender ausgewählt, der in der Kalender.app bereits existiert, führt die
Veröffentlichung zur Löschung der vorhandenen Kalendereinträge.


Es ist empfehlenswert, einen neuen Kalender für die Veröffentlichung zu

erstellen. Wählen Sie hierzu die Option Neuen Kalender erstellen … im
Klappmenü aus.
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Export

Mit der Option Export geben Sie Inhalte aus Ihrem Projekt mithilfe des eingebauten
Exporters frei.

Klicken Sie auf Export oder auf das + zum Erstellen einer neuen Veröffentlichung.

Konfigurieren Sie den Export. Es stehen folgende Optionen zur Verfügung:

• Name

• Exporter (muss ausgewählt werden)

• Account

• Dateiname

• Verzeichnis

Name

Tragen Sie einen Namen für die Aktion ein.

Exporter

Klicken Sie auf Auswählen … . Wählen Sie im Fenster Export ein Veröffentlichungsformat
aus und konfigurieren Sie es nach Bedarf.
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Account

Die Option Account ist standardmäßig auf Lokale Datei gestellt. Das bedeutet, die
Exportveröffentlichung erfolgt in einem Verzeichnis lokal auf Ihrem Mac.

Veröffentlichte Inhalte automatisch hochladen oder per E-Mail versenden

Wenn Sie FTP-, WebDAV- / SMTP-Account in Einstellungen - Accounts definiert haben,
können Sie hier ein Account auswählen, falls Sie den exportierten Inhalt automatisch auf
einen FTP- oder WebDav-Server hochladen oder als E-Mail versenden möchten.
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Wählen Sie Accounts verwalten…, um bei Bedarf neue Accounts einzufügen.

Dateiname

Tragen Sie den Namen der Export-Datei ein.

Verzeichnis

Bestimmen Sie den Ordner, in dem Sie die Datei speichern möchten. Klicken Sie auf
Wählen … und wählen Sie einen Ordner auf Ihrem Mac.


Wählen Sie Accounts verwalten aus, oder erstellen Sie neue
Accounts, falls die Veröffentlichung nicht auf dem lokalen Rechner
stattfinden soll.

Export via Merlin Server Veröffentlichung-Accounts

Haben Sie eine Merlin-Server-Installation und bearbeiten von dort aus derzeit ein
abonniertes Projekt?

In diesem Fall können Sie auch ein Veröffentlichung-Accounts von diesem Merlin-Server
für Ihre Veröffentlichungsaktion auswählen.
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Erinnerungen

Mit der Option Erinnerungen stellen Sie Inhalte aus Ihrem Projekt der in macOS

mitgelieferten Erinnerungen.app zur Verfügung.

• Klicken Sie auf Erinnerungen oder auf + zum Erstellen einer neuen
Veröffentlichung.

• Geben Sie einen Namen für die Veröffentlichungsaktion ein.

• Bestimmen Sie, welche Informationen veröffentlicht werden sollen und in der App
Erinnerungen auftauchen sollen.

• Vorgänge veröffentlichen

• Zuweisungen veröffentlichen
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Wählen Sie die gewünschten Optionen.

Klicken Sie auf die Lupen zum Einstellen der Veröffentlichungsoptionen für die
Vorgänge und Zuweisungen in Erinnerungen.

Bei der ersten Lupe weisen Sie die Merlin Project Informationen den Kalenderfeldern zu.


Kalenderfelder sind von der Erinnerungen.app in macOS vorgegeben,
und lassen sich nicht ändern.

Die zweite Lupe bietet Ihnen diverse Bedingungen für die Veröffentlichung. Dadurch
können Sie die Informationen, die Sie im Erinnerungen veröffentlichen, filtern.

Sie können jederzeit und für jede Ihrer Veröffentlichungen, die oben genannten Optionen
auch nachträglich anpassen.

Im letzten Schritt wählen Sie bei der Option In Erinnerungen-Liste, ein vorhandene
Erinnerungen-Liste aus der Erinnerungen.app oder erstellen eine neue Erinnerungen-
Liste.
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

Dieser Vorgang lässt sich nicht mehr Rückgängig machen!!! Wird eine
Erinnerung ausgewählt, die bereits existiert, führt die Veröffentlichung
zur Löschung der vorhandenen Erinnerungen. Daher ist es
empfehlenswert eine neue Erinnerungen-Liste für die Veröffentlichung

zu erstellen. Wählen Sie hierzu die Option Neue Erinnerungen-Liste
erstellen … aus dem Klappmenü.

Veröffentlichung Register

Am Register Veröffentlichung können Sie Ihre Aktion weiter konfigurieren, dass Sie:

• immer beim Sichern veröffentlicht

• regelmäßig am Tag und Uhrzeit aufgerufen wird.

Setzen Sie das Häkchen bei der Option Veröffentlichen: Immer beim Sichern. Dies
führt zur automatischen Aktualisierung der veröffentlichten Inhalte bei jeder Sicherung.

Oder Sie wählen die Tage und Uhrzeiten aus, an denen Ihre Veröffentlichungsaktion
automatisch und regelmäßig aktiviert werden soll.

Dieser Dialog informiert Sie über die letzten Veröffentlichungszeitpunkte und darüber, ob
ein Fehler aufgetreten ist.


Testen Sie mindestens einmal das Veröffentlichen, um sicherzustellen,
dass Ihre Aktion korrekt eingestellt ist und wie gewünscht funktioniert.

Veröffentlichen

Für die manuelle Aktualisierung der Inhalte, klicken Sie auf die Schaltfläche
Veröffentlichen oder verwenden Sie das Menü Ablage → Veröffentlichen →
Veröffentlichen.


Bei der Verwendung des Menüs Ablage → Veröffentlichen →
Veröffentlichen werden alle eingerichteten Veröffentlichungen
ausgeführt.
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Berichte

Berichte helfen Inhalte und Informationen aus dem Projekt besser zu überblicken und
eignen sich für die Weitergabe an beteiligte Personen.

In der Ansicht Bericht in Merlin Project befinden sich bereits diverse vorinstallierte
Berichte.

Bestehende Berichte lassen sich direkt verwenden oder an die eigenen Bedürfnisse
anpassen.

Jeder Bericht verwendet sogenannte Module, aus denen die Inhalte aus den
unterschiedlichen Ansichten im Projekt im Bericht zusammengestellt sind.

Berichtsmodule

Die Module lassen sich im Bericht mithilfe der Maus anklicken und im Inspektor
anpassen.

Mit einem Klick auf Plus erstellt man neue Module.
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Folgende Modultypen lassen sich für einen Bericht verwenden:

• Balkendiagramm

• Budget-Kosten-Diagramm

• Projektansicht

• Text

• Zeitphasen-Diagramm

• Zeitphasen-Liste

Am häufigsten wird das Modul Projektansicht eingesetzt. Spalten und die Gantt-
Optionen einer Projektansicht lassen sich direkt in dem Modul anpassen und steuern.

Verwenden Sie die Option Filter und Filtermodus im Inspektor um die Anzeige von
Informationen im Modul zu filtern.

Verwenden Sie die Option Gruppierung und Gruppierungsmodus im Inspektor um die
Anzeige von Informationen im Modul zu gruppieren.

Je nach Typ des ausgewählten Berichtsmoduls bietet der Inspektor unterschiedliche
Optionen zur Auswahl.

Das Budget-Kosten-Diagramm bietet Budgetspalten für das Diagramm und somit ist
es hilfreich für die Erstellung von Berichten mit Kosteninformationen.
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Die Zeitphasen-Liste hingegen benötigt Werte für Abtastdauer und die Felder.

Gleiches gilt für das Zeitphasen-Diagramm:

Klicken Sie auf Plus, wird ein neues Feld erstellt. In der Spalte Typ bestimmen Sie die
Darstellungsart im Diagramm. Mit dem Häkchen Kumuliert lassen sich die Werte aus den
Feldern im Diagramm kumuliert anzeigen.
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Eigene Berichtansicht erstellen

Eine eigene Berichtansicht lässt sich wie folgt erstellen:

Klicken Sie auf eine Berichtansicht und wählen die Option Bearbeiten.

Benennen Sie die neue Berichtansicht und klicken auf Aktivieren.

Nun fahren Sie fort indem Sie die neu erstellte Berichtansicht mit Modulen aufbauen.
Klicken Sie auf das Plus zum Hinzufügen von neuen Modulen.
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Beispiele

Spalten in Berichtansicht »Status« einfügen und entfernen

Zum Aktivieren und Deaktivieren von Spalten im Berichtsmodul Projektansicht, müssen
Sie zunächst die eigentliche Instanz der Projektansicht festlegen.

Im Bericht → Status sind in den Modulen mehrere Projektansichten dargestellt. Im

Inspektor lassen sich die Ansichten für das Modul über die Klappmenüs Typ und Ansicht
auswählen. Im dargestellten Beispiel ist das Modul Leicht hinter Plan ausgewählt. Es
verwendet die Ansicht Strukturplan → Status kompakt. Diese Ansicht wird mit dem

Filtern gesteuert.

Auf diese Weise lassen sich individuelle Module mit der Option Filter für Vorgänge, die
beispielsweise im oder hinter Zeitplan sind, einbinden.

Zum Einfügen einer weiteren Spalte im Modul, wechseln Sie zunächst in die Ansicht, auf
die das Modul zurückgreift. (in diesem Beispiel Strukturplan > Status kompakt)

Fügen Sie die gewünschte Spalte ein, indem Sie einem Mausklick auf den Pfeil in einer
beliebigen Spalte ausführen und anschließend die Option Neue Spalte auswählen.
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

Sie können das Format der Spalte entweder in der ursprünglichen
Projektansicht oder im Berichtsmodul anpassen. Wenn Sie die
Änderung für alle Berichtsmodule mit dieser Ansicht anwenden
möchten, sollten Sie die Änderung des Formats in der ursprünglichen
Projektansicht vornehmen.

Zum Entfernen der Spalte verwendem Sie die Löschtaste-Taste oder klicken Sie in den
Spaltenkopf und wählen die Option Ausblenden aus.

Die oben aufgeführten Schritte führen zu der folgenden Spaltenkombination in der
Ansicht Status Kompakt:
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Wenn Sie nun zur Ansicht Bericht > Status zurückkehren, erscheinen die geänderten
Spalten aus der Ansicht in den Berichtsmodulen.
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Ändern der Abtastdauer in der »Leistungswert« Berichtansicht

Wechseln Sie in die Berichtansicht Bericht > Leistungswert.

Klicken Sie auf das Modul mit dem Diagramm Leistungswert.

Geben Sie die gewünschte Abtastdauer im Inspektor für das Zeitphasen-Diagramm ein,
beispielsweise 1 fTag.


Sie können Tage, Wochen, Quartale und Jahre verwenden. Oder
fTage, fWochen, fQuartale und fJahre.

Die Genaugkeit des Graphen erhöht sich, da die Werte pro fortlaufenden Tag berechnet
sind.
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
Wählen Sie eine lange Abtastdauer, werden die Informationen im
Graphen linear dargestellt.
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Arbeitskosten pro Ressource in einem Diagramm und einer Tabelle darstellen

In Merlin Project können Sie vorhandene Berichtansichten anpassen und als neue
Ansichten mit eigenen Berichtmodulen sichern. In diesem Beispiel wechseln Sie zum
Bericht → Budget/Kosten-Überblick.

Klicken Sie im Menü Darstellung auf Berichte > Bearbeiten.

Wählen Sie die Ansicht Budget/Kosten-Überblick, klicken Sie auf Plus zum Duplizieren
der Ansicht.

Benennen Sie den eigenen Bericht und klicken Sie auf Aktivieren.

Löschen Sie das Budget-Diagramm und fügen das Modul Balkendiagramm ein.
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Bearbeiten Sie den Titel (bsp. Arbeit). Aktivieren Sie den Filter mit einem Mausklick auf die
Lupe. Stellen Sie die Filtereinstellung für alle Ressourcen, außer der Standard-
Ressource ein.

Fügen Sie das Berichtsmodul Projektansicht hinzu.

Setzen Sie Typ auf Ressource und Ansicht auf Kosten. Aktivieren Sie den Filter für

Echte Ressourcen. Stellen Sie die Gruppierung auf Rolle.
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Das Ergebnis zeigt Ihnen alle Kosten der Ressourcen gefiltert nach Echten Ressourcen
und gruppiert nach Rolle.

Berichtansicht mit anderen lokalen Dokumenten teilen

Gehen Sie im Menü Darstellung auf Berichte → Bearbeiten.

Wählen Sie eine gewünschte Berichtansicht aus.

Klicken Sie auf das Zahnradsymbol und anschließend auf Mit anderen lokalen
Projekten teilen.
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Leistungswert

Die Leistungswertanalyse hängt mit dem aktuellen Statusdatum zusammen.

Um einen besseren Überblick über die Berechnungen zu haben:

1. Schalten Sie bitte zuerst die Zeitlinie im Gantt ein. Sie zeigt das Statusdatum des
Projekts.

2. Wird die Linie nicht auf das heutige Datum angezeigt? Überprüfen Sie das
eingestellte Projekt Statusdatum: Einstellungen > Allgemein > Statusdatum

Ist es auf ein anderes Datum eingestellt?

• Belassen Sie dieses, falls Sie es explizit gesetzt haben.

• Stellen Sie es auf automatisch, um das heutige Datum verwenden zu können.

So werden die Werte berechnet

SKBA entspricht den geplanten Kosten bis zum aktuellen Statusdatum im Projekt

IKAA entspricht den aktuellen Kosten bis zum aktuellen Statusdatum im Projkekt

SKAA zeigt an, wie hoch waren die ursprünglich geplanten Kosten bis zur aktuellen
Erledigung. Merlin benutzt die aktuelle Erledigung und verwendet die geplanten Werte
(graue Balken), um die Kosten zu berechnen, mit dem Ausblick was wäre wenn die
geplanten Balken bereits erledigt wären.

Die Planabweichung berechnet sich aus: SKAA - SKBA

Kostenabweichung berechnet sich aus: SKAA - IKAA

Kostenleistungsindex (KLI) berechnet sich aus: SKAA / IKAA

Schätzung Gesamtkosten berechnet sich aus: IKAA + ((Geplante Kosten - SKAA) /
KLI)

Abweichung nach Abschluss berechnet sich aus: Geplante Kosten - Schätzung
Gesamtkosten


Alle Leistungswert-Felder beinhalten nur Werte bis zum aktuellen
Statusdatum im Projekt!
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Projekte zusammenfassen

Wenn Sie Gesamtberichte über Ihre verschiedenen Projekte erstellen, Überlastungen
aufgrund von Gesamtzuweisungen für Ihre Ressourcen anzeigen oder lösen möchten oder
einfach mit Ihren mehreren Projektdateien in einem Gantt-Diagramm, Kanban-Tafel,
[Mindmap] usw. arbeiten möchten, müssen Sie diese in einer einzigen Datei (Master-Datei)
zusammenfassen.

Sie können in Merlin Project Ihre Projektdateien per Drag & Drop oder über die Menüs
kombinieren.

Projekte per Drag & Drop zusammenfassen

Der schnellste Weg, ein Projekt mit mindestens zwei Unterprojekten zu erstellen, ist

• Erstellen Sie ein neues leeres Projekt

• Benennen Sie das Projekt so, dass Sie es leicht identifizieren können (z.B.
Masterprojekt)

• Ziehen Sie mindestens zwei Projektdateien aus einem Finder-Fenster in die
Gliederung des neuen Masterprojekts.

• Das Programm wird Ihnen folgende Optionen zeigen:

• Abbrechen
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• Anhängen

• Unterprojekt erzeugen

• Inhalt kopieren

1. Wählen Sie abhängig von Ihren Bedürfnissen Unterprojekt erzeugen
oder Inhalt kopieren.

Typischer Anwendungsfall von zusammengefassten Projekten

Wählen Sie Unterprojekt erzeugen, um die einzelnen Dateien als Unterprojekt zu
verknüpfen und zum Masterprojekt zusammenzufassen.

Mit dieser Option können Sie die Inhalte im Master oder in den einzelnen Unterprojekten
bearbeiten. Die Änderungen werden nach dem Speichern in beide Richtungen synchron
gehalten. Dies ist gleichbedeutend mit dem Zusammenfassen über den Menüpunkt
Dokumente zusammenfassen.

Alternativer Anwendungsfall

Wählen Sie Inhalt kopieren, um den Inhalt aus den einzelnen Projektdateien in das
Masterprojekt zu kopieren. Dadurch werden die einzelnen Dateien nicht als Unterprojekte
verknüpft und sie bleiben separat. Änderungen am Masterprojekt werden also nicht auf
die einzelnen Projekte übertragen oder umgekehrt.

Verwenden Sie diese Option:

• wenn Sie Ihre Arbeit nicht mehr in mehreren Dateien organisieren müssen

• oder eine Momentaufnahme des aktuellen Zustands Ihrer einzelnen Dateien in
das Masterprojekt benötigen und vielleicht beabsichtigen, zu späteren
Zeitpunkten neue Masterprojekte als weitere Momentaufnahmen zu erstellen, um
Ihre Gesamtfortschritt mit früheren Werten vergleichen zu können.

Andere Optionen des Dialogs

Wählen Sie Abbrechen, um weitere Aktionen abzubrechen.

Wählen Sie Anhängen, um die Dateien als Datei Anhänge in die Zeile #0 des leeren
Projekts einzufügen. Diese Option führt nicht zum Zusammenfassen des Inhalts der
einzelnen Dateien in einer Gantt-, Kanban-, Mind Map usw.

Dokumente zusammenfassen Menüpunkt

In Merlin Project können Sie auch einzelne Projekte über einen Menüpunkt
zusammenfassen und verknüpfen.

• Rufen Sie Ablage > Dokumente zusammenfassen…

• Klicken Sie auf '+'
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• Wählen Sie Ihre einzelnen Dateien aus

• Klicken Sie auf 'Ok'

Falls die Dateien, die Sie zusammenfassen möchten, derzeit in Merlin Project geöffnet
sind, werden sie im Menü '+' des Dialogs Dokumente zusammenfassen… aufgelistet, damit
Sie sie leicht auswählen können.
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Projekte einfügen

Sie können ein Projekt einfügen und es als Unterprojekt in einer bestehenden Projektdatei
verknüpfen, indem Sie auf das '+'-Symbol in der Symbolleiste klicken und 'Projekt…'
auswählen.

Die gleiche Option wird über das Menü Einfügen angeboten.
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Dies wird empfohlen, wenn Sie ein bestehendes Masterprojekt haben, in das Sie weitere
Projektdateien einfügen und im gleichen Master verwalten möchten.
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Arbeitsbereiche

Mit dem Arbeitsbereich können Sie unabhängig und getrennt von den anderen Benutzern
an gemeinsamen Projekten arbeiten.

Klicken Sie auf das Arbeitsbereich Symbol in der Symbolleiste, um auf diese Funktion
zuzugreifen.

Sie können Ressourcen als Benutzer anlegen oder die Arbeitsbereiche ohne Benutzer
verwenden.

Sie können zwischen folgenden Arbeitsbereichen wechseln:

• Öffentlicher Arbeitsbereich (standarmäßig aktiviert)

• Privater Arbeitsbereich

Der aktive Arbeitsbereich erscheint im Symbol abgebildet und im Dialog stärker eingefärbt.

Öffentlicher Arbeitsbereich

Alle Änderungen werden standardmäßig im öffentlichen Arbeitsbereich vorgenommen und
sind daher für alle Benutzer und alle Geräte, die auf das Projekt zugreifen, sichtbar. Wenn
die Weltkugel und der Text Öffentlicher Arbeitsbereich schattiert sind, ist der öffentliche
Arbeitsbereich der aktive Arbeitsbereich.
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Privater Arbeitsbereich

Klicken Sie auf das Vorhängeschloss in den privaten Arbeitsbereich zu wechseln.

Das Vorhängeschloss-Symbol in der Symbolleiste zeigt an, dass Sie im privaten
Arbeitsbereich arbeiten.

Während Sie Änderungen in Ihrem privaten Arbeitsbereich vornehmen, bietet der Dialog
mehr Informationen und Optionen.
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Sie sehen

• Die Anzahl der von anderen im öffentlichen Arbeitsbereich vorgenommenen
Änderungen.

• Die Schaltfläche Integrieren zum Integrieren in Ihren aktuellen privaten
Arbeitsbereich Änderungen, die von anderen im öffentlichen Arbeitsbereich
vorgenommen wurden.

• Die Anzahl der Änderungen, die Sie seit Ihrem Wechsel in den privaten
Arbeitsbereich vorgenommen haben.

• Die Schaltfläche Veröffentlichen, um Ihre privaten Änderungen zu übertragen
und für alle anderen Benutzer, die auf das Projekt im öffentlichen Arbeitsbereich
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zugreifen, sichtbar zu machen.

• Das Papierkorb-Symbol, um die im privaten Arbeitsbereich vorgenommenen
Änderungen zu löschen. Auf diese Weise setzen Sie Ihren privaten Arbeitsbereich
zurück.

Klicken Sie auf den Globus oder den Text Öffentlicher Arbeitsbereich, um zum
öffentlichen Arbeitsbereich zurückzukehren.


Beim Wechsel vom privaten in den öffentlichen Arbeitsbereich oder
umgekehrt werden Änderungen aus den verschiedenen
Arbeitsbereichen nicht automatisch integriert oder veröffentlicht.
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Zentrale Lizenzverwaltung

Die Zentrales Lizenzmanagement Optionen sind nur verfügbar, wenn Sie Merlin Project
von unserer Website heruntergeladen haben.

Abonnement erweitern


Diese Option ist nur verfügbar, wenn Sie Merlin Project von unserer
Website heruntergeladen haben.

Um die Anzahl der Benutzer in einem Abonnement für Einzelbenutzer zu erweitern, rufen

Sie aus dem Menü Merlin Project → Abonnement auf, klicken auf Bestehendes
Abonnement verwalten und anschliessend auf Abonnement erweitern.

Im darauffolgenden Dialog tragen Sie die von Ihnen gewünschte Anzahl weiterer Benutzer
ein.

Zentrale Lizenzverwaltung | Merlin Project-Handbuch 285



286 Zentrale Lizenzverwaltung



Teamgerät freischalten


Diese Option ist nur verfügbar, wenn Sie Merlin Project von unserer
Website heruntergeladen haben.

Bei Abonnements mit mehr als einer Benutzerlizenz ([Mehrere Benutzer in einem Abo])

rufen Sie aus dem Menü Merlin Project → Abonnement auf und klicken auf Teamgerät
freischalten .

Geben Sie einen gültigen Lizenzcode für dieses Team-Gerät ein, das Sie verwenden
möchten.



Sie können diese Option auch verwenden, wenn Sie Ihr Abonnement auf
einem anderen macOS-Gerät aktivieren möchten, ohne Ihre E-Mail- und
Passwort-Anmeldeinformationen einzugeben, wenn Sie Ihre
Lizenznummer kennen.

Wenn Sie ein Abonnement mit mehreren Benutzern verwalten, lesen Sie hier, wie Sie einen
Lizenzcode für Ihre Teammitglieder bereitstellen können.
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Gerät abmelden


Diese Option ist nur verfügbar, wenn Sie Merlin Project von unserer
Website heruntergeladen haben.

Um einen bestimmten Mac aus einem bestehenden Abonnement zu deaktivieren, gehen

Sie zu Merlin Project → Abonnement .

Drücken und halten Sie die Alt-Taste. Die Schaltfläche Bestehendes Abonnement
verwalten ändert sich in Gerät abmelden. Klicken Sie dann auf Gerät abmelden.


Diese Option kündigt das Abonnement nicht, sie gibt nur ein Gerät frei,
auf dem das Abonnement aktiviert war.
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Dieses Gerät freischalten


Diese Option ist nur verfügbar, wenn Sie Merlin Project von unserer
Website heruntergeladen haben.

Haben Sie eine Einzelplatzlizenz auf einem Gerät und müssen diese auf einem zweiten

Mac nutzen? Öffnen Sie Merlin Project auf dem zweiten Mac und rufen Sie Merlin Project
→ Abonnement auf. Klicken Sie auf Bestehendes Abonnement verwalten. Geben Sie die
E-Mail und das Passwort für Ihr Abonnement ein und klicken Sie auf Weiter … Klicken Sie
nun auf Dieses Gerät freischalten .


Nutzen Sie Dieses Gerät freischalten, falls Sie versehentlich die Option
Gerät abmelden geklickt haben.

Zahlungsdaten


Diese Option ist nur verfügbar, wenn Sie Merlin Project von unserer
Website heruntergeladen haben.

Ihre Zahlungsinformationen wurden für die wiederkehrende Zahlung zum Zeitpunkt des
Abonnements gespeichert. Um diese Informationen zu aktualisieren, z. B. wenn Ihre

Kreditkarte in der Zwischenzeit abgelaufen ist, gehen Sie zum Bedienfeld Merlin Project
→ Abonnement.

• Klicken Sie auf Bestehendes Abonnement verwalten

• und im folgenden Fenster auf Zahlungsdaten

• Geben Sie die Zugangsdaten ein, die Sie beim Abonnieren der App festgelegt

Zentrale Lizenzverwaltung | Merlin Project-Handbuch 289



haben

Sie werden zu unserem Abrechnungspartner Paddle weitergeleitet, wo Sie Ihre
Kreditkartendaten für die nächste Zahlung eingeben können.

Wenn Sie Ihre Änderungen abgeschlossen haben, bestätigt Paddle die erfolgreiche
Aktualisierung Ihrer Zahlungsdaten.
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Mehrere Benutzer in einem Abonnement


Diese Option ist nur verfügbar, wenn Sie Merlin Project von unserer
Website heruntergeladen haben.

Bei mehr als einem Benutzer in Ihrem Abo, melden Sie sich an für die Verwaltung Ihres
Abonnements.

In der Liste befinden sich alle bisher erworbenen Lizenzen. Die Informationen zu den
einzelnen Lizenzen sind in den folgenden Spalten sortiert:

• Lizenzcode

• Name

• E-Mail

• Status

• Geräte

• Für dieses Gerät freigeschaltet

Name und E-Mail sind optionale Angaben für eine bessere Zuweisung des jeweiligen
Lizenzcodes zu einem Benutzer.

Status zeigt an, ob die Lizenz aktiv und somit einsatzbereit ist.

Geräte zeigt an, die Anzahl der Geräte wo die Lizenz aktiviert wurde.

Für dieses Gerät freigeschaltet zeigt mit einem Häkchen an, dass die Lizenz für diesen
Mac aktiv ist.
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Weitere Lizenzen für das Abo kaufen


Diese Option ist nur verfügbar, wenn Sie Merlin Project von unserer
Website heruntergeladen haben.

In der unteren linken Ecke befindet sich das '+'-Symbol, damit kaufen Sie weitere Lizenzen
für das Abonnement ein.

Im darauffolgenden Dialog tragen Sie die von Ihnen gewünschte Anzahl der Lizenzen für
weitere Benutzer ein.

Weitere Optionen

In der unteren rechten Ecke, befinden sich zwei weitere Symbole:

• Senden an (um bestehende Lizenzen an Ihre Benutzer weiterzuleiten)

• (…) (für Erweiterte Optionen)
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Abolizenzen versenden

Um Lizenzcodes an Ihre Benutzer weiterzuleiten, klicken Sie die Senden an Optionen:

Wählen Sie einen oder mehrere Lizenzcodes aus der Liste aus. Klicken Sie anschließend
auf das Symbol Senden an und wählen eine der zur Auswahl stehenden Optionen aus
dem Klappmenü aus:

• Mail

• Nachrichten

• Notizen

• Erinnerungen

Mit Mail oder Nachrichten erhalten die Empfänger einen Lizenzcode zum Freischalten
Ihres Macs als Teamgerät. Siehe Abschnitt Teamgerät freischalten.

Mit Notizen lassen sich alle Informationen der gewählten Lizenzen an die Notizen.app
senden.

Erweiterte Optionen

Für Erweiterte Optionen zu Ihren Mehrbenutzer-Abonnements verwenden Sie das Symbol
(…).
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Wählen Sie zunächst eine oder mehrere Lizenzen aus der Liste aus. Klicken Sie auf das
Symbol (…) und wählen Sie eine der angebotenen Optionen:

• Kopieren

• n Lizenzcodes zurücksetzen …

• Abonnement für n Benutzer kündigen …

• Abmelden

Die Option Kopieren kopiert die Informationen für die gewählten Lizenzcodes in den
Zwischenspeicher für die weitere Nutzung.

Die Option n Lizenzcodes zurücksetzen setzt die ausgewählten Lizenzcodes zurück.
Nutzen Sie diese Option, um eine Lizenz wieder freizuschalten, wenn ein Benutzer die
Firma verlässt. Sie können anschliessend den neuen Lizenzcode einem anderen
Mitarbeiter versenden.

Die Option Abonnement für n Benutzer kündigen kündigt die ausgewählten
Lizenzcodes für die Benutzer.

Wenn Sie ein anderes Abonnement-Konto verwalten möchten, wählen Sie Abmelden und
melden Sie sich erneut.

Appendix …
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Infospalte

Symbole in der Infospalte

Die Spalte Info beinhaltet unterschiedliche Symbole.

Diese Symbole resultieren aus unterschiedlichen, bereits vom Benutzer im Projekt
getroffenen Eingaben.

Symbol Name Bedeutung Anmerkung

Projekt Die Zeile #0 ist die
Projektzeile und wird
grundsätzlich mit diesem
Symbol versehen.

Bei zusammengefassten
Projekten werden die
Unterprojekte mit diesem
Symbol gekennzeichnet.

Anhang Dieses Symbol zeigt
Ihnen an, dass an einem
Vorgang ein oder
mehrere Anhänge
vorhanden sind. 

Anhänge sind auch an
Gruppen, Meilensteinen
und Zuweisungen
möglich.

Ausrichtung »Früh« Ein Vorgang, eine Gruppe
oder ein Meilenstein ist
mit einer frühen Start-
Ausrichtung versehen.

Dieses Symbol ist nur bei
rückwärts geplanten
Projekten sichtbar. Bei
einem vorwärts geplanten
Projekt sind alle
Vorgänge, Gruppen und
Meilensteine automatisch
mit einem frühen Start
versehen.

Ausrichtung »Spät« Wird im vorwärts
geplanten Projekt ein
Vorgang, eine Gruppe
oder ein Meilenstein, mit
einer späten Start-
Ausrichtung versehen,
erscheint dieses Symbol.
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Symbol Name Bedeutung Anmerkung

Auslassungspunkte Dieses Symbol zeigt an,
dass mehrere
Informationen in der
Infospalte existieren, aber
nicht alle sichtbar sind.

Ändern Sie die Breite der
Spalte, damit alle
Symbole erscheinen.

Kalender Dieses Symbol zeigt an,
dass der Vorgang über
einen festgelegten
Kalender verfügt.

Im Inspektor des
Vorgangs findet man
unter »Fortgeschritten«
die Option für den
Kalender.

Datum Dieses Symbol zeigt an,
dass der Vorgang über
ein festgelegtes Datum
verfügt.

Im Inspektor muss ein
genaues Datum für den
Start oder Ende des
Vorgangs eingetragen
sein.

Notiz Dieses Symbol bedeutet,
dass eine Notiz
vorhanden ist.

Klicken Sie auf das
Symbol, es öffnet sich
das Register für Notizen
im Inspektor.

Ressourcenpool Dieses Symbol bedeutet,
dass die Ressource aus
einem Ressourcenpool
stammt.

Kommentare Dieses Symbol zeigt
Ihnen an, dass ein oder
mehrere Kommentare
vorhanden sind.

Klicken Sie auf das
Symbol, es öffnet sich
das Register für
Kommentare im
Inspektor.

Ungelesene
Kommentare

Dieses Symbol zeigt
Ihnen an, dass ein oder
mehrere ungelesene
Kommentare vorhanden
sind.

Klicken Sie auf das
Symbol, es öffnet sich
das Register für
Kommentare im
Inspektor.
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Planungskonflikte

Treten bei der Planung logische Probleme auf, erscheinen Symbole der Planungskonflikte
in der Infospalte.

Symbol Name Bedeutung Anmerkung

Planungskonflikt
(schwach)

Dieses Symbol zeigt an,
dass für den Vorgang
mindestens ein
schwacher
Planungskonflikt besteht.

Klicken Sie auf das
Symbol. Es öffnet sich
das Fenster
»Mitteilungen« mit einer
Auflistung aller
Planungskonflikte im
Projekt und
weiterführenden Infos.

Planungskonflikt (stark) Dieses Symbol zeigt an,
dass für den Vorgang
mindestens ein starker
Planungskonflikt besteht.

Ein starker
Planungskonflikt
verhindert im Gegensatz
zu einem schwachen
Konflikt die Planung.
Beispielsweise dadurch,
weil der Vorgang vor dem
Projektstart beginnt. Es
besteht
Änderungsbedarf.
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Titelspalte

In der Titelspalte befinden sich die Titel der Vorgänge, Gruppen, Meilensteine und
Zuweisungen. In der Titelspalte kommen zwei Symbole zum Einsatz. Es handelt sich um
ein schwarzes und ein helles Dreieck.

Die Dreicke zeigen Gruppen (schwarz) und Zuweisungen (hell) an.

Gruppe

Dieses Symbol zeigt Ihnen eine Gruppe an. Klicken Sie auf das Dreieck wird die Gruppe
auf- oder zugeklappt.

Damit lassen sich alle Gruppeninhalte ein- oder ausblenden.

Zuweisung

Dieses Symbol zeigt Ihnen an, dass an dem Vorgang, Gruppe oder Meilenstein eine oder
mehrere Zuweisungen vorhanden sind. Klicken Sie auf das Dreieck um die zugewiesene
Resource zu sehen.


Mit den Menüpunkten Struktur → Erweitern und Struktur →
Reduzieren lassen sich mehrere Gruppen und Zuweisungen gleichzeitig
auf- und zuklappen.
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Vorgabespalten

Vorgaben sind Werte, die für die Planung benötigt werden. Die Vorgaben treffen Sie als
Projektplaner anhand Ihrer Erfahrungswerte und weiterer Voraussetzungen für den
geplanten Projektverlauf.

Vorgabespalten können verwendet werden, um Arbeit, Dauer, Start- und Enddaten,
Kalender- und Ausrichtungseinstellungen für die jeweiligen Vorgängen im Projekt zu
definieren.

Fügen Sie eine neue Spalte ein und geben Sie Vorgabe ein. Merlin Project listet alle
Vorgaben Spalten auf, die für das Projekt und seine einzelnen Elemente verfügbar sind.
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Für die Planung sind die Vorgaben für Arbeit, Dauer sowie Start- und Ende am
häufigsten benötigt. Sie können sie in der Gliederung ein- oder ausblenden. Die meisten
der Vorgabewerte sind in der Gliederung und im Plan-Inspektor editierbar.



Für ein dynamisches Planen, reicht es eine Vorgabe für die Arbeit oder
Dauer festzulegen und die jeweiligen Vorgänge, Gruppen und
Meilensteine miteinander in Abhängigkeit zu setzen. Merlin Project
berechnet die geplanten und erwarteten Werte aus den Vorgaben.

Vorgabe Arbeit

Standardmäßig werden neue Vorgängen mit '1 Tag ?' Vorgabe Arbeit erstellt.

Sie können den Wert von Vorgabe Arbeit in der Gliederung anzeigen lassen und ihn dort
bearbeiten. Der Wert von Vorgabe Arbeit wird auch im Feld Arbeit des Plan-Inspektors
angezeigt, wo Sie ihn auch bearbeiten können.

Vorgabe Arbeit absolut

Vorgabe Arbeit absolut ist ein berechneter Wert und kann nicht bearbeitet werden.

Sie können sich dafür entscheiden, den Wert von Vorgabe Arbeit absolut in der
Gliederung anzuzeigen.

Die Berechnung basiert auf dem Wert von Vorgabe Arbeit. Falls Sie die Vorgabe Arbeit als
Zeitdauer eingeben, berechnet Vorgabe Arbeit absolut den gleichen Wert.

Falls Sie die Vorgabe Arbeit als einen Teilbetrag der Arbeit eingeben, berechnet Vorgabe
Arbeit absolut den Betrag auf der Grundlage der in einer übergeordneten Vorgangsgruppe
definierten Vorgabe Arbeit.
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Beispiel

Die Vorgangsgruppe ist definiert durch Aufwand von 10 Tagen, also Vorgabe Arbeit 10
Tage. Ein Untervorgang darin ist definiert durch 25% des Aufwands, also Vorgabe Arbeit
25%. Die Vorgabe Arbeit absolut des Untervorgangs wird mit 2,5 Tagen berechnet.

Vorgabe Dauer

Standardmäßig werden neue Vorgänge ohne eine Eingabe für Dauer erstellt. Das
bedeutet, dass die Spalte Vorgabe Dauer leer ist und dass der Wert Vorgabe Arbeit auch
die Dauer des Vorgangs definiert.

Um die Vorgabe Dauer von bestehenden Vorgängen zu ändern, markieren Sie die
Vorgangszeile und geben Sie im Plan-Inspektor den gewünschten Wert in das Feld Dauer
ein. Sie können den Wert von Vorgabe Dauer in der Gliederung anzeigen lassen und dort
bearbeiten.

Vorgabe Start / Ende

Standardmäßig werden neue Vorgänge mit leeren Start- oder Enddaten erstellt. Das
bedeutet, dass Vorgabe… Datumsspalten leer sind und dass Abhängigkeiten oder die
Datumseinschränkungen und Dauer von Vorgangsgruppen höherer Ebenen den Beginn
oder das Ende der neuen Vorgängen definieren.

Um einen Vorgabe Start für einen bestehenden Vorgang festzulegen, wählen Sie die
Vorgangszeile aus und verwenden Sie den Plan-Inspektor, um ein genaues Start- oder
Enddatum auszuwählen.



Für eine flexible Planung und eine leichtere Anpassung während der
gesamten Lebensdauer Ihres Projekts empfehlen wir Ihnen, so wenig
Start- und Enddaten wie möglich und so viele wie absolut verbindlich zu
definieren.

Vorgabe frühester Start / frühestes Ende

Standardmäßig werden neue Vorgängen mit leeren Start- oder Enddaten erstellt. Das
bedeutet, dass alle Vorgabe… Datumsspalten leer sind und dass Abhängigkeiten oder die
Datumseinschränkungen und Dauer von übergeordneten Vorgangsgruppen den Beginn
oder das Ende der neuen Vorgängen definieren.

Um einen frühesten Start oder frühestes Ende für einen bestehenden Vorgang
festzulegen, wählen Sie die Vorgangszeile aus und verwenden Sie den Plan-Inspektor, um
ein Datum für den frühesten Start oder das früheste Ende auszuwählen.



Für eine flexible Planung und eine leichtere Anpassung während der
gesamten Lebensdauer Ihres Projekts empfehlen wir Ihnen, so wenig
Start- und Enddaten wie möglich und so viele wie absolut verbindlich zu
definieren.
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Vorgabe spätester Start / spätestes Ende

Standardmäßig werden neue Vorgänge mit leeren Start- oder Enddaten erstellt. Das
bedeutet, dass Vorgabe… Datumsspalten leer sind und dass Abhängigkeiten oder die
Datumseinschränkungen und Dauer von Vorgangsgruppen höherer Ebenen den Beginn
oder das Ende der neuen Vorgängen definieren.

Um für einen bestehenden Vorgang einen Spätesten Start oder Spätestes Ende
festzulegen, wählen Sie die Vorgangszeile aus und verwenden Sie den Plan-Inspektor, um
ein Datum für den spätesten Start oder das späteste Ende auszuwählen.



Für eine flexible Planung und eine leichtere Anpassung während der
gesamten Lebensdauer Ihres Projekts empfehlen wir Ihnen, so wenig
Start- und Enddaten wie möglich und so viele wie absolut verbindlich zu
definieren.



Wenn Sie für einen Vorgang alle vier Datumswerte (Frühester Start,
Spätester Start, Frühestes Ende, Spätestes Ende) definieren müssen,
markieren Sie die Zeile des Vorgangs und wählen Sie mit dem Plan
-Inspektor die Option Zwischen für Start- und Enddatum.

Vorgabe Kalender

Standardmäßig werden neue Vorgänge entsprechend dem Projektkalender geplant.

Um den dazugehörigen Kalender bestehender Vorgängen zu ändern, markieren Sie die
Vorgangszeile, verwenden Sie den Plan-Inspektor, klappen Sie die Optionen
Fortgeschritten auf und wählen Sie den gewünschten Eintrag aus der Liste der Kalender
aus.

Sie können den Wert der Vorgabe Kalender in der Gliederung anzeigen lassen und ihn dort
bearbeiten.

Vorgabe Ausrichtung

Standardmäßig werden neue Vorgängen entsprechend der Richtung des Projekts geplant.

In einem vorwärts geplanten Projekt werden neue Vorgängen entsprechend der früh-
Ausrichtung eingefügt. In einem rückwärts geplanten Projekt werden neue Vorgängen
entsprechend der spät-Ausrichtung eingefügt.

Um die Vorgabe Ausrichtung bestehender Vorgängen zu ändern, markieren Sie die
Vorgangszeile, verwenden Sie den Plan-Inspektor und wählen Sie die gewünschte Option
aus der Ausrichtung -Liste.

Sie können den Wert der Vorgabe Ausrichtung in der Gliederung anzeigen und dort
bearbeiten.
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Geplant - Wirklich - Erwartet

Geplant

Merlin Project berechnet die geplante Arbeit und Dauer für jede Aktivität basierend auf den
Vorgabe Werten. Geplante Werte sind schreibgeschützt.

Geplante Werte für Start, Ende, Arbeit, Dauer, verstrichene Dauer und Auslastung werden
im Plan und Wirkliche Werte-Inspektor ausgegeben.

Wenn Sie Vorgabe Start, Vorgabe Ende, Vorgabe Arbeit, Vorgabe Dauer und Vorgabe
Auslastung eingegeben haben, spiegeln die geplanten Werte diese wider.

Falls nicht, berechnet Merlin Project sie auf der Grundlage von Voreinstellungen zu
Abhängigkeiten, Aktivitätsgruppen höherer Ebene oder anderen Standardwerten.

Beispiel

Ein Vorgang ist definiert durch 2 Tage Arbeit, die aufgrund ihres Vorgängers am Freitag
um 8 Uhr morgens beginnen muss.

• Geplante Arbeit berechnet basierend auf Vorgabe Arbeit, also 2 Tage

• Geplanter Start berechnet als Freitag um 8 Uhr

• Geplantes End berechnet als Montag um 17:00 Uhr

• Geplante Dauer berechnet als 2 Tage

• Geplante verstrichene Dauer berechnet aufgrund des dazwischen liegenden
Wochenendes als 3.38 fTage

• Geplante Auslastung berechnet 100%

Wenn Sie Kostensätze für Ihre Ressourcen, Basis- oder Pfändungskosten für Ihre
Aktivitäten definiert haben, werden die Geplanten Kosten im Inspektor Finanzen auf der
Registerkarte Saldo angezeigt.
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Wirklich

Wirkliche Werte sind die Werte, die Sie eingeben, um den tatsächlichen Fortschritt Ihrer
Planung aufzuzeichnen. Sie aktualisieren diese Informationen so oft, wie neue
Informationen aus Ihren Ressourcen bezüglich der tatsächlichen Arbeit oder des
Fertigstellungsgrades der verschiedenen Aufträge entstehen.

Fügen Sie eine neue Spalte ein und geben Sie Wirklich ein. Merlin Project listet alle Spalten
mit Wirklich-Werten auf, die für das Projekt und seine einzelnen Elemente verfügbar sind.

Sie können wählen, ob Sie diese in der Gliederung ein- oder ausblenden möchten.
Wirklich-Werte sind in der Gliederung und im Inspektor Wirkliche Werte editierbar.

Beispiel - Vorgang hat gerade begonnen

Ein Vorgang wird durch 2 Tage Arbeit definiert. Sie möchten den Vorgang so aktualisieren,
dass sie einen Fertigstellungsgrad von 50% widerspiegelt.

• Sie wählen den Vorgang aus

• Wechseln zu den Wirkliche Werte-Inspektor

• Sie wählen das richtige Datum für Wirklicher Start

• Sie wählen 50% aus der Erledigt Liste

Das bedeutet:

• Wirkliche Arbeit wird als die Hälfte der Vorgabe Arbeit berechnet, also 1 Tag

• Wirklicher Start ist das Datum, das Sie gerade eingegeben haben

• Wirkliches Ende ist leer (die Aufgabe ist noch nicht vollständig erledigt)

• Wirklich erledigt bis berechnet das Datum bis zum aktuellen Abschluss.

Beispiel - Ein Vorgang wird fertiggestellt

Ein Vorgang ist definiert durch 2 Tage Vorgabe Arbeit, die zu 50% erledigt war, ist nun
fertiggestellt.

• Sie wählen den Vorgang aus

• Wechseln zu den Wirkliche Werte-Inspektor

• Sie klicken auf 100%

Das bedeutet:

• Wirkliche Arbeit ist nun genau so wie viel wie die Vorgabe Arbeit, also 2 Tage

• Wirklicher Start ist das Datum, das Sie gerade eingegeben haben

• Wirkliches Ende ist das Datum, das die verbliebene Arbeit von 1 Tag benötigt.

• Wirklich erledigt bis berechnet das Datum bis zum aktuellen Abschluss. Daher
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ist es der gleiche Wert wie das Wirkliches Ende.

Beispiel - Aktualisierung des Fortschritts bei einem begonnenen Vorgang

Ein Vorgang ist definiert durch 2 Tage Vorgabe Arbeit und als 50% erledigt dokumentiert.
Jetzt ist es aber 75% erledigt und benötigt etwa 1 Tag mehr Arbeit als ursprünglich
geschätzt.

• Sie wählen den Vorgang aus

• Wechseln zu den Wirkliche Werte-Inspektor

• Tragen 75% in das Erledigt-Feld ein.

• Überprüfen Sie den Wert im Feld Verbleibende Arbeit.

• Passen Sie diesen Wert vom 4 Stunden auf 12 Stunden

Der Vorgang wird angepasst und der neue Erledigungs-Prozent wird neuberechnet. Er
beträgt jetzt 100% * Wirkliche Arbeit / (Wirkliche Arbeit + Verbleibende Arbeit) = 50%.

Das bedeutet:

• Wirkliche Arbeit betrug ursprünglich 75% der ursprünglichen Vorgabe Arbeit,
also 1,5 Tage

• Wirklicher Start ist das gesetzte Datum

• Wirkliches Ende ist leer (die Aufgabe ist noch nicht vollständig erledigt)

• Wirklich erledigt bis berechnet das Datum bis zum aktuellen Abschluss. Mehr
Arbeit bedeutet mehr Zeit, daher ist nicht mehr der gleiche Wert wie Wirkliches
Ende.

Wenn Sie Kostensätze für Ihre Ressourcen, Basis- oder Pfändungskosten für Ihre
Aktivitäten definiert haben, werden Wirkliche Kosten im Inspektor Finanzen auf der
Registerkarte Saldo angezeigt.
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Erwartet

Erwartete Werte spiegeln sowohl Vorgabe als auch Wirkliche-Werte wider.

Erwartete Werte sind schreibgeschützt und Sie finden sie im Plan- und Wirkliche Werte
-Inspektor.

Wenn ein Vorgang noch nicht begonnen hat, spiegeln die erwarteten Werte die Vorgabe
Werte wider.

Wenn ein Vorgang gestartet ist und Wirkliche-Werte eingegeben sind, spiegeln die
erwarteten Werte die Wirkliche-Werte wider.

Beispiel

Ein Vorgang, der durch 2 Tage Vorgabe Arbeit definiert ist, ist noch nicht begonnen.

Das bedeutet:

• Erwartete Arbeit berechnet basierend auf die Vorgabe Arbeit, also 2 Tage

• Erwartet Dauer berechnet basierend auf die Vorgabe Dauer. Falls Vorgabe
Dauer leer ist, die Dauer des Vorgangs basierend auf die Vorgabe Arbeit und
dessen Zuweisungen wird berechnet.

• Erwartet Start berechnet basierend auf Vorgabe Start. Falls Vorgabe Start leer
ist, das Datum an welchem dieser Vorgang geplant werden kann aufgrund von
Abhängigkeiten zu Vorgänger oder Gruppen höherer Ebenen.

• Erwartet End berechnet basierend auf Vorgabe Ende. Falls Vorgabe Ende leer
ist, das Datum an welchem dieser Vorgang fertig sein kann aufgrund von
Abhängigkeiten zu Vorgänger oder Gruppen höherer Ebenen und dessen Dauer.

Beispiel - Vorgang gestartet

Ein Vorgang, der durch 2 Tage Vorgabe Arbeit definiert ist, ist nun 50% erledigt.

Das bedeutet:

• Erwartete Arbeit berechnet Wirkliche Arbeit plus Verbleibende Arbeit, also 2
Tage

• Erwartete Dauer berechnet die Dauer bis zu 100% Erledigung.

• Erwarteter Start berechnet basierend auf Wirklicher Start

• Erwartetes Ende berechnet das Datum zur 100% Erledigung.

Beispiel - Aktualisierung des Fortschritts bei einem begonnenen Vorgang

Ein Vorgang, der durch 2 Tage Vorgabe Arbeit definiert ist, ist nun 50% erledigt. Die
Verbleibende Arbeit wurde nun angepasst auf 12 Stunden. Dadurch wird eine Erledigung
von 40% neu berechnet.

Das bedeutet:
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• Erwartete Arbeit berechnet Wirkliche Arbeit plus Verbleibende Arbeit, also 2.5
Tage

• Erwartete Dauer berechnet die Dauer bis zu 100% Erledigung.

• Erwarteter Start berechnet basierend auf Wirklicher Start

• Erwartetes Ende berechnet das Datum zur 100% Erledigung.

Beispiel - Ein Vorgang wird fertiggestellt

Ein Vorgang, der durch 2 Tage Vorgabe Arbeit definiert ist, ist nun 40% erledigt. Wirkliche
Arbeit war 1 Tag, Verbleibende Arbeit 12 Stunden. Der Vorgang ist nun erledigt und dies
ist über einen Klick auf '100%' dokumentiert. Dadurch wird das Verbleibende Arbeit auf
einen Leerwert zurückgerechnet, sein Betrag wird zu Wirkliche Arbeit addiert.

Das bedeutet:

• Erwartete Arbeit berechnet Wirkliche Arbeit plus Verbleibende Arbeit.
Verbleibende Arbeit ist nun 0, Wirkliche Arbeit ist 2.5 days. Erwartete Arbeit ist
2.5 Tage

• Erwartete Dauer berechnet die Dauer bis zu 100% Erledigung.

• Erwarteter Start berechnet basierend auf Wirklicher Start

• Erwartetes Ende berechnet basierend auf Wirkliches Ende

Wenn Sie Kostensätze für Ihre Ressourcen, Basis- oder Pfändungskosten für Ihre
Aktivitäten definiert haben, werden Erwartete Kosten im Inspektor Finanzen auf der
Registerkarte Saldo angezeigt.

Schlusswort

Diese Dokumentation wurde von ProjectWizards GmbH in Mai 2021 kompiliert. Haben Sie
Fragen oder Anmerkungen? Wir freuen uns, von Ihnen zu hören.

Bitte schreiben Sie uns an support@projectwizards.net
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